yystem Guide







System Guide

Microsoft.- Windows NT"

Beta March 1993

Microsoft Corporation



Information in this document is subject to change without notice. Companies, names, and data used in
examples herein are fictitious unless otherwise noted. No part of this document may be reproduced or
transmitted in any form or by any means, electronic or mechanical, for any purpose, without the
express written permission of Microsoft Corporation.

©1992-1993 Microsoft Corporation. All rights reserved.

Microsoft, MS, MS-DOS, XENIX, CodeView, and QuickC are registered trademarks and QBasic,
Windows, Windows NT, NT, and Win32s are trademarks of Microsoft Corporation in the U.S.A. and
other countries.

0S/2 is a registered trademark licensed to Microsoft Corporation.

U.S. Patent No. 4955066

Banyan and VINES are registered trademarks of Banyan Systems, Inc.
CompuServe is a registered trademark of CompuServe, Inc.

GEnie is a trademark of General Electric Corporation.

Hewlett-Packard and PCL are registered trademarks of Hewlett-Packard Company.
IBM is a registered trademark of International Business Machines Corporation.
Intel is a registered trademark and i386 and 1486 are trademarks of Intel Corporation.
Lotus and 1-2-3 are registered trademarks of Lotus Development Corporation.
MIPS is a registered trademark of MIPS Computer Systems Inc.

NetWare is a registered trademark of Novell, Inc.

PostScript is a registered trademark of Adobe Systems, Inc.

SideKick is a registered trademark of Borland International, Inc.

Tandy is a registered trademark of Tandy Corporation.

TrueType is a registered trademark of Apple Computer, Inc.

UNIX is a registered trademark of UNIX Systems Laboratories

XYWrite is a registered trademark of XYQUEST, Inc.

Printed in the United States of America.
Document No. 37369-0393



Contents

Welcome. . ... o XV

Chapter 1 Introducing Windows NT ............................ ... ... ... 1
Starting and Quitting Windows NT ... .......... ... .. .. .. . .. .. .. .. . 1
Starting Windows NT .. ... ... ... ... .. .. .. . .. ... ... ... 1
Using Windows NTHelp ......................... .. . .. ... .. .. .. .. 3
Starting and Quitting the Online Demonstration. . .. ........ ... .. .. ... .. 3
Quitting Windows NT .. ........ ... ... ... ... .. .. .. ... .. ... ... 3
What to Do After Setup. . .............. ... ... . .. 4
Using Windows NT Applications. .. .................. .. .. ... ... 4
Setting Up Your Personal Working Environment. . .. ......... ... ... . . 6
Configuring the Network. . ............. ... ... ... ... .. .. . ... . . .. 7
Browsing Other Computers and Resources on the Network . .. .. ..... .. .. 8
Managing Files and Disks. . .......... ... ... ... .. . . . . . ... .. ... .. 8
SettingUptoPrint............. ... .. ... ... .. ... . . . . . ... ... . 10
Configuring Your System....................... .. .. .. . .. .. .. . 10
Setting Up User Accounts and Groups .................. .. .. .. ... .. 12
Managing Security. . ........... ... . 13
Chapter2 Windows NTBasics...................oveueeee 15
Selecting Items for Action ............. ... .. ... .. .. .. .. . .. . ... ... . 15
Managing Windows. ............... ... .. ... . 17
Starting Applications in Program Manager.......... ... .. ... ... .. .. 17
Moving and Sizing Windows . . ................. ... .. ... .. ... ... .. 17
Using Document Windows ... ............... ... ... .. .. ... ... .. .. 18
Choosing Commands in Windows NT .. .............. ... .. ... .. . . . . . 18
Using the Control Menu and Task List .. ............. .. ... .. .. .. .. .. 20
UsingHelp..... ... ... . . . . 22
Using Dialog Boxes. ............. ... ... ... ... .. ... . .. ... .. .. .. 24
Responding to Messages. ................... .. ... ... .. .. .. .. .. ... 26
Cutting and Copying Information . ............... ... .. .. .. .. .. . . 26
Transferring Information Between Windows-Based Applications . . . . . . . . . 26
Transferring Information Between MS-DOS-Based Applications. . . . . . ... 27

Copying ScreenImages. ............... ... . .. .. ... .. ... .. ... .. . 27



Using the Keyboard . . ... 28
Using the Keyboard for Common Actions. . ...............o.ooooonn 29
Keyboard Shortcut Reference . . ... 30

Chapter3 Program Manager ................cooumimnimrnnmnnimnnannn. 33

OVEIVIEW . « o o e e e e e e e e e e e e e e e e 33
Quitting Windows NT Using Program Manager. ....................... 35

What Are Groups and Program Items? . ........... ...t 35
Opening Group Windows and Reducing Them to Icons ................. 36
Arranging Group Windows . .. ... 37
Arranging Group and Program-Item Icons ....................ooonnn 38
Saving Program Manager Settings . .. ... 39
Creating GrOUPS . . . ... oottt e 39
Creating Program Items . . .. ... 40
Deleting Groups and Program Items. . . ... 44
Changing the Descriptionof aGroup. . ... 44
Copying a Program Item to Another Group. . ..................oonnnn 45
Moving a Program Item to Another Group . ..................ooonnn 46
Changing an ICOM . .. ... o ittt 46

Starting an Application fromaGroup . ... 47
Starting an Application When You Start Windows NT .................. 48
Returning to Program Manager from an Application.................... 48

Chapter4 File Manager..............oovuiinnmmnmin i 49

OVEIVIEW .« o e e e e e e e e e 49
Starting and Quitting File Manager . ... 50
Customizing the Toolbar. ........ ... 51

Working with Directory Windows . .. ... 52
Opening and Closing Directory Windows. ..................o.ooonnn. 54
Selecting and Arranging Directory Windows and Icons. ................. 55
Displaying the Directory Tree or Contents .........................o0o 56
Changing the Font in File Manager . ...t 56

Navigating Drives and Directories . . . . ... 57
Changing Disk Drives .. ... 57
Changing DIreCtories . . . .. ...ttt 58
Expanding and Collapsing the Directory Tree. .. ....................... 59
Showing Which Directories Expand. . .. ... 60
Connecting to and Disconnecting from a Network Drive. . ............... 60

Working with Directory Information. . ... 62

Displaying Informationon Files . . ... 63



Sorting the Contents of a Directory .. ................... .. ... . ... .. .. 64
Limiting the Files to Display .................... ... . ... ... ... .. .. 65
Working with Files and Directories. .. ................ ... ... ... ... . .. 66
Naming a File or Directory . .............. ... ... ... ... ... ... ... .. .. 66
Selecting Files or Directories .. .................... ... ... ... . ... 68
Creating a Directory. ......................... ... ... .. ... .. .. ... .. 70
Moving and Copying Files and Directories. .. ............. ... . ... .. .. 70
Deleting a File or Directory ..................... ... ... ... .. ... ... 73
Renaming a File or Directory . ........................... ... .. ... .. 73
Searching for a File or Directory . ..................... .. .. ... .. .. ... 74
Associating Files with an Application................... .. ... . .. . . . .. 75
Starting an Application from File Manager. .. ............. .. .. .. .. ... 77
Printing a File from File Manager .. ................. .. .. ... .. .. . . . .. 78
Turning Off Confirmation Messages . . .................. .. ... .. ... .. 79
Setting File Attributes ... .............. ... ... . ... .. .. ... . ... ... 80
Viewing a File’s Version Information. .. ............... ... ... . .. . . . .. 81
Working with Shared Directories and Files ................. ... .. .. .. .. . 81
Sharing a Directory .............. ... . ... ... .. ... ... ... . ... . ... ... 82
Stopping Directory Sharing. . ........... ... ... . ... ... . ... ... .. ... .. 83
Changing Share Properties . ................ ... ... ... ... . . ... ... . 84
Viewing or Closing Shared Files ... ................. . ... .. ... .. .. .. 85
Securing Directoriesand Files . ... ............. ... . ... ... . .. . . ... . ... . 86
Setting Directory Permissions. . .................... ... .. .. . .. . .. ... 87
Setting File Permissions ................... ... . ... ... . ... .. ... ... . 92
Setting Special Access Permissions. . ............... ... .. .. ... .. .. ... 95
Setting Permissions Through Shared Directories . ................ .. .. .. 98
Auditing Files and Directories ........................ ... ... ... ... 101
Taking Ownership of Files or Directories . .. ................ ... .. .. .. 104
Maintaining Disks . ... o 104
Formatting a Floppy Disk . ........ .. .. ... ... ... ... ... . ... . ... .. 105
Copying aFloppy Disk . ........ . ... ... ... ... ... . ... . ... ... . 105
LabelingaDisk ............. ... .. ... ... . .. .. ... . . . ... . ... 106
Chapter5 ControlPanel ............................................. 107
Overview . ... . 107
Changing the Desktop. .......... .. .. ... .. ... ... ... .. . .. .. . ... ... 110
Customizing Desktop Colors ..................... ... ... .. ... ... ... 110
Configuring Desktop Appearance . ..................... .. . ... ... .. 113
Switching Between Applications . . ................ ... ... . ... . ... ... 117



vi

Setting Serial Port Communications Options . ...................... ... 118
Working with Fonts. .. ... 119
Adding Screen Fonts and TrueType Fonts. ........................... 119
Removing a FONt . ....... ... i 121
Working with Date, Time, and International Settings . .................... 122
Configuring Date and Time. . ......... ... 122
Working with Other International Settings . .......................... 124
Customizing the Keyboard, Cursor,and Mouse . . ........................ 126
Adjusting the Keyboard Delay and RepeatRate. ...................... 126
Adjusting the Cursor Blink Rate. . ...t 127
Changing the Cursor APPEaranCe . . ... ..........ouuoenmrs e oo: 127
Customizing Your Mouse or Other Pointing Device ................... 128
Working with Printers . . ................ 129
Working with Device Drivers. . ... 129
Installing and Configuring Drivers. ........................ oo 129
Using Audio and MIDI Sounds in Windows NT ...................... 132
Configuring the Network. . ............ ... i 135
Changing the COMPUtEr NAME. . . . ... ..ottt 136
Installing Network Adapter Cards ................. ..., 137
Installing Network Software .. ........... ... 137
Updating or Removing Network Components ........................ 138
Configuring Network Software and Adapter Cards .................... 138
Choosing and Configuring Protocol Software. ........................ 140
Joining a Workgroup or Domain. . ........... ... 141
Configuring Network Bindings. .. ........... ... 142
Configuring the Remote Procedure Call Service. ...................... 144
Setting Network Provider Search Order. . ........................... 145
Defining Options for the Operating System . ............................ 146
Defining an Alternate Startup Operating System ...................... 147
Changing the Environment Variables. . . ............................. 148
Changing the Virtual-Memory Paging File . .......................... 149
Changing Application Response Time. . ........................oon 151
Setting Up the Uninterruptible Power Supply (UPS)...................... 151
Using UPS with Other System Services. . ... 154
Testing Your UPS Configuration . ... 155
Managing Server Properties . .............. oo 156
Viewing User SeSSIONS. . ... ... .oooiee 157
Viewing Shared Resources .. ..., 158

Viewing Resources InUse. . ... 160



vii

Managing Directory Replication .. ................. ... ... . .. . ... .. 161
Managing Administrative Alerts ... ............. ... . ... ... . .. .. .. .. 165
Managing Services ................ ... ... .. 166
Starting and Stopping Services. ... ............ .. ... ... ... ... . 167
Configuring Service Startup .. ................. ... ... ... ... .. ... ... 168
Managing Devices. ............... ... ... . ... . .. . . . . . .. ... 170
Starting and Stopping Devices ... ................. ... ... ... ... . . ... 170
Configuring Device Startup .............. ... ... ... ... ... .. . ... . ... 171
Chapter6 PrintManager........................covuieinin . 173
Overview ... ... 173
Starting and Quitting .. ............. .. . . 175
Installinga Printer. . ........... .. .. ... ... ... ... . . .. . .. . ... ... ... 175
Installing a Printer Driver . ................. ... ... ... ... . ... ... .. 178
Connecting to a Network Printer . ... ............ ... ... ... .. ... .. .. . 178
RemovingaPrinter .. .......... . . .. . .. 180
Changing a Printer’s Properties . . ... .............. ... ... ... .. ... .. ... 180
Sharinga Printer. . ............ ... .. ... .. ... ... .. . .. ... ... . ... . 181
Setting Printing Options ........... .. ... ... ... ... ... .. ... .. ... 182
Setting Job Defaults. . .......... ... ... .. ... .. .. .. .. ... 183
Setting Printer Details . ............... ... ... ... .. ... .. .. .. ... ... 183
Setting Timeouts .................. . ... ... ... ... ... .. ... ... ... . 187
Securinga Printer ............. ... .. . 188
Auditinga Printer ........... ... . 191
Taking Ownership of a Printer. .. ....... ... ... ... ... ... .. .. . . . . . . . .. 194
Using Forms. ... ... . . .. 195
Printing Documents. . ............. ... . ... ... ... ... . .. . . . ... ... 196
Setting the Default Printer. . ... ....... ... ... . ... ... . .. . .. . . . . .. . 196
Viewing Documents at the Printer. .. .............. ... .. ... .. . . ... .. 197
Pausing and Resuming Printing . ... .............. . ... ... .. . . . ... .. 197
Changing Printing Order. ................ ... ... ... . ... ... . ... .. . 198
Restarting Documents .. ......... ... ... .. .. ... .. . ... ... . . . ... 198
Removing Waiting Documents. .. ................. ... .. ... . . . .. .. 198
Displaying or Changing Document Details. ............... ... . ... . .. 199
Administering Network Print Servers Remotely . .............. . . .. . ... 200
Chapter7 Mail.......... ... ... .. ... . . 203
Overview . ... .. 203
Starting and Quitting Mail. .......... ... ... ... . . 205



viii

Sending a MESSAZE . . . . ..ottt 210
Reading @ MESSAZE. . . . ..o oottt 213
Replying t0 @ MeSSage . . ... ..o ovvrrnetae 214
Deleting @ MESSAZE . . . .o v vttt 215
Advanced Featuresof Mail . .. ... ... ... ... i 216
Setting Up the Mail System . ............... i 219
Planning a Workgroup Postoffice. . ... 219
Creating the Postoffice and the Administrator Account. ................ 222
Sharing the Workgroup Postoffice . . ...t 224
Creating a Workgroup Postoffice . . ... 225
Managing Your Workgroup Postoffice . ... 225
Starting the Postoffice Manager . ... 226
Adding @ USEr. . ..o .ot 226
Modifying a USer ACCOUNE .. ... ...ttt 227
Removing a USETr ... ...t 227
Managing Disk Space .......... ... 227
Changing the Name of a Workgroup Postoffice .. ..................... 229
Moving a Workgroup Postoffice. . ... 230
Removing a Workgroup Postoffice. . ... 230
Managing the Mail System Files. .. ...t 231
Restoring a User’s Password. . ... 234
Using Mail with Other Networks and Other Messaging Systems ......... 235
Using Mail with a NetWare Network. . ... 235
Chapter8 Schedule+ ............cooiiiniiiniiiii s 237
OVEIVIEW. .« o o e e e e e e e 237
Starting and Quitting Schedule+. ......... ... ... 238
Organizing YOur SCT@EN . ... ... ..o.ouoii 239
Using the Appointment Book ... ... 240
Adding an Appointment. . ... ... 241
Adding a Tentative Appointment . .. ................ i 242
Adding a Recurring Appointment. . . ...............oii 243
Using the Task List .. ... . 245
Adding a Task to the Task List. . ... 245
Scheduling Time in the Appointment Book fora Task ................. 247
Using the Planner to Schedule Meetings . ... 248
Scheduling Attendees. .. ............. . i 248
Scheduling RESOUICES . ... ...t 250
Using the Messages Window to Schedule Meetings ...................... 251

Advanced Features of Schedule+. .. .. ... .. . 252



Chapter9 CommandPrompt........... ... ... ... ..., 255
Overview . ... 255
Starting and Quitting the Command Prompt. .. ............... ... ... .. 256
Changing the Command Prompt Display . .................... ... ... 256
Getting Help for the Command Prompt. . ... ... .. .. ... ... ... ... .. 261
Command Prompt Commands . ............... .. ... ... ... ... ... ... 262
Native Commands ... ............... ... . 262
Subsystem Commands. . ................... ... ... ... ... .. ... .. 266
Configuration Commands............... ... .. ... ... ... ... .. ... .. 267
TCP/IP Utilities .. ... 268
Special Purpose Utilities . ............. ... ... ... ... ... ... ... ... .. 269
Command Symbols ............. ... ... 269
Command Syntax. .......... ... ... 270
Command Names. . .................. ... ... . .. ... .. 270
Parameters. .. .......... .. ... 270
Switches . ... 271
Values . ... ... 272
Using the Command Prompt ........... ... ... ... ... ............... 272
Starting Programs at the Command Prompt . ................. ... .. ... 272
Batch Programs .. ... ... ... . . . 273
Transferring Information to or from a Command Prompt Window . . . . . .. 273
Editing Commands with Doskey and Editing Keys ... ............. .. .. 275
Pausing or Cancelinga Command . .. ....................... ... .. ... 275
Differences from MS-DOS 5.0 Commands ........................... .. 276
Differences from LAN Manager 2.1 Commands . . ................. ... ... 278
Chapter 10 Object Linking and Embedding. .............................. 281
Overview ... ... 281
Linking or Embedding an Object with Menu Commands. ................. 285
Creating a Linked or Embedded Object. . ......................... ... 286
Linking or Embedding Objects with OLE Applications in Windows NT . . . . . 288
Using ClipBook Viewer ................ ... ... .. ... ... ... ... 288
Using Clipboard Viewer . .............. ... ... ... ... ... ......... 2901
Embedding aPackage ............... ... ... . ... . ... . . . ... ... . ... .. 292
Maintaining Linked or Embedded Objects . . ......................... ... 294
Editingan Object . .............. ... . .. ... ... ... 295
Solving Problems with Linked or Embedded Objects . . .............. .. 296
Chapter 11  Other Application Environments. ............................. 299

How Windows NT Runs Applications ............................. ... 299



Supported Applications ... .......... .. 300

Windows 3.1 Environment . ... ... 301
Configuring the Windows 3.1 Environment . ......................... 301
MS-DOS EnVIFONMENL . . ..o\ttt e e e et et 302
Configuring the MS-DOS Environment. . ............................ 302
Running Memory-Resident Programs . ........................ ... ... 304
OS/2 ENVITONMENT . . . ..o ottt et e e e e et e 305
Configuring the OS/2 Environment .. ............... ..., 306
Setting Up and Starting Applications. ... ............... ... ... 308
Creating Program Information Files (PIFs). ............................. 309
Specifying PIFOpHONS . . ... 311
Chapter 12 System Maintenance with Windows NT Setup................... 321
Starting and Quitting Windows NT Setup. . ............................. 321
Changing System Configuration Settings . .............. ... ... ... ..... 322
Setting Up Applications to Run from Program Manager................... 323
Installing a New Device Driver ....................................... 325
Obtaining New Device Drivers. . ..., 325
Setting Up New or Revised Device Drivers. . ......................... 325
Correcting a Faulty Device-Driver Installation. . ...................... 326
Adding and Removing Drivers for SCSI Adapters and Tape Drives ... ... 326
Adding and Removing Windows NT Components ....................... 327
Deleting User Profiles . ........... ... .. . ... .. 330
Repairing Your SysStem .. .............. it 331
Chapter 13 UserManager...............c.ooiiieiiiiiiiiniiiiennananss 333
OVEIVIEW. .« o oottt e e e e e e e e e e e e e 333
Starting and Quitting User Manager. .. .............................. 334
Who Can Use User Manager?. . ... .. 334
Managing User ACCOUNES ... ...ttt 335
Built-In USer ACCOUNES . ... ..ottt 335
Adding User ACCOUNTS. . . . ...ttt 336
Managing User Account Properties . .......... ... ... ... ... ..., 340
Disabling or Deleting User Accounts. ................... ... ........ 346
Renaming User ACCOUNES . ... ........oooiiimitiiinmeeeneee.. 348
Managing GrOUPS. . . .. ..ot 348
BUuilt-In GroUPS. . . . oo oo 349
Adding Local GIoups. . ...t 353
Managing Local Group Properties . .................... .. ... ... .... 354

Deleting GrOUPS . .. ..o ottt 355



Xi

Managing the Security Policies .. ............... ... ... ... ... ... ... 356
Managing the Account Policy. . ......... .. ... ... .. ... .. ... ... ... 356
Managing the User Rights Policy. ....................... ... ... ... .. 357
Managing the Audit Policy . ... ............ ... .. . 360

Chapter 14 Backup...............cooiiniiiiii e, 363

Overview ... ... 363
Starting and Quitting Backup .. ............ ... ... .. . 364
Selecting Your Hardware .......... . ... ... ... .. ... ... . ... ... .. 365

Backing Up Disk Filesto Tape .. .................... .. ... .. ... .. ... 366
Choosing FilestoBack Up.......... ... ... ... .. ... ... .. ..... ... 366
Setting the Tape Options. .. .......... ... ... ... ... ... ....... 368
Setting the Backup SetOptions .. .................... ... ... ... ... .. 370
Setting the Log Options. . . ........... . ... .. .. ... . ............. 371
Checking the Backup Status . ... ........... ... ... ... ... . . ... .. .. 372
Using Batch Filesto DoBackups. . ................. ... ... ... ... .. . 373

Restoring Tape Filesto Disk ........ ... .. ... ... ... ... ... . ... ... .. ... 374
Choosing What You WanttoRestore . ........................... ... 375
Building Partial Tape and Backup Set Catalogs . .................... .. 376
Setting the Restore Options. .. ................ .. ... ... ... ... ... .. 377
Setting the Log Options. . ................... . ... .. ... ... ... .. 378
Checking the Restore Status . .......... ... ... ... .. ... . ... ... .. 379

Maintaining Tapes. . .............. . ... . 379

Chapter 15 EventViewer.............. ... .. ... ... oiiiiiniia .. 381

OVEIVIEW . ... 381
Starting and Quitting Event Viewer. ........ ... ... ... ... ... .. . . ... 384

Viewing EventLogs . ................. ... ... .. . 384
Selecting a Log for Event Viewing . ............................ .. .. 384
Refreshing the View . ........ ... ... . ... ... ... . . ... ... ... . ... 385

Setting Options for Logging Events. ... ............................. ... 385

Viewing Specific Logged Events. . ........ ... .. .. ... ... ... ... . ... 387
Sorting Events . ....... ... ... .. ... 387
Filtering Events . ....... ... ... ... ... ... .. ... . . ... .. ... ... 388
Searching for Events .. .............. ... . ... .. ... ... ... ... .. ... 390
Viewing Details About Events . .. ........... ... ... .. ... ... .. ... . .. 390

Using Archived Log Files. . .......... ... .. ... ... ... .. ............ .. 391
ArchivingaLog........... ... ... 392
Viewing a Log Archived in Log File Format . .................. ... ... 393

Using Logs Archived ina Text Format . ................... .. ... .. .. 393



xii

Chapter 16 Disk Administrator ... 395
OVEIVIEW . .« o o oo e e e e e e e e e e e e 395
Starting and Quitting Disk Administrator .................. ... ...... 396
Organizing Your SCreen . ....................... i, 397
Managing DisKs . ... ... 398
Partitioning Disks. .. ... 399
Creating and Deleting Volume Sets . . .............. .. ... .. 408
Extending Volumes and Volume Sets . .......... ..., 410
Creating and Deleting Stripe Sets. . .......... ... ... ..., 411
Chapter 17  Performance Monitor.................. ...t 413
OVEIVIEW. .« o o ot e e e e e e e e e e 413
Starting and Quitting Performance Monitor .......... ... ... ... ... .. 414
Organizing Your SCreen . .................oiiiiiiiineeeaaoo.. 416
Organizing YOur SCIEEM .. ... ..... ...ttt 417
Monitoring Performance . . ............ ... ... .. 418
Working with Information on Current Activity. ....................... 420
Working with Information from Log Files. . . ......................... 423
Charting Current ACtivity . ........ ... . i 423
Adding Chart Selections ........... ... ... . ... i 424
Changing Chart Selections . ...................iiiineeeeeoo.. 426
Changing the Chart Options . .............. ... ... 427
Logging Current ACtivity . ........ ... ... oo 428
Addingtoalog ......... . 429
Changing the Log Options. . ................. .. 430
Adding Bookmarks. .. ... 431
Setting Alerts on Current ACtivity .. .......... ... .. i 431
Adding Alert Selections. .. ........... ... i 433
Changing Alert Selections. . ............... .. i, 434
Changing the Alert Options. . . ............. .. ... ... ... ... ... ... 435
Creating Reports on Current Activity .................... ..., 436
AddingtoaReport. ....... ... .. . 437
Changing the Report Option . .. ............ ... ... .. .. ... ... 438
Working with Existing Log Files . ... ........ ... ... . ... .. ... 439
Charting Input Log Files ... ... ... i 440
Setting Alerts on Input Log Files .. ........... ... ... 441
Relogging Input Log Files. . . ........... ... ... . . it 442
Reporting Based on Input Log Files. . . .............................. 443

Chapter 18 Installing Windows NT ...t 445



Things You Need to Know Before Running Setup .................. ... .. 445
Starting Setup on an x86-based Computer . .................. .. .. .. ..... 446
Starting Setup on a RISC-based Computer. . ............................ 448
Choosing Express vs. Custom Setup . .. ................................ 449
Preparing the Computer for Windows NT ... ... ... ... ... . ... ... ... 449
Specifying the Disk Partitions .............. .. ... ... ... ... ... .. .. 450
Selecting a File System for the Windows NT Partition .. ............... 451
Selecting a Directory for Windows NT Files ........... ... ........... 454
Configuring Windows NT .. ... .. .. ... .. ... ... ... . . ..., 454
Setting Up Virtual Memory. ... ......... ... ... ... ... . . . ... 454
Setting UpaLocal Printer. .. ........... .. ... ... ... ... .......... 455
Setting Up a Network Adapter Card ................................ 455
Joining a Workgroup or Domain ............ ... ... .. ... ... ... .. ... 457
Setting UpaLocal Account .............. ... ... .................. 458
Setting Up Applications to Run from Program Manager. ... ............ 458
Completing Setup and Starting Windows NT. . .. ............ ... ... .. .. 459
Setting Up Windows NT Master Filesona Server ....................... 459

GlOSSaAY. . ... 463






Welcome XV

Welcome

Welcome to Microsofte Windows NT™, the next-generation operating system that
opens up the power of 32-bit computing in a graphical user environment.

Windows NT is designed to meet the demands of power users, developers, and
MIS for powerful hardware and applications, without sacrificing the ease of use
and application availability of Windows. Windows NT is another member of the
family of Windows operating systems. It includes powerful built-in networking
capabilities in addition to the same workgroup services provided in Windows for
Workgroups. Windows NT is easy to install, configure, and manage.

You can run powerful new 32-bit applications created for Windows NT, which is
also compatible with existing environments. So you can run applications created
for other versions of Microsoft Windows™, MS-DOSe, and character-based

MS 0OS/2@ 1.x as well as POSIX-compliant applications.

The Windows NT System Guide is for new and experienced users of Windows NT.
This manual describes the features in Windows NT and presents step-by-step
procedures for using the applications and tools provided in your product package.

This introduction provides the following information:

= A description of Windows NT, including its benefits and a comparison to
Microsoft Windows for MS-DOS

= The Windows NT system requirements

= A summary of the resources available for learning and using Windows NT

= A list of the conventions used in the Windows NT document set

What Is Windows NT?

The Microsoft Windows NT operating system is the portable, secure 32-bit,
preemptive multitasking member of the Microsoft Windows operating system
family. Windows NT combines the ease of use and productivity of the Windows
graphical interface with the powerful capabilities of a next-generation operating
system that takes maximum advantage of the advanced hardware of the 1990s.
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Key Features of Windows NT

Complex business applications place high demands on computing technology.
Windows NT is designed to support these applications with:

Efficient high-end computing, with full 32-bit operations, preemptive
multitasking, and memory protection.

Portability, running on advanced PC hardware based on x86 microprocessors
or reduced instruction set computer (RISC) architecture such as the MIPSe
R4000™.

Scalability, supporting a diverse range of hardware platforms for stand-alone
systems, workstations, and network servers. Windows NT also supports
symmetric multiprocessing to take full advantage of computers with multiple
processors.

Security, providing an advanced, reliably secure environment designed to meet
the requirements of U.S. Department of Defense C2-level standards.

Networking and workgroup support, with built-in file-sharing and print-
sharing capabilities for workgroup computing, and an open network system
interface that includes built-in support for NetBEUI, TCP/IP, and other
transports. Windows NT is compatible with existing networks such as
Banyane VINESe and Novelle NetWaree.

32-bit versions of Microsoft Mail and Microsoft Schedule+ for sending
mesages, managing calendars, and scheduling meetings.

With Windows NT, you can run a host of applications on both x86 and RISC
machines, including the following:

New, powerful Win32™-based applications (32-bit Windows)

Programs created for the MS-DOS and Microsoft Windows for MS-DOS
operating systems

MS OS/2 version 1.x character-based programs

POSIX-compliant programs
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Windows NT Compared to Windows for MS-DOS

If you are familiar with versions of the Microsoft Windows operating system that
run with MS-DOS, you will quickly understand how to use Windows NT.
Windows NT shares these same features:

Mouse and keyboard techniques for working with windows, menus, and icons
Desktop tools such as Program Manager, File Manager, and Print Manager

Accessories, games, and other components, with an extended set in
Windows NT

The complete object linking and embedding (OLE) capabilities supported by
applications created for versions of Windows for MS-DOS

Windows NT, however, is a complete operating system with powerful additions
to support file and system security, networking capabilities, and high-end, 32-bit
computing. Windows NT is designed to take full advantage of the advanced
computing capabilities of x86 and RISC processors to provide a platform for
advanced line-of-business computing solutions and for applications requiring
sophisticated system software.

You will find these additional features in Windows NT:

Advanced built-in network support, including complete security features.

Applications in the new Administrative Tools group for managing user
accounts, controlling network services, auditing system events, managing and
backing up disks, and more.

Tools in File Manager, Control Panel, and Print Manager for security,
hardware configuration, and network management.

A new file system—the Windows NT file system (NTFS)—that provides
security and automatic error-correction capabilities. NTFS allows file and
directory names of any length.

A command prompt where you can start programs and batch files, or issue all
Windows NT commands and most commands for MS-DOS, MS 0S/2, and
POSIX.
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System Requirements

The following table describes the system requirements for Windows NT.

Category Requirement

Hardware 32-bit x86-based (such as Intel® 80386/25 or higher)
microprocessor, or supported RISC-based microprocessor such
as the MIPS R4000 and DECe Alpha

VGA, or higher resolution, video display adapter

One or more hard disks, with 80 MB minimum free hard disk
space on the partition that will contain the Windows NT system
files

For x86-based computers, a high-density floppy disk drive
For RISC-based computers, a SCSIe CD-ROM drive

Memory 8 MB RAM required
Optional Mouse or other pointing device
components One or more SCSI CD-ROM drives

(required for RISC-based computers)

One or more network adapter cards, if you want to use Windows
NT with a network

Finding Information About Windows NT

The Windows NT System Guide presents information for both new and
experienced users who are installing and using Windows NT. Read this book for a
description of the applications and tools provided in your Windows NT package.
This manual presents procedures for completing common tasks, such as
organizing the desktop, managing files and directories, printing, using
applications, administering the network, and more.

Your product package also includes a set of Release Notes. Be sure to read these
notes, and also look for any README text files that are copied to the \WINNT
directory when you install Windows NT. These files contain up-to-date
information about specific hardware, printers, and networks.

The following sections describe other sources of information for learning and
using Windows NT.
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Additional Information

Three other key sources of information included in the Windows NT package will
help you plan for and use Windows NT:

Road Map for Windows NT
Gives you a graphical overview of where to find the tools and information you
need to learn and use Windows NT.

Online demonstration
Covers the basics of Windows NT. View it at the conclusion of Windows NT
Setup, or at any time by choosing the Introducing Windows NT icon in the
Main program group.

Online Help
Always available when you press F1 while working in Windows NT. Or at the
command prompt, type help or net help and then press ENTER.

Detailed information on Windows NT architecture and design is available in a
Microsoft Press book, Inside NT. Inside NT may be obtained wherever books and
software are sold. To order the book directly, call 1-800-MSPRESS.

To explore additional sources of information about Windows NT, see the
appendix called “Microsoft Support Services.” It covers the following:

= Contacting Microsoft Product Support Services

= Calling Interactive Voice Support

= Using the Microsoft forums on CompuServe

= Getting product training and consultation services
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Conventions

The following conventional terms, text formats, and symbols are used throughout
the printed and online documentation for Microsoft Windows NT.

Convention

Meaning

Bold

Italic

ALL UPPERCASE

monospace

>

\WINNT

Security

RISC

Indicates the actual commands, words, or characters that you
type in a dialog box or at the command prompt.

Indicates a placeholder for information or parameters that you
must provide. For example, if the procedure asks you to type
filename, you must type the actual name of a file. Italic also
indicates new terms and the titles of other books in the
Microsoft Windows NT package.

Indicates a directory, filename, or acronym. You can use
lowercase letters when you type directory or filenames in a
dialog box or at the command prompt, unless otherwise
indicated for a specific application or utility.

Represents examples of screen text or entries that you might
type at the command line or in initialization files.

Indicates a procedure with sequential steps.
Indicates a procedure with only one step.
Indicates a list of related information, not procedural steps.

Refers to the Windows NT system tree. All references to files in
the Windows NT operating system assume that you installed
Windows NT in this directory.

Indicates the group membership required for the account used
to log on to Windows NT in order to complete the task
described.

Indicates a special note for RISC-based computers.

Guidelines for mouse and keyboard actions are described in Chapter 2,

“Windows NT Basics.”
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Introducing Windows NT

After you install Windows NT, you can begin working right away. Windows NT
takes care of most configuration tasks automatically, including preserving settings
for other operating systems such as MS-DOS if you maintain dual-boot
capabilities. You can run your applications and manage files immediately, without
editing special configuration or initialization files.

This chapter presents the basic information you need to get started with
Windows NT and explains what you can do with the Windows NT operating
system.

If you are new to using a graphical user interface such as Microsoft Windows or if
you want a quick review, see Chapter 2, “Windows NT Basics,” for a summary of
the basic procedures you need to know.

Starting and Quitting Windows NT

As an operating system Windows NT affects every aspect of your work on the
computer, from when you first turn it on, through il your actions to start
applications, save files, and communicate with oth :r users over the network.

This section describes how to start Windows NT and log on to your computer, and
also describes how to use online Help and the Windows NT introductory
demonstration.

Starting Windows NT

Because Windows NT is a secure system, you must identify yourself, or “log on,”
and enter a password each time you start Windows NT.

» To start Windows NT

1. Turn on your computer.
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2. Press an arrow key at the boot loader prompt to choose Windows NT from the

list of operating systems on your computer, and then press ENTER.

. When the logon message appears, press CTRL+ALT+DEL to log on.

@ Press Chl+Alt+Del to log on

Important The CTRL+ALT+DEL sequence ensures the security of your system.
Even if you see a message already displayed that asks you to enter your
password, always press CTRL+ALT+DEL before you type your password.

In the Welcome dialog box, type your username and password, and also select
either your local computer name or the name of a Windows NT Advanced
Server domain, and then choose the OK button.

Usemame: |anniep

st

From: I terrier

Password: |

Your username, user account, and password are unique identifiers defined while
running Setup. If you do not know the correct entries for logging on a computer,
ask your network administrator.

The entry in the Username box is the name you entered while running Setup to
identify your user account, or it is the username assigned by the network
administrator. Each time you log on, Windows NT proposes the username for
whoever last logged on at this computer.

The entry in the From box is either your local computer name or the name of
the Windows NT Advanced Server domain to which your computer belongs.

The entry in the Password box is the one you defined while running Setup or
that the network administrator defined for you. Leave this box blank if there is
no password defined for your user account.

As soon as you log on, you can run applications, share files with other users on
the network, connect to a printer, and control who has access to your computer
and its files, as summarized in “What to Do After Setup” later in this chapter.
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Using Windows NT Help

Online Help in Windows NT is a convenient, quick way to look up information
about a task you are performing or a feature or dialog box you would like to know
more about.

Windows NT Help includes the following:

* A description of each command available from the Command Prompt
= Information about Microsoft Product Support Services
= Full-text search capability that enables you to find Help information quickly

= An explanation of how to use full text search

Starting and Quitting the Online Demonstration

The online demonstration installed with Windows NT introduces the built-in
networking security and workgroup features of Windows NT. The topics include
the following:

= Logging on to Windows NT

= Connecting to other computers and sharing files on a network

= Creating user accounts and setting file permissions

= Connecting to a printer

= Using ClipBook to share information over the network

=  Communicating with other users

» To run the “Introducing Windows NT” online demonstration
1. Choose the Introducing Windows NT icon in the Main group.

2. To quit, press the ESC key once if you are viewing the main menu, or press ESC
twice if you are viewing a topic.

Quitting Windows NT

When you are working in Windows NT, you can press CTRL+ALT+DEL to change
your password, to lock or secure the computer, or to log off so that you can restart
your computer or log on using another user account.

» To log off the current session
¢ From the File menu in Program Manager, choose Logoff, or press ALT+F4.
—Or—

® Press CTRL+ALT+DEL, and then choose the Logoff button in the Windows NT
Security dialog box.
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Logon Information

Annie Pearson is logged on as anniep\terrier.

Logon Date: 12/1271992 12:34

Use the Task List to close an application that is not responding

Lock Workstation

Change Password. .

To turn off your computer
e From the File menu in Program Manager, choose Shutdown.
—Or—

e Press CTRL+ALT+DEL, and then choose the Shutdown button in the Windows
NT Security dialog box.

Caution Never use the computer’s power switch to quit Windows NT, or you
may lose data. Always use Shutdown to quit, so Windows NT can save changes in
all working files and properly close applications and services.

What to Do After Setup

The Windows NT operating system affects every aspect of your work on the
computer, from when you first turn on the computer, through all your actions to
start applications, save files, and communicate with other users over the network.

Although Windows NT takes care of most configuration tasks automatically, you
might want to modify your working environment or add elements to your system.
This section suggests activities for using and modifying your system after
installing Windows NT.

Using Windows NT Applications

Program Manager is the application that runs each time you start Windows NT.
You can use Program Manager to organize and start applications and tools. The
first time you start Windows NT, Program Manager shows the Main group
window open on the desktop, plus icons for several built-in program groups. For
more information, see Chapter 3, “Program Manager.”

The following table lists the applications provided with Windows NT.
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Application

Used to

Main group:

File Manager

Control Panel

Print Manager

Mail

Schedule+
Command Prompt
PIF Editor
ClipBook Viewer

Windows NT Setup

Introducing
Windows NT

Windows NT Help
User Manager
Backup

Event Viewer

Disk Administrator

E@ Performance Monitor

Manage files and directories, share files on the
network, and connect to shared directories on other
computers. See Chapter 4.

Customize the fonts, color, and desktop, and to
configure hardware devices and the network. See
Chapter 5.

Connect to, configure, and share printers, and control
printing of documents. See Chapter 6.

Send and receive electronic mail. See Chapter 7.
Maintain a personal calendar and schedule meetings
automatically. See Chapter 8.

Start programs or run batch files for MS-DOS,
MS OS/2 version 1.x, and POSIX. See Chapter 9.

Create or change program information files for
running MS-DOS-based applications. See Chapter 9.

Store clippings from data files and share that
information over the network. See Chapter 10.

Install device drivers and Windows NT components.
See Chapter 12.

View an online demonstration of the networking,
security, and workgroup features of Windows NT.

Get information on the online Help features of
Windows NT.

Create user accounts and groups, and define policies
for users and groups. See Chapter 13.

Back up and restore files on a tape drive for NTFS,
FAT, or HPFS file systems. See Chapter 14.

View and manage event logs for system, security,
and application events. See Chapter 15.

View and manage hard disk partitions and other disk
resources. See Chapter 16.

Measure CPU use and other data on system
performance. See Chapter 17.
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Setting Up Startup Applications

You can specify which applications will start automatically whenever you log on.
These changes will only be saved for your user account. If another user logs on to
your computer, or if you log on to another user account, the startup applications
defined for that user account will appear.

To define startup applications

e In Program Manager, open the Startup group and add a program item for each
application that you want to start each time you log on, following the
procedures in “Creating a Program Item” in Chapter 3, “Program Manager.”

Setting Up Your Personal Working Environment

>

>

4

You will probably want to configure the appearance and content of your basic
workspace, the desktop.

Note If your computer is a member of a Windows NT Advanced Server domain,
the network administrator might have created a user profile for you. Ask your
network administrator if a user profile controls your personal working
environment. Changes you make to your workspace may not be retained the next
time you log on if a user profile controls your workspace.

To configure how your workspace looks and sounds

1. In Control Panel, double-click the Color, Desktop, and Sound icons to define
how your desktop looks and sounds, following the procedures in Chapter 5,
“Control Panel.”

2. In the Command Prompt window, choose commands from the Control menu
to configure fonts, screen size, position, and color, following the procedures in
Chapter 9, “Command Prompt.”

To set up custom program groups for running applications

e In Program Manager, create program groups and add program-item icons,
following the procedures in “What Are Groups and Program Items?” in
Chapter 3, “Program Manager.”

To change your password
1. Log on to Windows NT in the usual way, and then press CTRL+ALT+DEL.
2. In the Windows NT Security dialog box, choose the Change Password button.

3. In the Change Password dialog box, type your old password, a new password,
and a confirmation in the appropriate boxes, and then choose the OK button.
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Configuring the Network

Security

Windows NT provides network services so that users can connect computers to
share files, printers, and other resources. The following tools in Windows NT help
you configure and monitor the network.

To install, configure, or remove any network component and to join a workgroup
or domain, you must be logged on as a member of the Administrators group.

Use To

Network in Control Panel  Install and configure software to support the network, and to
Jjoin workgroups or domains.

Event Viewer View the system, security, and application events on a
computer to monitor how the computer is being used.
File Manager Share files and directories on the network, and connect
to shared directories.
Print Manager Share printers on the network, and connect to shared printers.
Server in Control Panel View connected users, shared resources, and open resources;

manage directory replication and designate recipients of
administrative alerts.

Services in Control Panel  Start and stop network services.

User Manager Manage user accounts, group members, and security policies.

Joining a Workgroup or Domain

Note You do not need to complete this procedure if your computer joined the
correct workgroup or domain during Setup.

In Windows NT, a workgroup is a collection of computers that appear under the
same workgroup name on the network. This grouping makes it easy to find
directories or printers shared by people you work with.

Besides providing the same network browsing capabilities as a workgroup, a
Windows NT Advanced Server domain is a collection of computers that can
recognize the same user accounts. Membership in a domain is assigned by the
domain administrator in a Windows NT Advanced Server network.

» To join a workgroup or a Windows NT Advanced Server domain

1. At the computer which will join the workgroup or domain, log on as a member
of the Administrators group. For example, you might be able to log on under
the username “Administrator” and use this account to make changes.
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2. In the Network option of Control Panel, choose the Change button bes le the

Workgroup or Domain name at the top of the dialog box, and then foliow the
procedure as described in “Configuring the Network” in Chapter 5, “Control
Panel.”

Browsing Other Computers and Resources on the Network

In Microsoft Windows-based networking you can browse domains, workgroups,
and computers to look for shared directories and printers.

» To browse for shared directories on the network

1.

In File Manager, choose Connect Network Drive from the Disk menu, or
choose the Connect Drive button on the toolbar.

. The networks, domains and workgroups, computers, and shared directories are

organized in a tree structure. From the Shared Directories box, choose an item
to expand the list: Choose a network name to display available domains and
workgroups, a domain or workgroup name to display available computers, or a
computer name to display its shared directories.

» To browse for shared printers on the network

1.

In Print Manager, choose Connect to Printer from the Printer menu, or choose
the Cc aect to Printer button on the toolbar.

. From : e Select Printer box, choose an item to expand the list: Choose a

netwo: .- name to display available domains and workgroups, a ‘omain or
workgioup name to display available computers, or a computer aame to
display its shared printers.

To connect to a printer, double-click on a printer name.

Managing Files and Disks

A key function of any operating system is to provide a file system for storing and
managing your application and data files. The tools for file management in
Windows NT include the following.

Use To

Windows NT Setup Specify a file system for Winc.»ws NT during setup.

File Manager Create and delete directories, rianage files stored in
directories, and define file attributes.

Server in Control Panel View and remotely manage other computers.

Convert utility Change a FAT or HPFS file system to NTFS for a disk

partition after Setup. Run CONVERT.EXE from the
command prompt.
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Managing Files
When you format a hard disk, you prepare it to store files using a particular file

system. Most operating systems require a specific file system to store files on a
hard disk. Windows NT automatically supports the following three file systems:

= The Windows NT File System (NTFS) is a new advanced file system that
supports file recovery, extremely large storage media, and long filenames.
NTEFS is required if you want maximum data security for your installation, and
is recommended if Windows NT is the only operating system on your
computer.

= The File Allocation Table (FAT) is the file system used by the MS-DOS
operating system, limited to eight-character filenames with three-character
extensions. FAT does not provide security. FAT is required for the system
partition if you also use MS-DOS on your computer.

= The High Performance File System (HPFS) is the file system used with the
OS/2 operating system version 1.2 or later, which supports long filenames.
HPFS does not provide security.

If you choose to install Windows NT on a disk partition formatted for FAT or
HPFS, Windows NT automatically observes all the file-naming conventions of
those file systems. For more information, see “Working with Files and
Directories” in Chapter 4, “File Manager”; see also the online Command
Reference and your documentation for Microsoft MS-DOS or Microsoft 0OS/2.

If you choose to use NTFS with Windows NT, these new file-naming conventions
apply:

= File and directory names can each be up to 256 characters, including
extensions; and a name can have multiple extensions separated by periods.

= Names can contain any uppercase or lowercase characters except the
following:

2N " < > |

= If you mix uppercase and lowercase characters in a filename, Windows NT
preserves the case when it displays the name. However, Windows NT does not
regard case when distinguishing filenames you enter in dialog boxes or at the
command prompt.

* You can search for filenames or perform other multiple-file operations in
Windows NT using wildcards, where an asterisk (*) stands for a whole word
or group of characters, and a question mark (?) represents a single character.

When you create a file with a long name under NTFS, Windows NT also
automatically creates a filename that is compatible with MS-DOS, so that
computers running MS-DOS or applications that don’t support long filenames can
still identify the file.
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Setting Up to

>

Print

Windows NT provides several advantages in printing:

= If you use Windows NT printers on the network, separate printer drivers do not
have to be installed on each workstation, because the printer driver is stored on
a single computer.

= You can browse for available printers on the network.

= You do not have to redirect a port for the printer—you just connect to a
printer using Print Manager.

= You can manage your print job from your local computer.

You can choose Print Manager in the Main program group of Program Manager
to install and configure printers.

To connect to, install, or configure a network printer

e If the network printer is on a Windows NT network, follow the procedures in
“Connecting to a Network Printer” in Chapter 6, “Print Manager.”

Or, if printer is on another kind of network, follow the procedures in
“Installing a Printer” in Chapter 6.

Configuring Your System

Security

What happens when you start your computer depends on various elements:

= The defaults you define for the boot loader and any user environment variables
you define for applications

= The services you configure to start automatically

= The applications you specify in the StartUp group in Program Manager

= The contents of your logon script

= Any user profile that might be assigned by the administrator for a Windows
NT Advanced Server domain

This section describes how to get started with defining each of these elements.

You can change some system settings only if you are logged on as a member of
the Administrators group or if you belong to another group that can configure the
computer. If you cannot run any application for changing system settings, ask
your network administrator for assistance. For more information, see “Managing
the Security Policies” in Chapter 13, “User Manager.”
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In Microsoft Windows NT, you define all elements of your system configuration
using graphical tools such as Control Panel and Windows NT Setup.

Windows NT automatically stores values that define the working environment for
Windows NT, plus the information for running applications or for using alternate
operating systems.

The Control Panel is probably the main tool you will use to change your system
configuration. For example, you can choose the Fonts option to install or remove
screen fonts, including TrueType fonts. Also, some configuration values change
automatically when you install new software or when you define your workspace
in an application such as Microsoft Excel.

The following key tools can be used to configure system hardware and software.

Use To

Windows NT Setup Install drivers for the video display, mouse, and keyboard for
the computer. Install or remove supporting components for
Windows NT.

Control Panel Define desktop appearance and configure hardware and
software for the computer and for the network.

PIF Editor Change the memory settings required for running
MS-DOS-based applications.

Print Manager Install and configure printers to be used with your computer.

System in Control Panel Define environment variables and preferences for alternate

operating systems.

Defining the Boot Loader
and Other Operating System Variables

You can specify the default operating system that your system proposes at startup,
define user environment variables, and add or configure virtual-memory paging
files to optimize performance in Windows NT.

To configure boot loader, user environment variables, or virtual memory

® In the System option of Control Panel, specify the settings you want, following
the procedures in “Defining Options for the Operating System” in Chapter 5,
“Control Panel.”

The boot loader defines the information needed for system startup, such as the
location for the operating system’s files. Windows NT automatically creates the
correct configuration and checks this information whenever you start your system.
How this configuration information is stored depends on your system’s
microprocessor:
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= For an x86-based computer, Windows NT saves your startup preferences in the
BOOT.INI file in the root directory on your main hard drive. Configuration
files such as AUTOEXEC.BAT and CONFIG.SYS are used only to specify
memory and other parameters for MS-DOS-based applications that you might
run under Windows NT.

= For a RISC-based computer, your startup preferences and all other system
configuration information are stored in non-volatile RAM.

You don’t have to keep another operating system such as MS-DOS on your
computer to run applications created for that operating system. For information
about running applications created for other operating systems, see Chapter 11,
“Other Application Environments.”

Setting Up Startup Network Services

Windows NT starts several network services automatically, so that the capabilities
of the Windows NT network are automatically available as soon as you want to
work with the system. For example, the Computer Browser, Event Log,
Workstation, and Net Logon services start each time you log on. You might also
want to start other services automatically at system startup, depending on your
system needs.

To start network services automatically when you log on

e In the Services option of Control Panel, set up services that you want to start
automatically, following the procedures in “Managing Services” in Chapter 5,
“Control Panel.”

Setting Up User Accounts and Groups

If your computer is not a member of a Windows NT Advanced Server domain,
you must create local user accounts and specify user groups. You might want to
create user accounts and groups for everyone who will use your computer.

A user account consists of all the information that Windows NT uses to allow
someone to use a computer, including the username, a description, a password,
and the groups to which that user belongs.

A group is an account that contains other accounts, which are called “members.”
Groups provide an easy way to grant common capabilities to several users,
because all rights and permissions assigned to a group are provided to its
members.
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» To set up user accounts and groups for a single computer

1. In the Administrative Tools group in Program Manager, double-click the User
Manager icon.

2. Create the user accounts you want, following the procedures in “Managing
User Accounts” in Chapter 13, “User Manager.”

3. Create the groups you want, following the procedures in “Managing Groups”
in Chapter 13, “User Manager.”

Applications and Commands for User Accounts and Shared Resources

Task Configuration application
Set up user accounts User Manager

Set up local groups User Manager

Set up shared resources File Manager, Print Manager

Managing Security

The security provided through Windows NT when you use NTFS, combined with
regular use of the Backup utility, can eliminate almost all possibility of data loss.
Security in Windows NT consists of two basic elements: preventing data loss
resulting from unauthorized access or preventing data loss resulting from file
damage.

Security For most actions related to security, you must log on as a member of the
Administrators group.

Controlling Unauthorized Access

To control unauthorized access, Windows NT includes tools for limiting initial
access to the system itself, to specific files and directories, and to resources such
as printers. Windows NT also includes tools for monitoring security events.

The tools for controlling access to the system include the following.

Use To
CTRL+ALT+DEL Change your password.
File Manager Share resources and establish permissions to protect specific

files and directories.

Network in Control Panel  Define limits for sharing a computer’s resources with
other users on the network.

User Manager Create user accounts for identification and authentication
when the user logs on, and authorize the specific actions a
user can perform on the system.
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You can also change your password by pressing CTRL+ALT+DEL and then choose
the Change Password button in the Windows NT Security dialog box.

The tools for auditing security transactions in Windows NT include the following.

Use To

Event Viewer Define the size and management of the security event log.
File Manager Define the files, directories, and users to be audited.

Print Manager Define printers to be audited

User Manager Define the kinds of events to be audited.

Preventing File Damage and Data Loss

When you use NTFS, Windows NT logs all file transactions, replaces bad sectors
automatically, and stores copies of all vital information. Therefore, Windows NT
can preserve disk integrity and ensure complete, rapid recovery after power
failure or other system failures.

No matter which file system you use, Windows NT also automatically preserves
a working boot configuration to ensure that you can always start Windows NT, in
spite of any changes to the system configuration that may occur during a work
session. Windows NT also requires that you create a Repair disk during Setup so
that your system can be repaired if boot information or system files are corrupted
at startup.

Setting Up Security Policies

You can define three basic security policies for your computer:

»  The Account policy controls how passwords are used by user accounts.

= The Audit policy controls what types of events are recorded in the Security log
(which you can view in Event Viewer).

= The User Rights policy controls the rights assigned to groups and user
accounts for your computer. We do not recommend that you change these
default settings.

To manage security policies for your computer

e From the Policy menu in User Manager, choose Account or Auditing, and then
follow the procedures in “Managing the Security Policies” in Chapter 13,
“User Manager.”
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CHAPTER 2

Windows NT Basics

This chapter reviews the basics for working in Windows NT. These features and
the related procedures in the graphical user interface of Windows NT are identical
to those in versions of Windows for MS-DOS. If you are familiar with Windows,
you can skip this chapter. You can practice any of the basic procedures described
here without fear of harming your system.

This chapter emphasizes using the mouse to complete tasks. For information
about using the keyboard to work with windows and dialog boxes, see “Using the
Keyboard” later in this chapter. The following topics are included in the chapter:
= Selecting items for action

= Managing windows

= Choosing commands

= Using the Control menu and Task List

= Using Help

= Using dialog boxes and responding to system messages

=  Copying and pasting information between applications

= Using keyboard shortcuts

Selecting Items for Action

In Windows NT, you can accomplish most tasks by selecting an item such as an
icon, window, or other element, and then choosing a command. You can use a
mouse or other pointing device such as a pen to select items and carry out actions
in Microsoft Windows NT. For example, you select an item by pointing to it with
the mouse and clicking.

The procedures in this manual and in Help assume that you configured the left
button as the primary mouse button. Any procedure that uses the secondary button
will refer to it as the right mouse button.
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The following terms are used to describe mouse actions.

Mouse term Meaning

Point Move the mouse until the tip of the mouse pointer rests on what
you want to choose on the screen.

Click Press and release the mouse button without moving the mouse.
Clicking an item selects it. For many actions, you can select
multiple items by holding down SHIFT while clicking.

Double-click Click the mouse button twice in rapid succession.

Drag Hold down the mouse button while you move the mouse.
For some actions, you can extend a selection by pressing SHIFT
while dragging. For other actions, you can move a copy of a
selection to another location by pressing CTRL while dragging.

Guidelines for Selecting ltems and Using the Mouse

To use Windows NT efficiently, use the mouse to select items and initiate
commands. The following list presents basic guidelines for using the mouse:

= When you select an icon, dialog box option, or other item, the selection is
highlighted. For example, selected text or the label on a selected icon appears
in reverse color.

= To cancel a selection, click another item.

= Double-clicking usually initiates the same action as selecting the item and then
choosing a command. For example, double-clicking an icon in Program
Manager is the same as selecting the icon and then choosing the Open
command from the File menu.

= When you move the mouse, the mouse pointer shows your location on the
screen and often changes shape when the mouse crosses different areas on the
screen. The following table shows some examples.

This pointer Appears

L\\s Where you can click to select items.

ey Where you can drag the window border to size a window.
+ Where you can draw or paint.

I Where you can enter text in a window or dialog box.

R? When you start an application and can continue working while
E Windows NT completes a background task.
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Managing Windows

All Windows NT operations take place on the desktop, the area of the screen
where elements such as windows, icons, and dialog boxes appear. When you first
start Windows NT, the Program Manager application window appears on the
desktop, showing the Main group window and group icons for the other
applications installed with Windows NT.

You can move windows and icons around on the desktop. When you click a
window to begin working, the title bar changes color to show that it’s the active
window, and the window automatically becomes the topmost window.

You can switch to other windows on the desktop by clicking the window you
want, or by pressing ALT+TAB to cycle through the running applications. You can
also use the Task List to switch windows, as described in “Using the Control
Menu and Task List” later in this chapter.

Starting Applications in Program Manager

Program Manager is a Windows NT application that you use to start applications
and also to organize applications and working files in logical groups. Applications
and files are represented in Program Manager as program-item icons, and
organized in groups that appear as windows or icons within the Program Manager
window. You start an application by choosing its icon. For more information, see
Chapter 3, “Program Manager.”

Moving and Sizing Windows

Y ou can move or size most windows in Windows NT, or scroll the contents of the
window with the basic mouse actions shown in the following illustration.

Drag the title bar to move a window

Drag a bord+ or corner
of a window . size it.

| File Edit Search Help

Drag the scruil box to
scroll continuously.

Click a scoll arrow to
scroll incrementally.

The following list shows how to use the buttons in the window frame to manage
the size and position of the window.
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Choose To
Display the Control menu (this is the same as pressing
ALT+SPACEBAR).

Reduce the application to an icon (this is the same as choosing

Minimize from the Control menu).

Enlarge the application window to full screen (this is the same as
= choosing Maximize from the Control menu).

Return the application window to its previous size (this is the same
' as choosing Restore from the Control menu).

Using Document Windows

Some Windows-based applications also present document windows so that you
can view more than one document simultaneously. You can size, scroll, and
arrange document windows, but you cannot move them outside the application
window.

File Edit View Insert Format Tools Table Window ﬂelp
FILE.DOC:1

[ Control menu Maximize button /
Scroll arrow
Scroll bar

Choosing Commands in Windows NT

When you work with applications in Windows NT, you choose commands to
complete actions. The applications and tools included with Windows NT provide
several ways to choose commands. You can:

= Use the mouse or keyboard to choose commands from the menu bar.

= Choose buttons on toolbars (where available).

= Use the drag-and-drop features in Program Manager or File Manager to move,
copy, and print files, or to start applications.
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This section describes how to choose commands from the menu bar in all
Windows-based applications. For information about using drag-and-drop in
Windows NT, see “Working with Files and Directories” in Chapter 4, “File
Manager.” For information about using a toolbar, see the documentation for your
application.

In all Windows-based applications, commands are grouped on menus, with the
menu names displayed in the menu bar across the top of the application window.
Each application has different menus, but most applications include at least a
File menu, Edit menu, and Help menu.

» To choose a menu command

1. To display the menu, point to the menu name in the menu bar and hold the
mouse button down.

2. Drag to select the command you want, and then release the mouse button.

You can also press the ALT key and the underlined
letter in a menu name to display the menu...

. Options Window Help
...then press the underlined

Open Enter letter in the command name
Move... F7 to choose it.

Copy... F8

Delete Del

Properties... Alt+Enter

Run...

Logoff... Alt+F4

Shutdown...

\ Some commands have a shortcut
key for choosing the command
without displaying the menu.

Guidelines for Working with Menus in Windows NT

The following list presents some basic guidelines for menus:

= When the menu is displayed, you can also press an arrow key to highlight
a command name and then press ENTER to choose the command.

= When you choose a command that ends in an ellipsis (...), the application
displays a dialog box that asks you to supply more information.

= If a command turns a feature on and off, a check mark (v') appears by the
command name when the feature is on.
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= When you choose a command that ends with an arrow (> ), the menu cascades
to display more command names.

= If a command name is dimmed, it indicates that the command does not apply
to the current situation or that you need to make a selection or complete
another action before choosing the command.

Using the Control Menu and Task List

All windows have a Control menu. You can use it to switch to another running
application; close the window or quit the application; change the size and position
of a window, or minimize or maximize it.

Most dialog boxes and messages also have a Control menu, usually with
commands for moving or closing the dialog box.

Click the Control-menu box on any
window to display its Control menu.

Move

Size

Minimize These cqmmands are the.same
Maximize as dragging borders or using
Close AFA buttons to change the window.

Switch To... Ctrl+Esc Choose Switch To if you

want to use the Task List.

To use a window’s Control menu

1. Click the Control-menu box in a window, or click an application icon on the
desktop. Or press ALT+SPACEBAR to display the Control menu for an
application window or for a dialog box. Press ALT+HYPHEN (-) to display the
Control menu for a document window.

2. Choose a command for the action you want.

The commands available on the Control menu vary for different applications,
but most Control menus include at least the Move and Close commands.

The Control Menu for each application window includes the Switch To command,
which displays the Task List. You can use the Task List to switch to other
currently running applications, or to manage windows and icons on the desktop.
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Although it is usually easiest to switch to another window by clicking that
window, your current application may fill the screen, or some of the windows
may not be visible. With Task List, you can switch windows quickly without
having to search for the window you want.

» To use the Task List
1. From the Control Menu, choose Switch To; or press CTRL+ESC.
2. In the task list, select the name of the application you want to work with.

To switch to a task not on the list, in the New Task box, type the executable
name for the task you want. Choose the Run button.

ger

New Task: |c0nlml l I ﬁ“ﬂ]

Anange Icons

3. Choose one of the following buttons for the action you want.

Choose To

Switch To Switch to the application selected in the list.

End Task Quit the selected application.

Cancel Close the Task List. You can also press ESC or double-click
the Control-menu box to quit.

Cascade Display windows in layers, showing the title of each
window.

Tile Resize all windows and arrange them side by side.

Arrange Icons Rearrange application icons on the desktop.

» To switch applications without using the Task List
e Press ALT+TAB.

Continue pressing ALT+TAB until the window you want is displayed.
If you do not want to use ALT+TAB for switching between windows, you can turn

off this capability by choosing the Desktop icon in Control Panel and then
selecting the Fast ALT+TAB Switching check box in the Desktop dialog box.
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Using Help

Windows NT provides Help so that you can get useful information quickly while
you are working. Help contains a description of each command and dialog box,
and explains procedures for most tasks.

To get Help

Press F1 wherever you are working.

The following illustration shows the Help Contents window for Program
Manager. The Help Contents lists the major topics for the current application.
From this window you can move to more specific information, in this example,
the Windows NT Glossary.

=

Program Manager Help

File Edit Bookmark Help

Manager Help

Note: The Help messagsg
do not reflect all the feat
Windows NT and are sub
change.

Windows NT Program Manag
wou can use to easily start ap
arganize your applications ar
logical groups.

To learn how to use Help, pret

Note: The Glossary entries
in this file do not reflect all
the features of Windows NT
and are subject to change.

How To... A

Arrange Windows and lcons
Change anlcan
Qrganize Applications and D

Start an Application
Citely Db lication

=2 gctive

@@ gnhotation

== application

= application window

s srrona leon o
— |

»

» To search for a Help topic

1.
2.

In the Help window, choose the Search button.

In the Search dialog box, type the first letter of the word or phrase you’re
looking for, or select a word or phrase from the list of keywords.

When you type a letter, the selection in the list shifts to the first keyword that
begins with that letter. If several keywords begin with the same letter, you can
type additional letters to move the selection to the keyword you want.

. Choose the Show Topics button to display a list of topics, and then select a

topic from the list.

Choose the Go To button to view the selected topics.
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The following table summarizes the actions you can take while using Help.

To

Do this

Get help in a Windows-based
application

Get help in a dialog box or
message box

Get help on using Help
See a list of Help topics
Get help on a specific topic

Go back to a previous topic
Jump to another Help topic
Display a definition
Continue working with Help
displayed

Minimize Help to an icon

View another Help file

Exit Help

Press F1 for context-sensitive Help, or chose a command
from the Help menu.

Press F1, or choose the Help button in the dialog box.

From the Help menu, choose How To Use Help.
Choose the Contents button.
Choose the Search button and select a topic to view.

Choose the Back button, or choose the History button and
double-click any listed topic.

Click the underlined jump term, or choose a “hot” button
in the Contents topics.

Click the term with the dotted underline, and then click
anywhere on the screen to close the definition.

From the Help menu in the Help window, choose Always
On Top.

Choose the Minimize button in the Help window.

From the File menu in Help, choose Open and select
another .HLP filename.

Double-click the Control-menu box.

You can also set bookmarks for frequently used Help topics, and annotate any
Help topic. These and other Help features are explained in Help.

Help is also available at the command prompt for all Windows NT commands.
The following table shows the syntax for Help at the command prompt.

Syntax Information provided
help Available native system commands.
command [? Description, syntax, parameters, and switches for native

help command

net help

net command ?
net command /help
net help command

net help command /options

system commands, plus help for MS-DOS subsystem
commands not listed when you type help.

Description, syntax, parameters, and switches for native
system commands.

Available network commands.

Syntax only for network commands.

Syntax and description for network commands.
Syntax and description for network commands.

Parameters and switches for network commands.
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You can also use the online Command Reference, which displays additional
details, examples, and conceptual information for the system or network
command you typed. To start the Command Reference, double-click the Help
icon in the Main program group.

Using Dialog Boxes

Windows NT displays a dialog box to ask for information and to provide
information you need to proceed. When you choose a command that displays a
dialog box, that dialog box may include areas where you type numbers or text.
You may also see various options to change or view settings related to the
command.

Option button Check box

& Option 2

|

Check bo: A IfICheck box B

Drop-down L. st:

-~ Command buttons

List Box: Items ¥
ltem1 Text box: [Pl
Item?2 ) . .
Item3 Spin button: [0 units —— Miscellaneous controls: text box,
ltem4 Slow Fast spin button, and scrolling scale.
item5 ‘

5,

\— List box

» To use a dialog box
1. Select options or type text to specify the information you want in a dialog box.

Click an option to select it, or press ALT plus the underlined letter in the option
name. If any item in a dialog box is dimmed, it is unavailable because it
requires a selection or some previous action.

To see a description of the options, press F1 or choose the Help button in the
dialog box.

2. To move the dialog box in the window, drag its title bar.

3. When you finish with the dialog box, choose the appropriate command button
to carry out the command.
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Usually, clicking the OK button carries out the command. Sometimes the
button that carries out the command has a label such as Open or Find Next.

» To close a dialog box without completing the command

e In the dialog box, choose the Cancel button, or double-click the Control-menu
box.

Guidelines for Buttons and Miscellaneous ltems

The following list presents some basic guidelines for using buttons and other
items in dialog boxes.

Option buttons and check boxes:

= Click a round option button to select it and to turn off any other option in the
group. You can select only one option button in a group.

= Click a check box to turn that option on or off. You can select as many check
boxes as you want.

=  When an option button or check box is selected, it’s filled—a selected option
button contains a dot and a selected check box contains an “X”.

Command buttons:
» If you choose a button with an ellipsis (...), another dialog box appears.

= If you choose a button with double arrows (>>), the dialog box expands.

List boxes:
= Click an item in any kind of list to select it, or scroll to see more items.
= In a drop-down list box, click the arrow to display a list of options to select.

= In some lists, you can select multiple items. In such a list, click a selection a
second time to turn it off.

Miscellaneous items:

= Type, edit, and paste text in any text box. If a text box contains text when you
move to it, all the text is selected and any text you type replaces it. Press DEL
or BACKSPACE to edit the text.

= Scroll a spin button or type in the box to select a number.

= Drag a scroll box to select a range in a scale.
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Responding to Messages

Windows NT displays messages or warnings if you should know about possible
consequences of a command action, or if Windows NT requires more information
or cannot complete a command for any reason.

Most messages explain the problem and what you should do to continue working.
Often, the Help button also appears so that you can get more information.

» To dismiss a message

o Choose the OK button.

If the message contains two or more command buttons, choose the OK button
to proceed, or choose the Cancel button to cancel the action and dismiss the
message.

Cutting and Copying Information

When you cut or copy information from an application, it is placed onto the
Clipboard, which is a temporary storage area in your computer’s memory. You
can then paste that information from the Clipboard into other documents or
applications. You can also use the Clipboard to transfer information between
Windows-based applications and some MS-DOS—based applications.

In some Windows-based applications, you can also paste information from the
Clipboard to create a linked or embedded object. For more information, see
Chapter 10, “Object Linking and Embedding.”

You can use the ClipBook Viewer to view and save the contents of the Clipboard.
For more information, choose the ClipBook Viewer icon in Program Manager,
and then press F1 to get help.

Transferring Information Between Windows-Based Applications

You can use the Cut, Copy, and Paste commands in most Windows-based
applications to copy or move information within a document, between documents,
or between Windows-based applications.

» To copy or move information with the Clipboard

1. In your document, select the information you want to copy or move.

2. To copy the information, choose Copy from the Edit menu. To move the
information, choose Cut from the Edit menu.
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» To paste information from the Clipboard

1.

If necessary, switch to the document or application that will receive the
information from the Clipboard.

2. Place the insertion point where you want the information to appear.

3. From the Edit menu, choose Paste.

Transferring Information Between MS-DOS-Based Applications

When you are running an MS-DOS—based application under Windows NT, you
can copy selected information or the entire screen onto the Clipboard. You can
paste only text into an MS-DOS—based application, not a graphic or screen
capture.

» To copy information from an MS-DOS-based application

1.

ok »

To open the application’s Control menu, click the Control-menu box or press
ALT+SPACEBAR.

From the Control menu, choose Edit.
From the cascading Edit menu, choose Mark.
In the document, select the information you want to copy.

From the application’s Control menu, choose Edit, and then from the
cascading Edit menu, choose Copy.

In the command prompt window, the text is copied automatically.

» To paste text into an MS-DOS-based application

1.

Copy the information onto the Clipboard.

2. Switch to the application into which you want to paste the information.
3.
4

. From the application’s Control menu, choose Edit, and then from the

Place the insertion point where you want the information to appear.

cascading Edit menu, choose Paste.

Copying Screen Images

For both Windows-based applications and MS-DOS-based applications, you can
copy an entire screen onto the Clipboard. For Windows-based applications, you
can copy an image of the active window onto the Clipboard. You can place this
image in any file that can save or display bitmap images.
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» To copy the entire screen onto the Clipboard as text

e Press PRINT SCREEN.

To copy a screen image for a non-Windows-based application, the application
must be running in text mode, not graphics mode.

» To copy an image of the active window onto the Clipboard

e Press ALT+PRINT SCREEN.

Using the Keyboard

Microsoft Windows NT and Windows-based applications provide a set of
common keyboard shortcuts that you can use to carry out commands and select

options in dialog boxes.

You can use these shortcut keys to bypass the menus.

The key names in the Windows NT documentation appear in small capital letters.
For example, the Shift key appears as SHIFT, and the Control key appears as CTRL.
The following conventions are used to describe keyboard actions in Windows NT.

Convention Meaning

KEYI+KEY2 A plus sign (+) between key names means that you must press
the keys at the same time. For example, “Press ALT+F4” means
you press and hold down ALT while you press F4.

KEY1,KEY2 A comma (,) between key names means that the keys must be
pressed sequentially. For example, “Press ALT, HYPHEN (-)”
means you press and release ALT, and then press the hyphen.

Keypad The numeric keys to the right of the standard alphanumeric
keys. Press NUM LOCK to toggle between numbers or arrow
keys.

Arrow keys The keys labeled UP, DOWN, LEFT, RIGHT, HOME, END, PAGE UP,

and PAGE DOWN on the extended keyboard or on the keypad;
used to move or scroll in a document, window, or list.

Each shortcut key may also work with the SHIFT, CTRL, and ALT keys for different
actions. The following list shows the general uses for shortcut keys, either
individually or in combination with other keys.
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Key

Used to

ENTER
ESC
F1,F2, F3, ...

INS, DEL, BACKSPACE
TAB; arrow keys

ALT+key

SHIFT+key
CTRL+key

Confirm or carry out an action.
Cancel an action.

Provide shortcuts for commands. If your keyboard has only 10
function keys, press ALT+F1 for F11, ALT+F2 for F12, and so on.

Edit—insert, delete, or clear an item.
Move the cursor, select an item, or scroll in a window or list.

Choose commands or dialog box options, or perform other
actions related to application windows.

Extend the selection.

Choose a command, apply an action in a dialog box, or perform
an alternate action on a selected object.

Using the Keyboard for Common Actions

You can use standard keyboard procedures for many of the common tasks
throughout Windows NT. The following procedures summarize how to start an
application in Program Manager and open a file in an application.

» To start an application in Program Manager

1. Press CTRL+TAB to select the group you want to open, and then press ENTER to
open that group window.

2. Press an arrow key to select the program-item icon for the application you
want, and then press ENTER to start the application.

Or press SHIFT+ENTER to start the application as an icon.

» To open a file in an application

1. Press ALT to select the menu bar.

2. To choose Open from the File menu, press F,0 (the direct-access keys, which
are indicated by the underlined letters in the menu bar and in the menus).

Or press the RIGHT ARROW and DOWN ARROW keys to select and open the
menu. Press the DOWN ARROW key to select Open, and then press ENTER to

choose it.

3. In the Open dialog box, press TAB to move between the list of files,
directories, and drives, and then press an arrow key to select the filename or

directory you want.

4. To choose the OK button, press ENTER.

To cancel your selection and close the dialog box, press ESC.
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This same series of keyboard actions works everywhere in Windows NT for
choosing menu items and for selecting options in dialog boxes.

Keyboard Shortcut Reference

The following tables summarize common keyboard shortcuts in Windows NT.
Keys that must be pressed sequentially are separated by a comma; keys that must
be pressed at the same time are separated by a plus sign.

Keyboard Shortcuts for Using Program Manager and File Manager
Basic Windows NT Keyboard Shortcuts

To Press
Help:

Open or switch to the Help window F1

Open or switch to context-sensitive Help SHIFT+F1
Move to and view the next jump term or definition TAB, ENTER

Using Program Manager and File Manager:

Open the selected icon ENTER

Move a selected group or item F7

Copy a selected item F8

Clear a selected group or item DEL

Edit properties of a selected group or item! ALT+ENTER
Cascade the windows on the desktop SHIFT+F5

Tile the windows on the desktop SHIFT+F4
Using File Manager:

Expand the directory tree one level in File Manager + (keypad)
Expand a directory branch in File Manager * (keypad)
Expand all branches in File Manager CTRL+* (keypad)
Collapse a directory branch in File Manager - (keypad)
Refresh the display F5

Scrolling in a Window or a Dialog Box:

Scroll up or down one line, or left or right one item Arrow keys
Scroll up one window PAGE UP
Scroll down one window PAGE DOWN
Scroll left one window CTRL+PAGE UP

Scroll right one window CTRL+PAGE DOWN
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Basic Windows NT Keyboard Shortcuts (continued)

To

Press

Moving and Selecting in a Window or a Dialog Box:

Move to an item in a dialog box and select it

Move left, right, up, or down in a window or
" dialog box

Move to the beginning of a line

Move to the end of a line

Move up or down one window

Move left one window

Move right one window

Extend the selection left, right, up, or down
Extend the selection to the beginning of the line
Extend the selection to the end of the line
Extend the selection up one window
Extend the selection down one window
Extend the selection left one window

Extend the selection right one window

TAB or arrow keys

Arrow keys

HOME
END

PAGE UP or PAGE DOWN

CTRL+PAGE UP
CTRL+PAGE DOWN
SHIFT+arrow keys
SHIFT+HOME
SHIFT+END
SHIFT+PAGE UP
SHIFT+PAGE DOWN

CTRL+SHIFT+PAGE UP
CTRL+SHIFT+PAGE DOWN

Editing in Dialog boxes or Applications:

Undo the last action

CTRLA+Z or ALT+BACKSPACE

Delete the selection SHIFT+DEL
Clear the selection DEL

Copy the selection CTRL+INS
Paste the selection SHIFT+INS
Clear the preceding character BACKSPACE
Working with a Window:

Select the menu bar ALT or F10
Carry out a command or action ENTER
Cancel a command or action ESC
Toggling full-screen and window display ALT+ENTER
for non-Windows-based applications?2

Select an application’s Control menu ALT+SPACEBAR

Select the Control menu in a document window
Display the Task List
Move to the next application

Quit the current application

ALT,HYPHEN (-)
CTRL4ESC
ALT+TAB
ALT+F4
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Basic Windows NT Keyboard Shortcuts (continued)

To Press

Working with Multiple Document Windows:

Move a document window CTRL+F7, arrow keys
Size a document window CTRL+F8, arrow keys
Maximize a document window CTRL+F10

Minimize a document window CTRL+F9

Restore a document window CTRLA+F5

Close a document window CTRL+F4

Move to the next document window CTRL+F6

Switch to the previous document window CTRL+SHIFT+F6
Move to the next pane F6

Move to the previous pane SHIFT+F6

1 This shortcut also toggles between full-screen and window display for the command prompt and
non-Windows-based applications

2 This shortcut also allows you to edit properties of a selected group or item in Program Manager and
File Manager.
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Program Manager

Overview

Use Program Manager to organize your applications and files in groups and to
easily start applications.

This chapter explains how to use Program Manager, including the following
topics:

= Quitting Windows NT

=  Working with group windows and icons

= Creating and deleting groups

= Creating, copying, moving, and deleting program items

= Changing program item icons

= Starting applications from Program Manager

= Starting applications automatically when you log on to Windows NT

Use Program Manager to start applications and to organize applications and files
on the Windows NT desktop. Program Manager starts when you log on to
Windows NT. The name of the computer or domain that you specified when you
logged on and your username appear in the title bar of the Program Manager
window. When you want to leave Windows NT, use Program Manager to log off
or shut down your computer.

The first time you log on to Windows NT, Program Manager opens on your
desktop with the Main group window open inside the Program Manager window.
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Program Manager lets you organize your applications so that you can easily find
and run them. To get working quickly, you can have an application open a
document automatically when it starts. Or you can start applications automatically
when you log on to Windows NT. Use groups and program items to organize your
applications. Groups can be displayed as windows or icons.

Program-item icons appear inside a group window and represent the applications,
accessories, and documents you can start from Program Manager. Double-
clicking a program-item icon starts the application that the icon represents.
Program-item icons can be moved between groups but not outside of them.

A group window is separate window inside the Program Manager window that
contains program-item icons. Each group window has its own control menu in the
upper left corner, but no menu bar. You can control group windows using
commands from the Program Manager menu bar. Group windows cannot be
moved outside the Program Manager window.

A group icon is a minimized group window. Group icons appear along the lower
edge of the Program Manager window. Each is labeled to indicate what sort of
program items are in the group. Like group windows, group icons cannot be
moved outside the Program Manager window.
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Quitting Windows NT Using Program Manager

Program Manager runs as long as you are running Windows NT. To end your
Windows NT session when you want to leave your computer running, return to
Program Manager and log off. When you want to turn off your computer, return
to Program Manager and use the Shutdown option.

» To log off from Windows NT
1. From the File menu, choose Logoff. Or double-click the Control-menu box.
2. Choose the OK button to confirm that you want to log off.

The system closes any running applications and displays the Welcome dialog
box. Before closing an application, the system prompts you to save any
unsaved work. Running services are not stopped.

» To shut down your computer
1. From the File menu, choose Shutdown.
2. Choose the OK button to confirm that you want to shut down your computer.

The system closes running applications and services, and informs you when
you can safely switch off your computer.

If you want to restart your computer immediately rather than switch it off,
select the Restart When Shutdown Is Complete check box. Windows NT
automatically restarts after closing applications and services.

Caution Never use the computer’s power switch to quit Windows NT. Always
choose the Shutdown command to quit, so Windows NT can save changes in all
working files and properly close applications and services.

What Are Groups and Program ltems?

A group contains program items. You can display a group as either an icon or a
window. When a group window is open, you can work with its program items—
icons that represent applications. When you choose a program item, the
application it represents starts. If you have specified a document in the program
item, the application opens the document for you when it starts.

Groups provide a convenient way to organize your applications, and program
items provide an easy way to start your applications. Because you can associate a
file with an application when you create a program item, you can create groups
that organize files belonging to a project and let you easily switch from one part
of the project to the next.
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Windows NT provides personal groups and common groups. Personal groups are
stored as part of each user’s logon information. Each time a particular user logs
on, that user’s personal groups appear. Common groups appear for all users who
log on to the computer. Personal and common groups have different icons:

244 243

A AP

e 2 el
Perzonal Commaon

Applications  Applications

When you installed Windows NT, the system created groups and program items
for applications.

Group Description

Main group Contains the Windows NT system applications including
File Manager, Control Panel, and Print Manager. The
Read Me item contains information you should know
before you start working with Windows NT.

Applications group Contains applications found on your hard disk.

Administrative Tools group Contains applications for system management including
User Manager, Disk Administrator, and Backup.

Accessories group Includes applications for word processing, drawing, and
communications, plus several other applications such as a
clock and a calculator.

Games group Offers games you can use to practice Windows skills.

Startup group Contains applications that start when you log on to
Windows NT. You can add any applications you want to
this group; it is empty until you add applications to it.

Opening Group Windows and Reducing Them to Icons

To start an application from a group, first open the group window that contains
the program-item icon for that application. Once you have started the application,
you can reduce the group window to an icon to free room on your desktop. For
more information on starting applications, see “Starting an Application from a
Group” later in this chapter.

» To open a group window

e Double-click the group icon. Or select the group’s name from the list at the
bottom of the Window menu. Or press CTRL+F6 or CTRL+TAB until the group
icon you want is selected, and then press ENTER.
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» To reduce a group window to an icon

e Click the Minimize button, or double-click the Control-menu box for the
group.

Arranging Group Windows

When several group windows are open, some windows will hide others. Use the
Cascade and Tile commands from the Window menu to arrange all the open
windows so that some part of each window is visible.

The Cascade command resizes and layers the open group windows within the
Program Manager workspace so that each title bar is visible.

Options Window Help

Games

Accessories

Control Panel  Print Manager ClipB ook Command

Viewer Prompt

“’)/} A
HICROSFT
HIHDOHENT

Windo NT PIF Editor Command Introducing
Setup Reference  ‘Windows NT

The Tile command divides the Program Manager workspace into smaller
windows of similar sizes for each group window you have open.



38 System Guide

Accessories

Paintbrush Terminal MNotepad

N om B o

ClipBook Command Calendar Calculator

Viewer Prompt

User Manager Disk Manager Performance Solitaire Minesweeper
Moritor

Backup Event Viewer

If you open another group window after you use the Cascade or Tile command, it
covers the arranged windows. To arrange it with the other windows, choose the
Cascade or Tile command again.

» To arrange all the open group windows

e From the Window menu, choose Cascade or Tile.

Arranging Group and Program-ltem Icons

You can arrange icons one at a time, or have Program Manager organize them all
at once. When Program Manager arranges group icons, it aligns them along the
lower edge of the Program Manager window. When arranging program-item
icons, Program Manager distributes them within their group window.

» To arrange icons one at a time

e Drag each icon to a new location.

» To arrange group icons
1. Select any group icon.

2. From the Window menu, choose Arrange Icons to align the group icons along
the lower edge of the Program Manager window.

» To arrange program-item icons

1. Open the group window that contains the program-item icons you want to
rearrange.
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2. From the Window menu, choose Arrange Icons to distribute the program-item
icons evenly within the selected group window.

Windows NT can automatically arrange program-item icons whenever you
change the window size, or add, delete, or move program items. You can adjust
the spacing between icons by choosing the Desktop icon from Control Panel, and
then typing a number in the Icon Spacing box.

» To automatically arrange icons
¢ From the Options menu, choose Auto Arrange.

A check mark beside the command means it is in effect.

Saving Program Manager Settings

Once you have set the appearance of your group windows and icons, you can save
it. Then each time you log on to Windows NT, they will appear as you set them
up. As an alternative, you can choose to save the appearance of group windows
and icons as they are when you log off of Windows NT. When you next log on to
Windows NT, they will appear as they were when you logged off.

» To save the current settings

e From the Options menu, choose Save Settings Now.

So that different settings are not saved when you log off from Windows NT, make
sure that the Save Settings On Exit command is not checked.

» To save settings when you log off from Windows NT
¢ From the Options menu, choose Save Settings On Exit.

A check mark appears next to the command. You can turn this feature off by
choosing the command again.

Creating Groups

You can create personal and common program groups using Program Manager.
Generally, you will only need to create personal groups. When you log on, the
groups you have created are ready for you. When another user logs on to the
computer, that user does not see your program groups. You can add any number
of groups to Program Manager to organize your applications and documents in a
way that makes sense to you. After creating a group, you can add program items
to it. For more information, see “Creating Program Items” later in this chapter.
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Create a common program group only when you want all users of the computer to
have access to the program items in the group. If, for example, you have installed
an application that you want to make available to all users of the computer, you
can place it in a common program group.

To create a common group, you must be logged on as a member of the
Administrators or Power Users group. Users who are not members of one of these
groups can copy program items from a common group to their personal groups;
however, they cannot delete or move program items from common groups.

» To create a new group

1. From the File menu, choose New.

New
) Program Item

® Personal Program Group

@] Common Program Group

2. In the New Program Object dialog box, select Personal Program Group or
Common Program Group, and then choose the OK button.

escription:

3. In the Description box, type a description for the group you want to create and
choose the OK button.

This description will appear in the title bar of the group window and below the
group icon.

Creating Program Items

To create a program item, define the properties for the item. You can create a
program item using Program Manager, File Manager, or Windows NT Setup. If
you use File Manager or Windows NT Setup to create a program item, Windows
NT will define the item’s properties for you. Each method of creating program
items has advantages:
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= Use Program Manager when you want to specify the program item’s properties

such as the application’s working directory or which document the application
will open when it starts. Also use Program Manager when you want to change
a program item’s properties.

When you are using a mouse, File Manager provides the most direct way to
create a program item and place it in the group you choose.

Windows NT Setup is fastest when you need to create many program items at
one time. For more information on this method, see Chapter 12, “System
Maintenance with Windows NT Setup.”

Creating or Changing a Program Item Using Program
Manager

You can use Program Manager to create a program item for an application or for
an application and a document. The following steps guide you through the basics
of creating a program item. If you want, you can also specify a working directory,
a shortcut key, and that the program start running minimized.

To create or change a program item in a common program group, you must be
logged on as a member of the Administrators or Power Users group.

» To create a program item using Program Manager

1. Open the group to which you want to add the item.

2. From the File menu, choose New to display the New Program Object dialog
box. Then select the Program Item option and choose the OK button. Or press
and hold down ALT while double-clicking in a blank area of the group
window.

Description:

Command Line:

Working Directory:

Shortcut Key: |None !

(| Bun Minimized

. In the Description box, type a description that identifies the application.

This optional description becomes the label that appears under the icon in the
group window. If you leave this box blank, Program Manager labels the icon
for you. However, a description of your own can be very useful, especially if
you set up multiple program items for the same application.
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4. In the Command Line box, type the name of the program file, including its

path and extension.

For example, to add Microsoft Excel, located in a directory named CN\EXCEL,
you would type:

c:\excel\excel.exe

If you don’t know the name of the program file, choose the Browse button to
display a list of files and directories. Select the appropriate filename from the
list. You can use the directory listing to change to a different directory, if
necessary. Choosing the OK button places the selected filename in the
Command Line box.

If you want the application to open a document when it starts, after the
program name type a space and then the document’s filename. Include the
path required to locate the document. Be sure to separate the program name
from the document name with a space.

For example, to specify a spreadsheet named 92BUDGET.XLS, located in the
CN\ADMIN\FY92 directory, as the document to be opened when you start
Microsoft Excel, you would type:

c:\excel\excel.exe c¢:\admin\fy92\92budget.xls

If the document is in the same directory as the application, you can omit the
path. For example, to specify a spreadsheet named EXPENSE.XLS, located in
the C\EXCEL directory, you would type:

c:\excel\excel.exe expense.xls.

. Choose the OK button.

The dialog box closes and the new program item appears in the group.

You can also specify a working directory, a shortcut key, and whether the
application starts as an icon in the Program Item Properties dialog box.

To specify a working directory

In the Working Directory box, type the name of the directory.

When you start the application, the directory you specify as the working
directory will become the current directory. It will be the default directory in
the application’s Open and Save As dialog boxes when you open and save
files.

To specify an application shortcut key

Type the key combination in the Shortcut Key box.
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A shortcut key allows you to switch quickly to the application when it is running.
Valid shortcut-key sequences are CTRL+ALT+character, CTRL+SHIFT+character,
SHIFT+ALT+character, and CTRL+SHIFT+ALT+character. Character can be any
letter, number, or special character. When you type a character in the Shortcut
Key box, Program Manager adds CTRL+ALT in front of it. To specify a different
control-key sequence, you must type the sequence.

You can reserve shortcut keys for an MS-DOS application by using Program
Manager or PIF Editor. Shortcut-key settings made in Program Manager override
settings made in PIF Editor.

To run an application as an icon when it starts
e Select the Run Minimized check box.

When this box is selected, the application is reduced to an icon when it starts.
When you want applications you have added to the Startup group to run
minimized when you start Windows NT, use this option.

Once you have created a program item, you can change its properties.

To change a program item
1. Select the program item and choose Properties from the File menu.

2. Change any of the options in the Program Item Properties dialog box and
choose the OK button.

Creating a Program Item Using File Manager

You can also use File Manager to create program-item icons in Program Manager
groups. You can move applications and associated documents from File Manager
directories to Program Manager group windows or group icons.

To create a program item in a common program group, you must be logged on as
a member of the Administrators or Power Users group.

The following steps require a mouse and have no keyboard equivalent.

» To create a program item using File Manager

1. Arrange your desktop so that you can see both File Manager and the group
where you want to place the new program item.

The destination group can be either a window or an icon.
2. Open the File Manager window, and if necessary position and resize it.

If no other application windows are open, you can use the Tile button in the
Task List to arrange the File Manager and Program Manager windows.
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3. Locate and select the program or document file in File Manager that you want
to add. You can select multiple items and add them all to a group at the same
time.

4. Drag the file from File Manager to Program Manager, and place it in the group
window or on the group icon.

As you drag the file, the mouse pointer turns into a replica of a file icon. If you
have more than one file or document selected, you see a multiple-file icon.

Once you have created the program item, you can customize its properties by
selecting the icon and choosing Properties from the File menu. For more
information on program-item properties, see “Creating or Changing a Program
Item Using Program Manager” earlier in this chapter.

Deleting Groups and Program Items

Security

When you no longer need a group or program item, you can delete it. When you
delete a group, Program Manager deletes the program items it contains. Deleting
program items has no effect on the corresponding application and document files.
They are not removed from your hard disk.

To delete a common program group or program items in a common group, you
must be logged on as a member of the Administrators or Power Users group.

To delete a group

1. If the group contains program items, reduce it to an icon. If the group window
is empty, you can delete it without reducing it to an icon.

2. Select the group icon or empty group window.
3. From the File menu, choose Delete. Or press DEL.

4. A dialog box prompts you to confirm the deletion. Choose the Yes button to
remove the group.

To delete a program item from a group

1. Open the group window that contains the item you want to delete.
2. Select the program-item icon.

3. From the File menu, choose Delete. Or press DEL.

4

. A dialog box prompts you to confirm the deletion. Choose the Yes button to
remove the program item.

Changing the Description of a Group

You can change the description of any group. The description is the label for the
group icon and appears in the title bar of the group window.
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>

To change the description of a common group, you must be logged on as a
member of the Administrators or Power Users group.

To change the description of a group

1. Make sure the group whose description you want to change is reduced to an
icon.

2. Select the group icon.

3. From the File menu, choose Properties. Or press and hold down ALT while
double-clicking the program-group icon.

4. In the Program Group Properties dialog box, type a new description, and then
choose the OK button.

Copying a Program Iltem to Another Group

Security

The easiest way to copy a program item from one group to another is to use the
mouse to drag the program-item icon onto the other group icon or into the other
group window. If you don’t have a mouse, you can use the Copy command on the
File menu.

You can always copy a program item from a common group to one of your
personal groups. However, you must be logged on as a member of the
Administrators or Power Users group to copy a program item from a personal
group to a common group.

To copy a program item to another group

1. If you’re not concerned with where the new program-item icon is placed in the
group window, open the group window containing the program-item icon you
want to copy and leave the destination group reduced to an icon.

If you want to place the new program-item icon in a particular location in a
group window, open the group windows for both the source and the
destination.

2. Press and hold down CTRL while you drag the program-item icon from its
current location to the destination group’s icon or window.
The mouse pointer becomes a replica of the program-item icon you are
copying.

3. When the copied icon is on top of the destination group’s icon or inside the
destination group’s window, release the mouse button and the CTRL key.

You can create a duplicate program item within a group. Press CTRL while
dragging the icon to another place in the window.
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» To copy a program item to another group using the Copy command

1

. Open the group window that contains the program item you want to copy.
2. Select the program-item icon.
3.
4

. In the To Group box, select the name of the group you want to copy the

From the File menu, choose Copy.

program item to.
Choose the OK button.

Moving a Program ltem to Another Group

Moving a program item is easiest if you have a mouse. You can simply drag the
program-item icon onto the other group icon or into a group window. If you don’t
have a mouse, you can use the Move command on the File menu.

Security

To move a program item from a common group, you must be logged on as a
member of the Administrators or Power Users group.

To move a program item to another group

1.
2.

Open the group window that contains the program item you want to move.
Drag the program-item icon to the destination group’s icon or window.

The mouse pointer becomes a replica of the program-item icon you are
moving.

. When the program-item icon is on top of the destination group’s icon or inside

the destination group’s window, release the mouse button.

To move a program item to another group using the Move command

1.

Open the group window that contains the program item you want to move.

2. Select the program-item icon.
3.
4

. In the To Group box, select the name of the group you want to move the

From the File menu, choose Move.

program item to.
Choose the OK button.

Changing an Icon

When you add a program item to a group, Program Manager selects an icon for
that item. You can change the icon displayed in the group window.

Security

To change an icon in a common group, you must be logged on as a member of the
Administrators or Power Users group.
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» To change an icon
1. Select the program item whose icon you want to change.
2. From the File menu, choose Properties.

3. In the Program Item Properties dialog box, choose the Change Icon button.

File Name:

| c:\winnt\system\moricons.dll

Current Icon:

4. Use one of the following methods to select a new icon:

= If more than one icon is available, select a different icon in Current Icon
box.

= If no additional icons are available, Windows NT displays the icons
available with PROGMAN.EXE. Select an icon in the Current Icon box.

= In the File Name box, type the path to either PROGMAN.EXE or
MORICONS.DLL, for example c:\winnt\system32\moricons.dll, and
choose the OK button. Then select an icon in the Current Icon box.

5. Choose the OK button.

Starting an Application from a Group

If an application is represented by a program-item icon in a group, the easiest way
to start the application is to choose the program-item icon from the group
window. If you included a document with the program item, it appears in the
application workspace. For more information, see “Creating or Changing a
Program Item Using Program Manager” earlier in this chapter.

» To start an application from a group

1. Open the group window that contains the program-item icon for the
application.

2. Double-click the icon.

When you start an application, Program Manager changes the current directory to
the directory you specified in the Working Directory box when you added the
program item to the group. If you are using an MS-DOS application, you can
specify a working directory in either Program Manager or PIF Editor. Settings
made in Program Manager override PIF Editor settings.
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Use the following steps to run an application as an icon when you start the
application.

» To run an application as an icon
1. Open the group window that contains the program-item for the application.
2. Press and hold down SHIFT while double-clicking the icon.

You can have Windows reduce Program Manager to an icon whenever you start
an application. This is useful because the icon remains visible on the lower edge
of the desktop when most applications are running, making it easy to find when
you want to switch to Program Manager.

» To reduce Program Manager to an icon whenever you run an application
e From the Options menu, choose Minimize On Use.

A check mark appears beside the command when it is in effect. To cancel the
command, choose it again.

Starting an Application When You Start Windows NT

When you install Windows NT using the Setup program, Windows NT creates a
Startup group. When you add a program item for an application to the Startup
group, the application starts each time you log on to Windows NT.

For example, if you want to start File Manager whenever you log on to Windows
NT, move the File Manager icon from the Main group to the Startup group.
Program items in the Startup group start in the order their icons appear in the
window starting with the top row, and moving left to right.

You can also have Windows NT automatically reduce an application to an icon
when it starts. To do this, select the Run Minimized box in the Program Item
Properties dialog box for the application’s program item.

Returning to Program Manager from an Application

When you are working with an application or document and you want to start a
different application, you can do so by returning to Program Manager.

» To return to Program Manager from an application

e Click the Program Manager window or double-click the Program Manager
icon. Or press ALT+TAB repeatedly until the message box shows the Program
Manager title and icon. Or press ALT+ESC repeatedly to move through open
application windows and application icons until you reach Program Manager.
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File Manager

Overview

File Manager allows you to organize and work with directories and files.

This chapter explains how to use File Manager and includes the following topics:

Using directory windows to display directories and files
Navigating drives and directories

Working with directories and files

Sharing directories and files

Securing directories and files

Maintaining disks

File Manager displays the organization of the directories and files on your disk
drives and on network disk drives. Use File Manager to create and remove
directories; move, copy, and delete files; connect to directories shared on the
network; share directories; secure files and directories; and perform other disk,
directory, and file management tasks.

When you first start File Manager, the File Manager window appears. It contains
a menu bar, toolbar, drivebar, status bar, and a directory window that shows the
contents of the current drive.
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I- Directory window l Status bar

Toolbar

Provides quick access to commands through buttons and allows you to change
drives by selecting from a list.

Drivebar
Allows you to change drives by selecting one of the drive icons. Different

icons represent the floppy and hard drives on your computer, network drives to
which you’ve connected, and CD-ROM drives.

Status bar
Shows you how much free space remains and total space exists on the current

drive. It also shows you how many files are in the current directory and how
much space they take up.

The toolbar, drivebar, and status bar are displayed by default. You can remove
them from the screen by choosing the Toolbar, Drivebar, and Status Bar
commands from the Options menu.

Starting and Quitting File Manager

By default, when you start File Manager, its window appears as it was when you
last quit File Manager. Settings you make using the Options menu are always
saved when you quit. The positions of directory windows and icons and the
settings on the View menu are saved as long as the Save Settings on Exit
command is in effect when you quit.
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» To start File Manager

e Choose the File Manager icon in the Main Group. Or select the File Manager

icon and press ENTER.

» To quit File Manager

e Choose the Control-menu box. Or, from the File menu, choose Exit.

Customizing the Toolbar

You can add, remove, and rearrange the buttons on the toolbar. Every command
available on File Manager menus has an equivalent button.

» To add a button to the toolbar

1

. From the Options menu, choose Customize Toolbar. Or double-click the
background of the toolbar.

Axailable Buttons: Toolbar Buttons:

1 File - Copy...

Separator

ile - Rename. .. File - Move. ..

[X]Fite - Delete...

Separator

- Properties...
ile - Print...
- Create Directory...

ile - Search._.

2. In the Available Buttons box, select the button that you want to add. Select

Separator to add a space between buttons.

3. Choose the Add button.

» To move a toolbar button

Press and hold down SHIFT while dragging the button to a new location on the
toolbar.

—Or—

. From the Options menu, choose Customize Toolbar. Or double-click the
background of the toolbar.

2. In the Toolbar Buttons box, select the button or Separator you want to move.

To move the selection to the left on the toolbar, choose the Move Up button.

To move the selection to the right on the toolbar, choose the Move Down
button.
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3. Choose the Close button.

» To remove a toolbar button
= Press and hold down SHIFT while dragging the button off the toolbar.
—Or—

1. From the Options menu, choose Customize Toolbar. Or double-click the
background of the toolbar.

2. In the Toolbar Buttons box, select the button or Separator you want to remove,
and then choose the Remove button.

3. Choose the Close button.

» To restore the default toolbar buttons

1. From the Options menu, choose Customize Toolbar. Or double-click the
background of the toolbar.

2. Choose the Reset button.
3. Choose the Close button.

Working with Directory Windows

Each directory window is divided into two panes: the left pane displays the
directory tree, and the right pane lists the contents of the current directory. The
directory tree shows the structure of the directories on a disk. The directory
structure begins at the upper left with the root directory, the first directory on a
disk. The root directory is created when you format a disk. It is represented by a
backslash (\). For example, C:\ is the root directory for drive C. Other directories
branch below the root directory. The contents list in the right pane of the directory
window shows the names of files and directories within the current directory.
Directories within a directory are known as subdirectories. The panes are
separated by a split bar that allows you to adjust their widths.
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The following table describes the elements in a directory window.

Element

Description

Directory path

Volume label

Network name
File system name

Directory icons

Current directory

File icons

Up icon

The name and location of the current directory is displayed in the
title bar of the directory window.

The name that identifies your disk is displayed in brackets ([ ]) to the
right of the directory path. This information appears only if you have
assigned a label to your disk.

If you have selected a shared directory, its name is displayed instead
of the volume label.

The name of the file system used on the selected drive is displayed
next to the root directory.

Icons representing directories and shared directories appear in both
panes. In the directory tree, directory icons are connected by a
vertical line to the directory level above them. In the contents list,
directory icons represent directories in the current directory.

The directory you are currently using is represented by an icon that
looks like an open directory folder in the directory tree. File Manager
commands affect the current directory or files within it.

Icons next to filenames indicate file type. There are icons to
represent program files, document files, and other types of files. For
more information, see “Working with Files and Directories” later in
this chapter.

Double-clicking the arrow at the top of the contents pane takes you
up one level in the directory tree.
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Opening and Closing Directory Windows

You can open additional directory windows that display the contents of the same
drive or a different drive. Opening multiple directory windows makes it easy to
move and copy files.

If you have two or more windows displaying the same drive and directory
information, a number appears in the title bar of each window, indicating that
there is more than one window displaying that directory.

A new directory window inherits its display options from the previous one. For
example, if you are working with a directory window that shows only the
directory tree, and you open a new directory window, the new window displays
only the directory tree.

To open a new directory window

To open a window Do this
That displays information for the Double-click the drive icon. Or press TAB to
selected drive select the drivebar and use the arrow keys to

select a drive icon. Then choose Open from the
File menu, or press ENTER.

That displays the same information as ~ From the Window menu, choose New Window.

the previous active window Or from the toolbar, click the New Window
button.

That displays only the contents pane In the directory tree, press and hold down SHIFT

for the selected directory while double-clicking the directory icon. Or in

the directory tree, select the directory icon, and
then press SHIFT+ENTER.

When you finish working with a directory window, you can close it to clear space
on your screen. If you have only one directory window open, you cannot close it.

To close the active directory window

e Double-click the Control-menu box, located in the upper-left corner of the
directory window. Or, from the Control menu, choose Close.

File Manager updates open directory windows automatically. For example, when
you save a new file from an application, File Manager displays the new file name
immediately. Sometimes File Manager cannot complete an update when, for
example, you are using network directories or you have changed floppy disks.
You can update the active directory window manually when this occurs.

» To update a directory window

o Click the drive icon for the current drive, or choose Refresh from the Window
menu.
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Selecting and Arranging Directory Windows and Icons

Before you can work with the files and directories in a directory window, you
must select the window. Selecting the window makes it active: the title bar
changes color or intensity and the window moves in front of any other open
windows.

» To select an open directory window

e Click anywhere in the window. Or choose a window name from the list at the
bottom of the Window menu. Or press CTRL+F6 or CTRL+TAB until the window
you want is selected.

If the window you want to select is hidden by another window, you can use the
Cascade or Tile commands on the Window menu to rearrange the open directory
windows so that all of them are visible.

» To arrange open directory windows

To Do this from the Window menu

Overlap windows so that each window’s Choose Cascade
title remains visible

Resize and arrange windows without Choose Tile Horizontally
overlap so that each window is wider than it
is long

Resize and arrange windows without Choose Tile Vertically
overlap so that each window is longer than
it is wide

When you minimize a directory window, it becomes an icon. You can move icons
individually by dragging them with a mouse, or File Manager can arrange them
evenly all at once. For information about changing the spacing between icons
arranged by File Manager, see “Changing the Desktop” in Chapter 5, “Control
Panel.”

» To arrange icons

e From the Window menu, choose Arrange Icons.
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Displaying the Directory Tree or Contents

When you first start File Manager, the directory window displays both the
directory tree for the current drive and the contents of the current directory. By
using commands on the View menu, you can choose to display only the directory
tree or only the contents of the current directory. When both panes of a directory
window are displayed, they are separated by a split bar that you can move to
change the widths of the panes.

» To display the directory tree or directory contents

To display Do this from the View menu

Only the directory tree for the current drive ~ Choose Tree Only

Only the contents of the current directory Choose Directory Only
The tree and contents for the current Choose Tree And Directory
directory

» To move the split bar

1.

Point to the split bar.

The pointer turns into a double bar with two arrows.
Drag the bar to a new position.

—Or—

1. From the View menu, choose Split to display a vertical bar.

Use the arrow keys to move the selection bar to where you want to place the
split bar, and then press ENTER.

If you decide you do not want to move the split bar, press ESC to cancel the
command.

Changing the Font in File Manager

You can change the font that File Manager uses to display the names of files and
directories. When you change the font, it changes in all directory windows.

» To change the font

1.
2.

From the Options menu, choose Font.
In the Font box, select the font you want to use.

When you select a font, a style, or a size, the text in the Sample box changes to
reflect your choice.

. In the Font Style box, select a style option (for example, bold or italic).

4. In the Size box, select a point size: the larger the point size, the larger the

character appears on your screen.
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5. By default, file and directory names appear in lowercase letters on FAT drives.
On drives formatted to use the Windows NT files system (NTFS), names
appear as they were typed in uppercase and lowercase.

To display names on FAT drives in uppercase, clear the Display Lowercase
For FAT Drives check box.

To display names on all drives in lowercase, select the Display Lowercase For
All Drives check box.

6. Choose the OK button.

Navigating Drives and Directories

You can use File Manager to change to different local and network drives and to
navigate through the directory structure.

Changing Disk Drives

A directory window shows the directory structure of the current drive. On the
drive bar, the icon for the current drive is surrounded by a rectangle. On the
toolbar, the current drive is shown in the list box.

When you change to a different drive, the names of the files and directories on
that drive are displayed in the directory window. When File Manager searches the
drive to display its contents, you can press ESC to stop the search. If you stop the
search, only a partial directory tree is displayed, as indicated by the status bar at
the bottom of the File Manager window.

» To select another drive in a directory window

o Click the drive bar icon representing the drive you want to use.

B C: [FAT_VOL]
A

Or press and hold down CTRL while typing the letter of the drive you want to
select.

—Or—

1. Press TAB or F6 to move to the drive bar.
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To move back to the directory tree or contents area without changing drives,

press TAB or F6 again.

2. Use the arrow keys to select the drive icon you want, and then press the

SPACEBAR.

» To change drives by using the Select Drive command

1. From the Disk menu, choose Select Drive. Or double-click the background of
the drive bar to display the Select Drive dialog box.

2. Select the drive you want to change to.

3. Choose the OK button.

Changing Directories

You can change directories using either the directory or the contents list.

In the directory tree, the current directory is marked by the selection cursor, a
dotted rectangle around the highlighted icon and text. You can select only one
directory at a time in the directory tree. To change to a different directory, move

the selection cursor.

In the contents list, you can move up or down one level in the directory structure.
You can go up one level by choosing the Up icon, and you can change to a
subdirectory by choosing its icon in the list.

» To change to another directory in the directory tree

¢ Click the directory name you want to change to. Or use the following keys to
change to a different directory.

Press

To change to

UP ARROW Or DOWN ARROW
HOME or BACKSLASH (\)
END

RIGHT ARROW

LEFT ARROW or BACKSPACE
PAGE UP
PAGE DOWN

CTRL+UP ARROW
CTRL+DOWN ARROW
A character key

A directory above or below the current directory.
The root directory.
The last directory in the list.

The first subdirectory of the current directory, if one is
displayed in the directory tree.

The next directory level up from the current directory.
The directory one screen up from the current directory.

The directory one screen down from the current
directory.

The previous directory at the same level.
The next directory at the same level.

The next directory whose name begins with that letter
or number.
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» To change directories by using the contents list

To Do this Icon

Move down a level Choose the directory icon next to the &
subdirectory’s name.

Move up a level Choose the Up icon, or press the ..
BACKSPACE key.

Expanding and Collapsing the Directory Tree

When you first start File Manager, only the first level of directories are displayed
in the directory tree.

When you expand a directory, the directory tree displays the names of the
subdirectories in that directory. Like the structure of a tree, subdirectories branch
from directories. You can expand an entire directory branch, a single level of the
branch, or all branches in the tree. You can also collapse a directory so that its
branch of subdirectories is not listed in the directory tree.

» To expand or collapse a directory

To Do this in the directory tree
Expand one level of Choose the icon or name of the directory you want to
a directory expand, or select the directory, and then choose Expand

One Level from the Tree menu.

Expand an entire branch Select the directory, and then choose Expand Branch from
the Tree menu.

Expand all branches in the From the Tree menu, choose Expand All.
directory tree

Collapse a directory Choose the icon or name of the directory you want to
collapse, or select the directory, and then choose Collapse
Branch from the Tree menu.
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Showing Which Directories Expand

If you want to know which directories have subdirectories, you can use the
Indicate Expandable Branches command on the Tree menu. When you use this
command, a plus sign (+) marks each directory that has subdirectories. The plus
sign means you can expand the directory to display its subdirectories in the
directory tree. After you expand a directory, the plus sign changes to a minus sign
(-), indicating that the directory is expanded and can be collapsed. If you choose
the Indicate Expandable Branches command, File Manager may take longer to
create the directory tree.

Expandable directory

&

(3] &pplications EaDates [E Moan Logo.bmp
- C1 Letters CaProposal D Staffing. lst
CaRequirements

- €3 Planning
. . Feb Research Notes.doc
[ Final st
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5. Proposal
CO\Requirements
- G Projegt Road
=T

\ Collapsible directory

» To mark expandable directories in the directory tree
e From the Tree menu, choose Indicate Expandable Branches.
A check mark appears next to the command in the Tree menu.

To turn off this feature, choose Indicate Expandable Branches again.

Connecting to and Disconnecting from a Network Drive

You can use File Manager to connect to and disconnect from network drives.
When you connect to a network drive, you can specify whether or not to
reconnect to the drive each time you log on to Windows NT.

When you connect to a network drive, File Manager opens a new window in
which to display the directory information. You can switch this feature off from
the Options menu by choosing the Open New Window On Connect command.

Computers in your computer’s domain or workgroup are displayed automatically
in the Shared Directories box. You can switch this off by clearing the Show
Computers In Domain/Workgroup By Default check box.
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Security  If you are logged on as a member of the Administrators or Backup Operators
groups, or you have been granted permission, you can connect to a computer’s
root shares, for example \SALESERVER\CS.

» To connect to a network drive

1. Choose Connect Network Drive from the Disk menu, or choose the Connect
= Drive button on the toolbar.

Drive: 1 E:
Path: ! |

Connect As: | |

[ Reconnect at Logon
Shared Directories: [ Show Computers in Workgroup By Default

= Microsoft Windows Network
£ PROJECTS
2B ACCOUNTS
"EVSETTER
“EEAJREDALE
B INVOICE
FE\INVOICEACURRENT Current Invoices
ENINVDICESPUBLIC Public Files
EIWINVOICEVBACKLP Backup Files
‘E\RECEIPTS
£ SHIPPING

2. File Manager displays the first free drive letter in the drive box. You can
accept the displayed drive letter for the connection, or choose another.

3. Select or type a network path in the Path box. A network path consists of a
computer name followed by the name of a shared directory, for example,
\SHIPPING\PUBLIC.

= If you have connected to the directory before, select the path from the list
displayed in the Path box. The Path box displays the previous 10 paths.

= You can use the Shared Directories box to select a network path. In
Microsoft Windows-based networking you can browse domains,
workgroups, and computers to look for shared directories. Other networks
may contain different options.

The networks, domains and workgroups, computers, and shared directories
are organized in a tree structure. Choose an item to expand the list: Choose
a network name to display available domains and workgroups, a domain or
workgroup name to display available computers, a computer name to
display its shared directories. When you select a shared directory, File
Manager fills in the Path box with the name you selected.
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6.

= If you know the name of a computer, but need to see the names of its
shared directories, you can type the computer name in the Path box and
choose the OK button. Preface the computer name with two backslashes
(). Windows NT adds the name of the computer’s first shared directory to
the Path box and displays all of the computer’s shared directories in the
Shared Directories box. To connect to different directory, select it in the
Shared Directories box.

= You can type the name of a computer and shared directory in the Path box.
Preface the computer name with two backslashes (\\) and separate the
computer name from the shared directory’s name with a single backslash
(\), for example \SHIPPING\SALESQI.

In the Connect As box, type a valid username. You do not need to use the
same name you used to log on to Windows NT. For example, you may want to
connect to a shared directory using a name that allows greater access to files in
the directory.

If you do not want to connect to the shared directory each time you log on,
clear the Reconnect At Logon box.

Choose the OK button.

» To disconnect from a network drive

1.

2.

Choose Disconnect Network Drive from the Disk menu, or choose the
Disconnect Drive button on the toolbar.

WWSETTERVSCRATCH
“WPOODLEAPUBLIC
WHUSKYASTEVEW
SDALMATIONSUTILITY

B B H B

In the Disconnect Network Drive dialog box, select one or more network
drives and choose the OK button.

Working with Directory Information

You can control how File Manager displays directory information by using
commands on the View menu.

The changes you make by using commands on the View menu affect the active
directory window and any new windows you open from that window. Other open
windows are not affected.
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In the contents list, File Manager displays icons next to names so that you can
quickly identify directories and files. The following table describes the icons.

Icon Represents

O Directories. These are listed first, in alphabetical order.

few| Shared directories. These are directories you can connect to on the network,
or you are sharing on your computer.

=l Program files and batch files. Their default filename extensions are .EXE,

.CMD, .COM, .PIF, and .BAT. These files start applications.

Document files. These files are associated with applications. When you open
one of these files, the associated application starts automatically. For more
information, see “Associating Files with an Application” later in this chapter.

M System or hidden files. These files have system or hidden attributes. For more
information, see “Setting File Attributes” later in this chapter.

| All other files.

Displaying Information on Files

When you first start File Manager, only the names of directories and files are
shown. In addition to names, you can also display size, last modification date and
time, and attributes of files in the contents list. On drives formatted to use the
Windows NT file system (NTFS), you can display the MS-DOS-style names that
Windows NT creates to accompany long filenames.

» To display only names of files and directories

e From the View menu, choose Name, or choose the Name button on the
toolbar.

» To display complete information about each file

o From the View menu, choose All File Details, or choose the All File Details
button on the toolbar.

The file size, last modification date and time, and file attributes are displayed next
to each filename and directory name in the active directory window. If the
directory is on a drive formatted to use the Windows NT file system (NTFS), the
short, MS-DOS filename is shown as well as the long filename.
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» To display selected information about each file

1. From the View menu, choose Partial Details.

[ Last Modification Date
[] Last Modification Time
[ File Attributes

[ MS-DOS file names for NTFS||  Help

2. Select the check boxes of options you want to display, and clear the check
boxes of options you don’t want to display.

The table that follows describes each option.

3. Choose the OK button.

You can select the following options in the Partial Details dialog box.

Select

To

Size
Last Modification Date

Last Modification Time

File Attributes

MS-DOS filenames for
NTFS

Display the size in bytes of each file.

Display the date each file was last modified, according to
the system clock.

Display the time of day each file was last modified,
according to the system clock.

Indicate whether files are hidden, system, archive, or
read-only. For more information, see “Setting File
Attributes” later in this chapter.

Display short, MS-DOS-style names for long filenames on
drives formatted to use NTFS.

Sorting the Contents of a Directory

When you first start File Manager, it lists directory contents alphabetically, with
directories first, followed by filenames. You can sort the files and directories by
name, type, size, or the date the file was last modified. Sorting files and
directories affects the contents list only.
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» To sort the contents of a directory

Use this Use this
To sort contents by command toolbar button
Alphabet: Directories are sorted first, then Sort By Name

files.

Type: Directories and then files are sorted Sort By Type
alphabetically by filename extension.

Size: The largest file is listed first. Sort By Size

Date: Directories and then files are sorted Sort By Date tel
with the most recent first.

Limiting the Files to Display

When you first start File Manager, the contents list displays the names of all the
files and directories in the current directory, except hidden and system files. (For
information about hidden and system files, see “Setting File Attributes” later in
this chapter.) You can specify whether File Manager displays only certain types of
files, or groups of files with similar filenames or extensions.

» To specify which types of files are displayed in a directory window

1. From the View menu, choose By File Type.

2. In the By File Type dialog box, use the Name box to limit the display to a
single filename. Use wildcards to limit the display to files with similar names.

A wildcard substitutes for one or more characters. Use an asterisk (*) to
represent a group of characters. Use a question mark (?) to represent a single
character. The Name box default, *.*, means all files in the directory are listed.
For example, to display only those files with the extension .TXT, you can type

* txt.

3. Under File Type, select the types of files you want to display.

Select

To

Directories

Programs

Documents

Other Files

Display the names of directories that are in the current directory.

Display all filenames that have an .EXE, .COM, .PIF, .CMD, or
.BAT extension.

Display the names of text or graphics files associated with an
application. For information about associating files, see
“Associating Files with an Application” later in this chapter.

Display all filenames not included in the preceding three options.

4. To display hidden and system files, select the Show Hidden/System Files

check box.

5. Choose the OK button.
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Caution If you choose to display hidden and system files, be careful not to
rename or delete them. Your computer may not start or work properly without
them.

Working with Files and Directories

Once you select a file or directory, you can use File Manager to copy, move,
delete, or rename it. You can also use File Manager to create a new directory. You
can start applications from File Manager, and, once a type of file is associated
with an application, open a file and start its application at the same time. Use File
Manager to set the attributes for files.

Naming a File or Directory

An operating system’s file system determines the conventions that apply to file
and directory names. When you use Windows NT on drives formatted to use the
Windows NT file system (NTFS), you can use long file and directory names.
When you create a directory or rename a file and use a long filename, File
Manager automatically creates a shorter, MS-DOS-style name. This allows
applications that do not support long file names to use the file.

NTES uses the following naming conventions:

= Names can be up to 256 characters long, including the extension. Separate the
extension from the name using a period.

= Names preserve case, but are not case sensitive. When you name a file, your
use of uppercase and lowercase letters will be retained. However, Windows
NT does not distinguish filenames by their case. For example, Windows NT
considers the filenames August Sales and AUGUST SALES to be identical.

= Names can contain any uppercase or lowercase characters except the
following:

2" /N < > *

When Windows NT creates a long name, it automatically creates a short,
MS-DOS-style name as well. This keeps Windows NT compatible with MS-DOS
workstations and applications. For example, a workstation running MS-DOS will
use short names to see the shared directories and files on a Windows NT
computer. Applications that do not support long file names will be able to work
with files by using the short name. However, if you save a file using an
application that does not support long filenames, the long filename will be lost
and the file will have only a short name.
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When you create a long name, Windows NT uses the following rules to create the
short name:
= Spaces are removed.

= Periods are removed except for the last period in the filename that is followed
by a character. Windows NT interprets this period as marking the start of the
filename’s extension.

= Characters not allowed in MS-DOS-style names are changed to underscores

-

= The name, not including its extension, is truncated to 6 characters and a
hyphen (-) and a number are appended.

=  The name’s extension is truncated to 3 characters.

If you are using Windows NT in an environment where long file names are not
always supported, you may want to continue using MS-DOS conventions for the
first 6 characters of names and use periods only to separate the name from the
extension. For example, you could name a file AUGSLS-August 1992 Sales
Report. XLS. Then the short name would be AUGSLS-1.XLS.

MS-DOS conventions for naming files are:
= The name of a file or directory can have two parts: a name and an optional
extension. The two parts are separated by a period.

= The name can contain up to eight characters, and the extension can contain up
to three characters.

= The name must start with either a letter or number. It can contain any
uppercase or lowercase characters except the following:

S N S A
If you use these characters in a filename, you may get unexpected results.
= The name cannot contain any spaces.

= The following names are reserved and cannot be used for files or directories:

AUX COM4 LPT3
COM1 CON NUL
COM2 LPT1 PRN

CcoM3 LPT2
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Selecting Files or Directories

Before you can work with a file or a directory, you must select it. When a file or
directory is selected, its name and icon are highlighted in the directory window. In
the contents list, you can select more than one file or directory at a time in order
to perform a task with several files at once. For example, you may want to select
several files and move them to another directory. You can select a group of files
or directories that appear in consecutive order, or you can select items that are not

in sequence.

» To select files or directories

To select

Do this

A single file or
directory

Two or more
items in sequence

Two or more
items out of
sequence

More than one
group of items

All files in a
directory

In the contents list, click the name of the file or directory you want to
select.

Press TAB to move the selection cursor to the contents list. Then use
the UP ARROW or DOWN ARROW keys to select the file or directory.

Click the first file or directory you want to select. Then press and
hold down SHIFT while you click the last item in the group.

Press TAB to move to the contents list, and then use the arrow keys to
select the first item. Then press and hold down SHIFT while selecting
the remaining items using the arrow keys.

Press and hold down CTRL while you click each item.

_Or—

Press TAB to move to the contents list, then use the arrow keys to
select the first item. Press and release SHIFT+F8, then use the arrow
keys to move to each item and press the SPACEBAR to select it. When
you finish selecting items, press SHIFT+F8 again.

Use any method to select the first sequential group of items. Hold
down CTRL while you click the first item in the next group, and press
and hold down CTRL+SHIFT while you click the last item in the group.
—Or—

Use the keyboard method with SHIFT+FS to select the first group, then
use the arrow keys to move to the first item in the next group and
repeat the process, pressing SHIFT+F8 again when all items are
selected.

Press CTRL+SLASH (/).
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When you are selecting files and directories using the keyboard, you can use the

following keys.

Press To select

UP ARROW Or DOWN ARROW A file or directory above or below the current
selection.

END The last file or directory in the list.

HOME The first file or directory in the list.

PAGE UP The file or directory at the top of the previous
screen.

PAGE DOWN The file or directory at the bottom of the next
screen.

A letter or number The next file or directory that begins with that letter
or number.

To select a group of items by using the Select Files command

1.
2.

5.

From the File menu, choose Select Files.
In the Files box, type the name of the file you want to select.

Use wildcards to specify a group of files. For example, to select all files with a
.TXT extension, type *.txt. Or, to select all files in a directory, leave the
default *.* in the Files box.

. Choose the Select button.

The Cancel button changes to the Close button.
Repeat steps 2 and 3 until you have selected all the files you want.

You can choose the Deselect button at any time to cancel a selection. The
Deselect button cancels the selected files that you specify in the Files box.

Choose the Close button.

To cancel a selection of files or directories

To cancel Do this
A single selection Press and hold down CTRL while you click the item.
—Or—

Press and release SHIFT+F8, use the arrow keys to move to the
selection you want to cancel and press the SPACEBAR. Then
press SHIFT+F8 again.

All selections Press CTRL+BACKSLASH (\).
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» To cancel a group of selected files by using the Select Files command

1. From the File menu, choose Select Files.

2. In the Files box in the Select Files dialog box, type the name of one of the
selected files you want to cancel.

You can use wildcards to specify a group of files or all files that are selected in
a directory.

3. Choose the Deselect button.
4. Repeat steps 2 and 3 until you finish canceling selections.
5. Choose the Close button.

Creating a Directory

You can create a directory by using the Create Directory command. After you
create a directory, you can copy files and directories to it from other locations by
using the Move and Copy commands. For more information, see “Moving and
Copying Files and Directories” later in this chapter.

» To create a directory

1. In the directory tree, select the directory in which you want the new directory
to appear.

2. From the File menu, choose Create Directory.
3. In the Name box, type a name for the new directory.

Use the same conventions for naming directories as you do for naming files.
For information, see “Naming a File or Directory” earlier in this chapter.

If you decide to create the directory somewhere other than in the current
directory, you can type the full path of the new directory.

4. Choose the OK button.

Moving and Copying Files and Directories

Security

You can move and copy files and directories from one location to another by
dragging them with the mouse or by using the Copy or Move commands. You can
copy and move items between directories and between drives. When you move or
copy a directory, all the files and subdirectories in it are moved or copied.

On drives formatted to use the Windows NT file system (NTFS), you must have
permission to move or copy a file or directory. For more information on file and
directory permissions, see “Securing Directories and Files” later in this chapter.
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Important When you copy files or directories, security permissions set on them
are discarded as is ownership and auditing information. They will inherit a new
set of permissions from the directory into which they have been copied or moved.
In the case of files, if the new directory does not specify permissions for files,
only the file’s owner (the person who copied or moved the file) will have
permission to use the file. When you copy or move a directory to a disk formatted
to use the FAT file system, permissions are discarded and not replaced.

To move or copy files or directories by dragging

1. Make sure the source and destination locations are visible. You can use the
Cascade or Tile command on the Window menu to rearrange directory
windows. The destination can be a directory icon, directory window, or drive
icon. If the destination is a drive icon, the file will be placed in the current
directory of that drive.

2. Select the file or directory you want to move or copy. You can select more
than one file or directory.

When you drag a selection, Windows NT assumes you want to copy it when
the destination is on a different drive and move it when the destination is on
the same drive.

To Do this

Move to a location on the same drive Drag the selection.

Move to a location on any drive Press and hold down SHIFT while dragging
the selection.

Copy to a location on a different drive Drag the selection.

Copy to a location on any drive Press and hold down CTRL while dragging

the selection.

3. Release the mouse button. If you are dragging while pressing SHIFT or CTRL,
release the mouse button before releasing the key.

4. To complete moving or copying, choose the Yes button in the confirmation
message.

You can choose not to receive confirmation messages. For more information,
see “Turning Off Confirmation Messages” later in this chapter.

If the destination directory contains a file with the same name, a dialog box
prompts you to verify that you want to replace the existing file. Choose the Yes
button to replace the existing file, or if you are moving or copying more than one
file, choose the Yes To All button. If you choose the Yes To All button, File
Manager does not prompt you for each file that is replaced.
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4,

» To move or copy files or directories using commands
ol 1.

Select the file or directory you want to move or copy.
You can select more than one file or directory.

To move, from the File menu, choose Move. Or choose the Move button on
the toolbar.

To copy, from the File menu, choose Copy. Or choose the Copy button on the
toolbar.

The name of the selected file or directory appears in the From box of the Move
or Copy dialog box.

You can select a different file or directory by typing its name in the From box.
If the file or directory is not in the current directory, include the path.

In the To box, type the destination drive or directory.

If you type a drive name without including a path, the file or directory will
appear in the current directory of the drive.

If you type a new name, the original file or directory will be renamed when it
is moved or copied.

Choose the OK button.

If the destination directory contains a file with the same name, a message prompts
you to verify that you want to replace the existing file. Choose the Yes button to
replace the existing file, or if you are moving or copying more than one file,
choose the Yes To All button. If you choose the Yes To All button, File Manager
does not prompt you for each file that is replaced.

Copying a File to the Clipboard

You can copy a file onto the Clipboard so that the file can be linked to or
embedded in another document. For more information about object linking and
embedding, see Chapter 10, “Object Linking and Embedding.”

» To copy a file to the Clipboard

1.
2.

Select the file you want to copy.
From the File menu, choose Copy to Clipboard.

The name of the selected file appears in the Copy to Clipboard box. You can
copy a different file by typing its name in the box. If the file is not in the
current directory, include its path.

Choose the OK button.
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Deleting a File or Directory

Security

You can use File Manager to delete files and directories. By selecting multiple
files or directories, you can delete them at one time. When you delete a directory,
all files and subdirectories in the directory are deleted.

On drives formatted to use the Windows NT file system (NTFS), you must have
permission to delete a file or directory. For more information on file and directory
permissions, see “Securing Directories and Files” later in this chapter.

Caution Once you delete files or directories, they cannot be recovered.

To delete a file or directory
1. Select the file or directory you want to delete.

2. From the File menu, choose Delete, or choose the Delete button on the toolbar.
Or press DEL.

3. Choose the OK button to delete the selected file or directory, or type the name
of a different file or directory you want to remove. If you type a long name
that contains spaces, be sure to enclose the name in quotation marks.

File Manager prompts you to confirm the deletion. (You can choose not to
receive confirmation messages. For more information, see “Turning Off
Confirmation Messages” later in this chapter.)

4. To delete a single file or directory, choose the Yes button. To delete more than
one file or directory and without confirming each deletion, choose the Yes To
All button.

Renaming a File or Directory

Security

You can rename any file or directory by choosing the Rename command from the
File menu.

On drives formatted to use the Windows NT file system (NTFS), you must have
permission to rename a file or directory. For more information on file and
directory permissions, see “Securing Directories and Files™ later in this chapter.

Caution Be careful when you rename files. If you rename a file that your system
requires, for example, any file that has an .SYS extension, your system may not
start or run correctly.

» To rename a file or directory

1. Select the file or directory you want to rename.
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2. From the File menu, choose Rename.

The name of the selected file or directory appears in the From box. If you
decide to rename a different file, type the name in the From box. To rename a
group of files, use wildcards (for example, *.BAK).

3. In the To box, type the new name.

Use a file or directory name that does not already exist in the destination
directory. You can specify only one filename in the To box. If you want to
rename a group of files, you can only use wildcards (for example, *.TXT).

4. Choose the OK button.

Searching for a File or Directory

When you want to find a file or directory, use the Search command. You can
select files and directories in the Search Results window and use File menu
commands to print, copy, move, delete, and rename them. You can view file
details by using commands on the View menu. However, although you can move
or copy files from the Search Results window, you cannot copy or move files into
1t.

To search for a file or directory
1. Select the directory that you want to start the search from.
2. From the File menu, choose Search.

3. In the Search For box, type the name of the file or directory. Use wildcards to
search for a group of files or directories with similar names or extensions.

For example, to search for all files with the extension .WRI, you would type
* wri in the Search For box.

4. In the Start From box, the current directory is listed. To start the search from a
different directory, type the directory name in the Start From box.

5. By default, File Manager searches the directory listed in the Start From box,
and all its subdirectories. If you do not want File Manager to search the
subdirectories, clear the Search All Subdirectories check box.

6. Choose the OK button.

File Manager searches the directory and subdirectories you specified, displaying
its progress in a dialog box. To cancel the search, choose the Cancel button. You
can continue working with File Manager while the search continues in the
background. To hide the dialog box while the search continues, choose the Hide
button. When the search is complete, the Search Results window appears,
displaying all the filenames and directories found.
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If you modify the drive on which the search was performed and the Search
Results window is active (or is made active), a message appears, asking whether
you want to update the Search Results window. If you choose the Yes button, the
search is performed again on the modified drive.

Associating Files with an Application

A file is associated with an application through the file’s filename extension and
the application’s file type. Once a file is associated with an application, you can
choose any file with the same extension in the directory window to start the
application and load the file. A file extension can be associated with only one
application; however, an application can be associated with several different file
extensions.

Many applications are associated with files when you install them. If an
application does not automatically set up an association, you can associate files
with it by using the Associate command.

= If the application appears in the list shown in the Associate With File Type
box, you can associate a file extension with it using the Associate dialog box.

= If the application does not appear in the list, create a file type for it and
associate it using the File Type Editor dialog box.

» To create or change a file association using the Associate dialog box

1. In a directory window, select a file that has the extension you want to
associate.

For example, to associate files that have a .DAT extension with an application,
select any file that has a .DAT extension.

2. From the File menu, choose Associate.

Files with Extension: |71

Associate With File Type:

Card File [cardfile.exe)
Help File [winhlp32_exe]
Paintbrush Picture (pbrush.exe)
Registration Entries [regedit.exe)
Sound Recorder [soundrec_exe)
Terminal Settings [terminal.exe]

3. The filename extension of the file you selected appears in the Files With
Extension box. To associate a different filename extension, or if no file was
selected when you chose the Associate command, type the extension in the
Files With Extension box.
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4. Select the file type and program name in the Associate With File Type box and
choose the OK button.

» To create or change a file association using the File Type Editor dialog box

1. In a directory window, select a file that has the extension you want to
associate.

2. From the File menu, choose Associate.

3. In the Associate dialog box, choose the New Type button.

Description: Associated Extensions

|| [acc

Command:
|

4. The filename extension of the file you selected appears in the Associated
Extensions box. Choose the Add button to add it to the list of associated
extensions.

5. Type a description for the type of file in the Description box.
The description identifies the file type and is required.

6. Type the name of the program file in the Command box. By choosing the
browse button in the Command box, you can select the program file and its
path.

7. Choose the OK button.

» To remove an association

1. In a directory window, select a file with the extension that you want to
remove.

2. From the File menu, choose Associate.

3. In the Associate dialog box, the extension of the selected file appears in the
Files With Extension box. To remove the association for a different filename
extension, or if no file was selected when you chose the Associate command,
type the extension in the Files With Extension box.

4. In the Associate With box, select None.
5. Choose the OK button.
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Changing File Type Information

The Advanced section of the File Type Editor dialog box allows you to edit
information that File Manager uses when opening or printing a file either
conventionally or using dynamic data exchange (DDE). Because this information
is added when you install an application, you should not need to edit it.

Security Some file types are protected. To change a protected file type, you must be logged
on as a member of the Administrators or Power Users group.

The options in the Advanced section specify information for the file type shown
in the Description box. Information is specific to each application. In commands,
the %1 parameter represents the filename of the file currently selected in File
Manager. The following table describes the options.

Option Purpose

Action Specifies the action to which the information in the Command and
DDE areas applies. For example, if Open is selected, the
information in the Command and DDE areas specifies what to do
when opening a file.

Command Specifies the command that is run to perform the action. If the
application supports DDE, specify the name of the program file here
and use the options in the DDE area to specify the DDE commands.

Uses DDE Specifies that the application uses DDE commands to perform the
action.

DDE Message Specifies the DDE command to use if the application is already
running.

DDE Application Specifies the DDE command to use if the application is not running.

Not Running

Application Specifies the DDE application string used to initiate a DDE
conversation with the application specified in the Command box.

Topic Specifies the DDE topic string used to initiate a DDE conversation

with the application specified in the Command box.

Starting an Application from File Manager

You can use File Manager to start your applications. You start an application by
opening a program file or document file from a directory window. Program files
almost always have a .COM, .EXE, .PIF, .CMD, or .BAT filename extension.
Document files are associated with applications and are represented by document-
file icons in directory windows. For information about the types of file icons, see
“Working with Files and Directories” earlier in this chapter.
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When you start an application that runs in a window, the window appears in front
of any open File Manager windows. When you start an application that uses the
entire screen, the application replaces the File Manager window. If you want to
reduce File Manager to an icon each time you start an application, choose the
Minimize On Use command from the Options menu.

To start an application from a program file or document file
e In the directory window, choose the filename.

_Or—
1. Select the filename in the directory window.

2. From the File menu, choose Open; or press ENTER.

To start an application and open a file

o Drag the icon for the data file onto the icon for the program file.
—Or—

1. Select the program file for the application you want to use.

2. From the File menu, choose Run.

3. The name of the program file appears in the Command Line box. If you did
not select a program file, or if you want to run a different application, type the
name (and path, if necessary) of the program file in the Command Line box.

Then, in the Command Line box, add the name of the data file after the
program filename. Include the path if the data file is not in the same directory
as the program file.

4. If you want the application to start minimized, select the Run Minimized
check box.

5. Choose the OK button.

Printing a File from File Manager

>

Using File Manager, you can print files that are associated with applications. You
can use the Print command, or, if you are using a mouse, you can simply drag the
file icon onto the minimized Print Manager icon.

Note Some applications do not support printing through File Manager. If this is
the case, or if a file is not associated with an application, you must open the
application and print the file from there.

To print a file by dragging the file icon
1. Make sure Print Manager is started and minimized to an icon on the desktop.

2. Drag the document-file icon onto the Print Manager icon.
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» To print a file by using the Print command
1. In the directory window, select the file you want to print.
2. From the File menu, choose Print.
3. Choose the OK button.

Turning Off Confirmation Messages

If you do not want a confirmation message to appear each time you delete or
replace files and directories, you can change the confirmation settings. You can
also turn off messages that appear when you perform certain mouse actions, such
as moving and copying. If you turn off confirmation messages, File Manager
carries out commands as soon as they are issued.

» To turn off confirmation messages
1. From the Options menu, choose Confirmation.

2. Clear the check box for each confirmation option you want to cancel, and then
choose the OK button.

Clear this option If you don’t want a warning message

File Delete Before deleting files

Directory Delete Before deleting directories

File Replace Before writing over existing files

Mouse Action Before moving or copying files by dragging

Disk Commands Before formatting or copying a disk

Modifying System, Hidden, Before deleting, replacing, or moving system, hidden,
Read Only files and read-only files

Caution If you clear the Directory Delete check box, remember that when you
delete a directory, all files and subdirectories in that directory are deleted. Also, to
avoid accidentally writing over files you want to keep, do not clear the File
Replace check box.
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Setting File Attributes

File attributes are part of the directory information the operating system maintains
for each file. This information helps the operating system identify a file and
controls the kinds of tasks you can perform with the file. You can see file
attributes in a directory window by choosing the All File Details command on the

Security

View menu.

On drives formatted to use the Windows NT file system (NTFS), you must have
permission to change file attributes. For more information on file and directory
permissions, see “Securing Directories and Files” later in this chapter.

The four file attributes are described in the following table.

Abbreviation Attribute

Description

R Read-only
A Archive
H Hidden

S System

Prevents a file from being changed.

Identifies a file that has been modified since it was last
backed up. When you use some commands, such as
backup and xcopy, the archive attribute is turned off.

Prevents a file from appearing in a directory listing at the
command prompt. Files that have a hidden attribute
appear in directory windows only if you select the Show
Hidden/System Files check box by using the By File
Type command on the View menu.

Identifies the file as a system file. Files that have a
system attribute appear in a directory window only if you
select the Show Hidden/System Files check box by using
the By File Type command on the View menu.

» To change file attributes for one or more files

1. Select the files whose attributes you want to set.

2. From the File menu, choose Properties.
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File Name: Feb Research Notes.doc
Path: D:\Project Noon
Last Change:  2/11792 2:00:00AM
Yersion: Mot marked
LCopyright: Mot marked
Size: 62.249 bytes
[ Attributes
[JRead Only [ Hidden
Archive | System
i
B2

If you are using a network, more options may be available in the Properties
dialog box.

3. Select or clear the check boxes for the attribute settings.

When you have selected more than one file, check boxes will appear gray if
the attribute for the files is not set alike.

4. Choose the OK button.

Viewing a File’s Version Information

File Manager allows you to see version information for files. This is information
supplied by the manufacturer of an application including the company name and
other comments.

» To view a file’s version information
1. Select the file whose information you want to see.
2. From the File menu, choose Properties.

3. In the Version Information box, select the subject in the left box. The
information on the subject is displayed in the right box.

Working with Shared Directories and Files

Windows NT allows you to share directories and files over the network. Use File
Manager to share and stop sharing directories. File Manager also allows you to
monitor and control the use of shared files.
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Sharing a Directory

Share a directory when you want to make information located there available to
others on the network.

Security

Before you can share a directory, the Server service must be running. You can
start the server service using the Services option in Control Panel.

To share a directory, you must be logged on as a member of the Administrators or
Power Users group.

To share a directory

1.

Select the directory you want to share in either the tree or contents panes of the
directory window.

If you are logged on as a member of the Administrators group or if you have
permission, you can share a directory on a remote computer. First connect to
the computer’s shared root directory, for example C$. Then select the directory
you want to share.

From the Disk menu, choose Share As, or choose the Share Directory button
on the toolbar.

Share Name:

Path: |D:\Proiect Moon\Proposal |

Comment: | |

User Limit:
@ Unlimited

Y —

The Share Name box shows the name users will specify to connect to the
shared directory. By default, File Manager uses the name of the directory you
selected. If you want to share the directory using a different name, type a new
share name in the Share Name box. Share names can be up to 12 characters
long.

If the directory you selected is already shared, the Share Name box shows the
share names for the directory. You cannot give a shared directory a new share
name; however, you can create a new share by choosing the New Share button.

. The path for the directory you selected appears in the Path box. If you decide

you want to share a different directory, you can type a different path.

. Type a comment in the Comment box.
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Users will see the comment when connecting to the directory using the
Connect Network Drive dialog box. A comment is optional.

. Set a limit on the number of users who can connect to the shared directory at

one time in the User Limit box.

By default, no limit is set.

. To set permissions on the shared directory, choose the Permissions button.

For more information on setting permissions, see “Setting Permissions
Through Shared Directories” later in this chapter.

. Choose the OK button.

File Manager shows that the directory is shared by displaying a shared
directory icon next to the directory’s name.

Stopping Directory Sharing

Security

Once you stop sharing a directory, it is no longer available over the network.

To stop sharing a directory, you must be logged on as a member of the
Administrators or Power Users group.

Caution If you choose to stop sharing a directory while users are connected, those
users may lose their data.

» To stop sharing a directory

. Select the drive containing the directories you want to stop sharing by

selecting the drive’s directory window or drivebar button.

. From the Disk menu, choose Stop Sharing. Or choose the Stop Sharing button
on the toolbar.

Shared Directories on \\setter:

i B

1 ADMING C:hnt

E1B% B

=108 Ch

=103 D

f= Project Foad D:\Project Foad

£ Proposal [:\Project NoonProposal
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3.

The Stop Sharing dialog box shows the computer name of the selected drive
and, in the Shared Directories On box, the shared directories on the drive. For
each share name, the directory path on the computer is shown. Select the
directories you want to stop sharing. If you selected a shared directory before
opening the Stop Sharing Directory dialog box, the shared directories
corresponding to that directory are already selected.

. Choose the OK button.

If any users are connected to a shared directory, File Manager will warn you
before sharing is stopped.

Changing Share Properties

You can change the number of users allowed to connect to a shared directory, a
shared directory’s comment information, or the shared directory’s permissions.

Security To change a shared directory’s properties, you must be logged on as a member of
the Administrators or Power Users group. Only members of the Administrators
group can change share properties on administrative shares.

» To change a shared directory’s properties

1.

2.

Select the shared directory whose properties you want to change in either the
tree or contents panes of the directory window.

From the Disk menu, choose Share As. Or choose the Share Directory button
on the toolbar.

Share Name:

Path: D:\Project Noon\Proposal

Comment: |

User Limit:
@ Unlimited

Oatow [ [ users

. If the directory has been shared more than once, select the name in the Share

Name box of the shared directory whose properties you want to change. You
can then:

= Change the number of users allowed to connect to the directory at one time
by selecting, under User Limit, the Unlimited option or the Users option.
When you select the Users option, you can either type a limit or click the
scroll arrows to raise or lower the limit.
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= Edit the Comment box to change the description that appears when users
see the shared directory listed in the Network Connections dialog box.

»  Choose the Permissions button to change the permissions on the shared
directory. For more information on setting permissions, see “Setting
Permissions Through Shared Directories” later in this chapter.

4. Choose the OK button.

Viewing or Closing Shared Files

You can view who is using shared files and stop the use of a file. When you are
viewing the status of a shared file, File Manager provides the following

information.

Item Shows

Total Opens The total number of users who are working with the file
Total Locks The total number of locks on the file

Open By The name of the user who has the file open

For The type of access the user has to the file

Locks The number of locks the user has placed on the file

File ID The identification number of the file

Security To stop the use of shared files, you must be logged on as a member of the
Administrators or Power Users group.

» To view or close a shared file
1. Choose the file in the contents pane of the directory window.
2. From the File menu, choose Properties.

3. Choose the Open By button in the Properties dialog box.

File Name: C:A\PROPOSAL\PROPOSAL.D

Total Opens: 3
Total Locks: 0

Close Selected
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4. To stop use by one or more users, select the user or users and choose the Close
Selected button.

To stop use by all users, choose the Close All button.

Caution When you close a file that is in use, changes made to that file will not
be saved.

5. Choose the OK button.

Securing Directories and Files

You can control users’ access to directories and files on drives formatted to use
the Windows NT file system (NTFS). Drives formatted to use FAT and HPFS do
not support Windows NT security. You can, however, secure shared directories
no matter what file system is in use.

To secure a directory or file, set permissions on it. Each permission you set
specifies the access that a group or user can have to the directory or file. For
example, when you set Read permission for the group called coworkers on the file
MY IDEAS.DOC, the users in that group can display the file’s data and attributes,
but cannot change the file or delete it. For more information on how to work with
groups and users, see Chapter 13, “User Manager.”

Windows NT offers a set of standard permissions you can set on directories and
files. The standard permissions for directories are No Access, List, Read, Add,
Add & Read, Change, and Full Control. The standard permissions for files are No
Access, Read, Change, and Full Control.

The standard permissions are groups of individual permissions. When you set a
standard permission, the abbreviations for the individual permissions are
displayed beside the standard permission. For example, when you set the standard
permission Read on a file, the abbreviation RX appears beside it. The individual
permissions and their abbreviations are:

Read (R) Write (W) Execute (X)
Delete (D) Change Permissions (P) Take Ownership (O)
In addition to setting standard permissions, you can set special access

permissions. Special access permissions allow you to define a custom set of
individual permissions for directories and files.
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To effectively work with NTFS security, keep the following in mind:

= Permissions are cumulative except that the No Access permission overrides all
other permissions. For example, if the coworkers group has Change
permission for a file while the finance group has only Read permission and
John is a member of both groups, John will be granted Change permission.
However, if you change the finance group’s permission for the file to No
Access, John will not be able to use the file even though he is a member of a
group that has access to it.

= When you create files and subdirectories in a directory, they inherit
permissions from the directory. For example, if you add a file to a directory
that allows the coworkers group Change permission and the finance group
Read permission, those same permissions will apply to the file.

=  Changing the permissions on a directory changes the permissions on files that
exist in the directory. For example, if you grant the finance group Change
permission on a directory, members of that group will be able to change all the
files in the directory.

= The user who creates a file or directory is the owner of that file or directory.
The owner can always control access to the file or directory by changing the
permissions set on it. Users who are members of the Administrators group can
always take ownership of a file or directory.

= The easiest way to administer security is by setting permissions for groups, not
individual users. Typically, a user will need access to many files. If the user is
a member of a group that has access to the files, you can end the user’s access
by removing the user from the group rather than changing the permissions on
each of the files. Note that setting permission for an individual user does not
override the access granted to the user through groups to which the user
belongs.

Setting Directory Permissions

When you first display a directory’s permissions, the Directory Permissions
dialog box shows the permissions that the directory inherited from the directory
containing it. The Names box shows the groups and users for whom permissions
have been set. If you have selected multiple directories, permissions are shown
only if they are the same for all of the directories. You can change permissions,
add a group or user to the list, or remove a group or user from the list.

Setting permissions on a directory controls what users can do in that directory.
When you set directory permissions, you are setting permissions on the directory
and all the files that exist in the directory. Existing subdirectories and their files
are not changed unless you specify to change them. When you create new files
and new subdirectories, they inherit their permissions from the directory.
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When you set a standard permission, two sets of individual permissions are
displayed next to it: the permissions set on the directory and the permissions set
on files in the directory. For example, when you set Add & Read permission on a
directory, you see (RWX), signifying Read, Write, and Execute permissions on
the directory, and (RX), signifying Read and Execute permission on files in the

directory.

To change permissions on the directory, you must be the owner of the directory,
or have been granted permission to do so by the owner.

The following table shows permissions for directories and the actions on
directories available to users for each permission.

® Permission allows use
O Permission does not allow use

e
Ca 55

Yo

Display directory filenames

Display the directory’s attributes

Go to the directory’s subdirectories

Change the directory’s attributes

Create subdirectories and add files

Display the directory’s owner and permissions
Delete the directory and subdirectories
Change directory permissions

Take ownership of the directory

O 0 O 0 0 0 0 0 O

CCCec0 e e e

ooooooooo&’@ad

O OO @ o 0 0 0 O

C O O @ @ ¢ 0 0 o

C O @ @ 06 0 0 0 o
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The following table shows permissions for directories and the actions on files
available to users for each permission.

® Permission allows use

. 4 &
O Permission does not allow use & i I
) Q 9
Z > ¥ S0 O
A & & F 3 ~é§ ¥
< S 7 < < ) 3
Display the file’s owner and permissions o o} [ o} ) ) [
Display the file’s data 0] o [ o [ ° )
Display the file’s attributes o} 0] [ o ° ) [
Run the file if it is a program o o [ ®) ) [ )
Change the file’s attributes o o ®) o o ® °
Change data in and append data to the file o] o o o o] ) [
Delete the file o} o) O o o) ) [
Change the file’s permissions o o) O o] o) o [
Take ownership of the file o o ®) o o o [

» To view or change directory permissions

1. Select the directory in the directory window. You can select multiple
directories.

2. From the Security menu, choose Permissions. Or choose the Permissions
button on the toolbar.

Directory:  D:\Project Noon
Owner: SteveW [Steve Wood)

O Replace Permissions on Subdirectories

Mame:

Executives Read [BX] [RX]
@@ Noon Leads Change [RWwW>D] [RWwWHD)
£ Noon Project Team Add & Read [RwX] [RX)
B8 S ales Staff No Access [Mone] [None]
ﬁ Stevelw [Steve Wood) Full Control [All) (&1}

Type of Access: |Change
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3. By default, the changes you make to directory permissions affect the directory

and its files. Changes do not automatically apply to existing subdirectories and
their files. You can apply the changed permissions to existing subdirectories
and their files by selecting the Replace Permissions On Subdirectories check
box.

Select the name of a group or user and choose a permission from the Type of
Access box.

You can customize directory and file permissions by choosing Special
Directory Access... or Special File Access.... For more information on special
access permissions, see “Setting Special Access Permissions” later in this
chapter.

5. Choose the OK button.

> To add a group or user to the directory permissions list

1. In the Directory Permissions dialog box, choose the Add button.

The Add Users and Groups dialog box displays the groups on the computer or
in the domain shown by the List Names From box.

You can select another domain by using the List Names From box. Domains
appear only if your computer is a member of a domain on a Windows NT
Advanced Server network. The domains shown have a trust relationship with
the domain containing the directory.

List Names From: \Asetter LgJ
Names:
B Administrators Members can fully administer the system
% Backup Dperators Members can assign file backup and restare p
CREATOR OWMER The user who creates this object
(& Everyone &l Users
{3

Guests Guests of the domain

£ INTERACTIVE Users accessing this object locally

# METwWORK Users accessing this object remotely
# Power Users Members can treat the computer as their own [+

Add Names:

[T 1]

Type of Access: |[Read
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2. You can use options in the Add Users and Groups dialog box to display users,
find the users in a group, or find the domain to which a group or user belongs.

= Choose the Show Users button to display the names of users on the selected
computer or domain.

= To see a group’s content, select the group and choose the Members button.
Users are listed in a new dialog box. On a Windows NT Advanced Server
network, global groups that are members of a local group appear in the list.
To see a global group’s users, select the group and choose the Members
button. To include the group in the Add Users and Groups dialog box,
choose the Add button. To include some of the group’s users, select them
and choose the Add button.

= To add a group or user, you must know the domain which contains the
group’s or user’s account. On a Windows NT Advanced Server network,
choose the Search button to find the domain of a group or user. In the Find
Account dialog box, type the name of the group or user in the Find User Or
Group box and specify the domains you want to search. Then choose the
Search button. To include the groups or users in the Add Users and Groups
dialog box, select them in the Search Results box and choose the Add
button.

3. To add groups or users to the permissions list, select them in the Names box
and choose the Add button, or double-click the name of the group or user.

Or you can type the names of groups and users in the Add Names box.
Separate names using a semicolon. If the account of the group or user is not
located on the computer or domain shown by the List Names From box, you
must specify the location. Type the computer or domain name followed by the
group or user name and separate the names using a backslash, for example
SHIPPING\ERNESTA. You can type the name without waiting for Windows
NT to list groups in the Names box.

4. Select the permission for the groups or users shown in the Add Names box
using the Type of Access box.

5. Choose the OK button.

» To remove directory permissions for a group or user
1. In the Directory Permissions dialog box, select the name of the group or user.

2. Choose the Remove button.
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Setting File Permissions

When you first display a file’s permissions, the File Permissions dialog box shows
the permissions that the file inherited from the directory containing it. The Names
box shows the groups and users for whom permissions have been set on the file. If
you have selected multiple files, permissions are shown only if they are the same
for all of the files. You can change permissions set for the listed groups and users,
add a group or user to the list, or remove a group or user from the list.

To change permissions on the file, you must be the owner of the file, or have been
granted permission to do so by the owner. The following table shows permissions
for files and the actions available to users for each permission.

® Permission allows use
O Permission does not allow use

Display the file’s attributes

Run the file if it is a program

Display the file’s owner and permissions
Change the file’s attributes

Change data in and append data to the file
Delete the file

Change the file’s owner and permissions

0000000%40
CeS&

OO0 Q0 Ce e e
l?ead
EEEEREEXXILY
‘?0&,

» To change permissions on a file
1. Select one or more files from the contents pane of the directory window.

2. Choose Permissions from the Security menu, or choose the Permissions button
- on the toolbar.
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Owner: SteveW [Steve Wood)
MName:

File: D:\Project Noon\Proposal\PROPOSAL.DOC

Executives Read (R¥)
& INTERACTIVE Read [R¥X]
# Noon Leads Change [Rw>D)
i#¢ Noon Project Team Read [RX)
G S ales Staff Mo dccess [None)
ﬁ Stevel [Steve Wood) Full Cantrol (&ll)
Type of Access: |Full Control [*_!Zj

3. Select the name of the group or user whose permission you want to change.

4. Choose a permission from the Type of Access box.

To customize the permissions set for the group or user, choose Special

Access... from the Type of Access box. For more information on special access
file permissions, see “Setting Special Access Permissions” later in this chapter.

5. Choose the OK button.

» To add a group or user to the file permissions list

1. In the File Permissions dialog box, choose the Add button.

The Add Users and Groups dialog box displays the groups on the computer or
in the domain shown by the List Names From box.

You can select another domain by using the List Names From box. Domains
appear only if your computer is a member of a domain on a Windows NT
Advanced Server network. The domains shown have a trust relationship with
the domain containing the file.
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List Names From: |@ \Waetter® @

FEGP Administrators Members can fully administer the system
i Backup Dperators Members can assign file backup and restore p
" CREATOR OWNER The user who creates this object
) Everyone All Users
& Guests Guests of the domain
S INTERACTIVE Users accessing this object locally
& NETWORK Users accessing this object remotely
& Power Users Members can treat the computer as their own

Add Names:

[T

Type of Access: |Flead

2. You can use options in the Add Users and Groups dialog box to display users,
find the users in a group, or find the domain to which a group or user belongs.

Choose the Show Users button to display the names of users on the selected
computer or domain.

To see a group’s content, select the group and choose the Members button.
Users are listed in a new dialog box. On a Windows NT Advanced Server
network, global groups that are members of a local group appear in the list.
To see a global group’s users, select the group and choose the Members
button. To include the group in the Add Users and Groups dialog box,
choose the Add button. To include some of the group’s users, select them
and choose the Add button.

To add a group or user, you must know the domain which contains the
group’s or user’s account. On a Windows NT Advanced Server network,
choose the Search button to find the domain of a group or user. In the Find
Account dialog box, type the name of the group or user in the Find User Or
Group box and specify the domains you want to search. Then choose the
Search button. To include the groups or users in the Add Users and Groups
dialog box, select them in the Search Results box and choose the Add
button.
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3. To add groups or users to the permissions list, select them in the Names box
and choose the Add button, or double-click the name of the group or user.

Or you can type the names of groups and users in the Add Names box.
Separate names using a semicolon. If the account of the group or user is not
located on the computer or domain shown by the List Names From box, you
must specify the location. Type the computer or domain name followed by the
group or user name and separate the names using a backslash, for example
SHIPPING\ERNESTA. You can type the name without waiting for Windows
NT to list groups in the Names box.

4. In the Type of Access box, select the permission for the groups or users shown
in the Add Names box.

5. Choose the OK button.

» To remove file permissions for a group or user
1. In the File Permissions dialog box, select the name of the group or user.
2. Choose the Remove button.

Setting Special Access Permissions

In general, the standard directory and file permissions are all you need to secure
your directories and files. However, if you need to create a custom set of
permissions, you can use special access permissions. You can set special access
permissions on directories, on all the files in selected directories, or on selected
files.

When you set special access permissions on a directory, the permissions affect the
directory only. Current permissions on files in the directory are not affected.
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The following table shows special access permissions for directories and the
actions available to users for each directory permission.

® Permission allows use
O Permission does not allow use
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Display filenames in the directory
Display the directory’s attributes

Add files and subdirectories

Change the directory’s attributes

Go to the directory’s subdirectories
Display directory owner and permissions
Delete the directory

Change the directory’s permissions

ooooooooo&ead
OO0 o0ee0 e o
U
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O C ® 000 0 0O
O € 00000 0O
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Take ownership of the directory

The following table shows special access permissions for files and the actions
available to users for each permission.

® Permission allows use

N
O Permission does not allow use _§ { &
& S S
F & 85 .8
S & & F $F £S5
¥ a ) O &0 XK

Display the file’s owner and ® [ [ o) ®) ®
permissions
Display the file’s data ) o O O o o [
Display the file’s attributes ) o) ° o o) o) [
Change the file’s attributes ) [ o o o O [ )
Change data in and append data O [ ) o O o) o [
to the file
Run the file if it is a program 0O o ) o) O ) [
Delete the file O o) o [ o o [
Change the file’s permissions O o o o) [ o [ )
Take ownership of the file o o O O O [ ®
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» To set special access permissions

1.

You can set special access permissions on directories, all files in directories, or
selected files.

To set permissions on directories, select them in the directory window.

To set permissions on all the files in one or more directories, select the files’
directories in the directory window.

To set permissions on selected files, select the files in the contents pane of the
directory window.

. Choose Permissions from the Security menu, or choose the Permissions button

on the toolbar.

. In the Permissions dialog box, select the group or user you want to grant

special access.

If no groups or users are shown, indicating that the directories or files you
selected have differing permissions, add a group or user before setting special
access permissions.

Open the appropriate Special Access dialog box.

To set permissions on directories, choose Special Directory Access... from the
Type of Access box or double-click the name of the group or user.

To set permissions on all the files in the selected directories, choose Special
File Access... from the Type of Access box.

To set permissions on selected files, choose Special File Access... from the
Type of Access box or double-click the name of the group or user.

The Special Access dialog box shows which access permissions have been
granted based on the current standard or special permissions setting.

Directory:  D:\Project Noon

MName: Moon Project Team
' Full Control (All)
) Other
& Read (R)
B white (w)
(| Execute [(X]
[ pelete (D)
[] change Permissions (P)
[] Take Ownership (0)
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3. To set special access permissions, select the check boxes for the access you

want to grant.
To grant full control, select Full Control (All).

If you are setting permissions for all files in directories, you can select Access
Not Specified. This removes permissions from files in the selected directories
and prevents files from inheriting permissions from their directories.

4. Choose the OK button.

Setting Permissions Through Shared Directories

You can set permissions through a shared directory whether the directory is on a
drive formatted to use the Windows NT file system (NTFS), FAT, or HPFS.

Security

To work with shared directory permissions, you must be logged on as a member
of the Administrators or Power Users group.

To secure shared directories effectively, keep the following in mind:

Permissions set through a shared directory are effective only when the
directory is reached over the network.

Permissions set through a shared directory apply to all files and subdirectories
in the shared directory.

Permissions set through a shared directory that is on an NTFS volume operate
in addition to NTFS permissions set on the directory itself. Shared directory
permissions specify the maximum access allowed. For example, if a user has
Read permission on the shared directory but List permission on the directory
itself, the user’s access is limited to List.
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The following table shows the permissions for files and directories granted
through the shared directory and the actions available to users for each
permission.

® Permission allows use
O Permission does not allow use

N,
O‘qoce&&
G
Q”é’e

Display subdirectory names and filenames
Display the data and attributes of files
Run program files

Go to the directory’s subdirectories
Create subdirectories and add files
Change data in and append data to files

&
S

N4

&
[ J
[ J
[
o
[
®
Change the file’s attributes )
[ J

00000 O0O
ooooooool?e‘?d
00000 00

Delete subdirectories and files

» To view or change permissions on a shared directory

1. Select the shared directory whose permissions you want to change in either the
tree or contents panes of the directory window.

2. From the Disk menu, choose Share As. Or choose the Share Directory button
on the toolbar.

3. In the Share Directory dialog box, choose the Permissions button.

4. In the Access Through Share Permissions dialog box, select the name of a
group or user and select a permission from the Type of Access box.

5. Choose the OK button.

» To add a group or user to the shared directory permissions list
1. In the Access Through Share Permissions dialog box, choose the Add button.

The Add Users and Groups dialog box displays the groups on the computer or
in the domain shown by the List Names From box.

You can select another domain by using the List Names From box. Domains
appear only if your computer is a member of a domain on a Windows NT
Advanced Server network. The domains shown have a trust relationship with
the domain containing the directory.

2. Use options in the Add Users and Groups dialog box to display users, find the
users in a group, or find the domain to which a group or user belongs.

= Choose the Show Users button to display the names of users on the selected
computer or domain.
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= To see a group’s content, select the group and choose the Members button.

Users are listed in a new dialog box. On a Windows NT Advanced Server
network, global groups that are members of a local group appear in the list.
To see a global group’s users, select the group and choose the Members
button. To include the group in the Add Users and Groups dialog box,
choose the Add button. To include some of the group’s users, select them
and choose the Add button.

To add a group or user, you must know the domain which contains the
group’s or user’s account. On a Windows NT Advanced Server network,
choose the Search button to find the domain of a group or user. In the Find
Account dialog box, type the name of the group or user in the Find User Or
Group box and specify the domains you want to search. Then choose the
Search button. To include the groups or users in the Add Users and Groups
dialog box, select them in the Search Results box and choose the Add
button.

3. To add groups or users to the permissions list, select them in the Names box

and choose the Add button, or double-click the name of the group or user.

Or you can type the names of groups and users in the Add Names box.
Separate names using a semicolon. If the account of the group or user is not
located on the computer or domain shown by the List Names From box, you
must specify the location. Type the computer or domain name followed by the
group or user name and separate the names using a backslash, for example
SHIPPING\ERNESTA. You can type the name without waiting for Windows
NT to list groups in the Names box.

In the Type Of Access box, select the permission for the groups or users
shown in the Add Names box.

5. Choose the OK button.

» To remove shared directory permissions for a group or user

1. In the Access Through Share Permissions dialog box, select the name of the

group or user.

2. Choose the Remove button.
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Auditing Files and Directories

Security

Auditing files and directories allows you to track their usage. For a particular file
or directory, you can specify which groups or users and which actions to audit.
You can audit both successful and failed actions. Windows NT stores the
information generated from auditing in a file. You can view the information using
Event Viewer. For more information on Event Viewer, see Chapter 15, “Event
Viewer.”

Important To audit files and directories, you must set the audit policy to audit file
and object access. Set the audit policy using User Manager. For more information
on audit policy, see Chapter 13, “User Manager.”

To audit files and directories, you must be logged on as a member of the
Administrators group.

To audit the following activities on a directory, select the events shown.

® Event audits action

O Event does not audit action _§ -
§ o s &
s & g ¢ §& @&
& & & F 5 Lo
Displaying filenames ° o o o} o o
Displaying attributes [ O ° O o o
Changing attributes O ) o o O o
Creating subdirectories and files o ® o o ©) o
Going to the directory’s subdirectories O o} ® O o o}
Displaying owner and permissions [ [ [ o ®) 0]
Deleting the directory o 0] o ® o) o
Changing directory permissions o o ) o ® e}
Changing directory ownership O o O O o °
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To audit the following activities on a file, select the events shown.

® Event audits action

O Event does not audit action . §% R
k] L osp d §§0’ 5} @ é;&
g & g an & 05"§ IS

Displaying the file’s data ® O ®) O o o
Displaying attributes ®e O [ o o
Displaying the file’s owner and [ ) ° o o
permissions

Changing data o e O o o o
Changing attributes o e o ] o O
Running the file o O [ o o o
Deleting the file o O o) ® o o
Changing the file’s permissions O O @) @) ° o
Changing the file’s ownership o O o o o ®

» To audit a file or directory

1. In the File Manager window, select the file or directory.

2. From the Security menu, choose Auditing.

Directory:  D:\Project Noon

O Replace Auditing on Subdi

Hame:

B Noon Project Team
£G® S ales Staff

 Events to Audit

Bead

Write

Execute

Delete

Change Permissions
Take Ownership

Success

aujuinlc

Failure

oogooono
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3. If you are setting auditing on a directory, select the Replace Auditing On
Subdirectories check box when you want to change the auditing on
subdirectories and their files. When the check box is clear, your auditing
choices affect only the selected directory and its files.

4. Select the name of the group or user.
5. Select the events to audit, and then choose the OK button.

To add a group or user to the auditing list
1. In the Auditing dialog box, choose the Add button.

The Add Users and Groups dialog box displays the groups on the computer or
in the domain shown by the List Names From box. You can select another
domain by using the List Names From box.

2. Use options in the Add Users and Groups dialog box to display users, find the
users in a group, or find the domain to which a group or user belongs.

= Choose the Show Users button to display the names of users on the selected
computer or domain.

= To see a group’s content, select the group and choose the Members button.
Users are listed in a new dialog box. On a Windows NT Advanced Server
network, global groups that are members of a local group appear in the list.
To see a global group’s users, select the group and choose the Members
button. To include the group in the Add Users and Groups dialog box,
choose the Add button. To include some of the group’s users, select them
and choose the Add button.

= To add a group or user, you must know the domain which contains the
group’s or user’s account. On a Windows NT Advanced Server network,
choose the Search button to find the domain of a group or user. In the Find
Account dialog box, type the name of the group or user in the Find User Or
Group box and specify the domains you want to search. Then choose the
Search button. To include the groups or users in the Add Users and Groups
dialog box, select them in the Search Results box and choose the Add
button.

3. To add groups or users to the audit list, select them in the Names box and
choose the Add button, or double-click the name of the group or user.

Or you can type the names of groups and users in the Add Names box.
Separate names using a semicolon. If the account of the group or user is not
located on the computer or domain shown by the List Names From box, you
must specify the location. Type the computer or domain name followed by the
group or user name and separate the names using a backslash, for example
SHIPPING\ERNESTA. You can type the name without waiting for Windows
NT to list groups in the Names box.

4. Choose the OK button.
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» To remove file or directory auditing for a group or user

1. In the Auditing dialog box, select the name of the group or user in the list.

2. Choose the Remove button.

Taking Ownership of Files or Directories

When you create a file or directory, you become the owner of it. By granting
permissions, the owner controls how the file or directory is used. The owner can
grant permission to another user to take ownership of a file or directory.
Otherwise, you must be logged on as a member of the Administrators group to
take ownership.

Although an administrator can take ownership, an administrator cannot transfer
ownership to others. This preserves security. For example, only an administrator
who takes ownership and changes permissions can gain access to a file on which
you have set No Access permission. By checking the ownership of the file, you
would see the ownership change and know who had violated the permission you
set on the file. To make sure that your files are secure, you should check their
ownership regularly.

» To take ownership of a file or directory

1. Select the file or directory in the File Manager window. You can select more
than one file or directory at a time.

2. From the Security menu, choose Owner.

Directory Name: D:\Quarterly Reports

Owner: caryr [Cary Reinstein)

3. Choose the Take Ownership button.

If you have selected one or more directories, File Manager asks whether you
want to take ownership of all files and subdirectories in the trees of the
selected directories. Choose Yes if you want to do so.

Maintaining Disks

Use commands on the Disk menu to format, copy, and label floppy disks.
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Formatting a Floppy Disk

Formatting prepares a floppy disk so that information can be stored on it and
retrieved from it. Windows NT uses the MS-DOS FAT file system when
formatting a disk. When you format a disk, File Manager removes all the
information from it, writes new directory information to it, and checks for
unusable portions called bad sectors.

» To format a floppy disk
1. Insert a disk into a drive.
2. From the Disk menu, choose Format Floppy.

3. In the Disk In box, make sure that the drive shown is the one containing the
floppy you want to format. If necessary, select the correct drive.

4. In the Capacity box, select the size of the disk you want to format.
5. To give the disk a volume label, type a name in the Label box under Options.

6. To quickly reformat a disk that has been formatted previously, select the Quick
Format check box. A quick format deletes directory information in the file
allocation table and root directory. The disk is not checked for bad sectors.

7. Choose the OK button.

8. A message prompts you to confirm that you want to format the disk.
Formatting deletes all information on a disk, so make sure the disk is the one
you want to format. Then choose the Yes button.

File Manager displays its progress in a dialog box as formatting proceeds. You
can work with File Manager while formatting continues in the background. To
cancel formatting, choose the Cancel button. To hide the dialog box while
formatting continues, choose the Hide button.

After your disk is formatted, a message prompts you to indicate whether you want
to format another disk.

Caution You cannot recover information on a disk that has been formatted.

Copying a Floppy Disk

You can make a copy of a floppy disk by using the Copy Disk command on the
Disk menu. When you copy a floppy disk, both disks must have the same storage
capacity. For example, if the disk you are copying from (the source disk) has a
capacity of 720K, the disk you are copying to (the destination disk) must also.
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» To copy an entire disk

1.

Insert the source disk in the drive you want to copy from. If you have two
floppy disk drives of the same size, insert the destination disk in the drive you
want to copy to.

2. From the Disk menu, choose Copy Disk.

. If your computer has two floppy disk drives, select the letter of the source

drive and the destination drive in the Copy Disk dialog box. Then choose the
OK button.

If your computer has only one floppy disk drive, you are not prompted to
select drives.

. A message prompts you to confirm that you want to copy the disk. There is no

way to recover information previously stored on the destination disk, so make
sure the disk in the destination drive is one you want to overwrite. Then
choose the Yes button.

If you are making a copy using a single floppy disk drive, you are prompted to
switch source and destination disks as needed.

A message informs you of the percentage of your disk that has been copied.

File Manager displays its progress in a dialog box as the copy is made. You can
work with File Manager while copying continues in the background. To cancel
copying, choose the Cancel button. To hide the dialog box while copying
continues, choose the Hide button.

Labeling a Disk

You can assign or change a label for a disk by selecting the Label Disk command
on the Disk menu.

» To assign or change a volume label

L.
2.
3.

Click the drive icon for the disk you want to label.
From the Disk menu, choose Label Disk.

In the Label box, type the label for the disk.

The label can contain up to 11 characters.

Choose the OK button.
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Control Panel

Overview

You can use Control Panel to customize various features of Windows NT.

This chapter describes the options available in Control Panel, which include the
following:

= Changing the desktop

= Setting serial port communications options

=  Working with fonts

=  Working with date, time, and international settings

= Customizing the keyboard, cursor, and mouse

= Working with printers

=  Working with device drivers

= Defining options for the operating system and
the uninterruptible power supply

= Configuring the network

= Managing server properties and services

Control Panel provides many options for customizing Windows NT so that it
works and looks the way you want. The icons in Control Panel represent options,
including network and sound capabilities, for configuring a computer. For each
icon, there is a corresponding command on the Settings menu. Your Control Panel
window may look different, depending on the devices you have installed, such as
an extra pointing device.

Most changes made in Control Panel (except adding and removing fonts) will
affect only the user who is currently logged on to the computer.
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Security Some options in Control Panel require you to be logged on as a member of a
specific group. If you are not a member of the necessary group, a message

appears.

Settings Help

i & & © -

£
Calor Fonts Ports Mouse Desktop  Keyboard

Bl ek KX

Printers  International  System  Date/Time  Network

‘@ ..'::m‘i.
B, B> de 2 @ &
Drivers  MIDI Mapper  Sound Server Services Devices

Choose To
lE' Set the color of the various elements of the desktop.
Calar

Qg Change the appearance of the cursor.

Cursors
ﬁ Change the system date, time, and time zone.
Date/Time
e Specify the pattern, screen saver, alignment grid, icon spacing, and cursor
H pecity the p g g pacing
] blink rate.
Desktop
Start, stop, and configure the startup type for device drivers.
DeQices
IE"@, Install and configure drivers for optional devices such as sound boards and
v synthesizers.

Drivers
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Choose

To

System

eF

UpPs

Add or remove screen, vector, and TrueType fonts. (Some printer fonts are
installed automatically when you install a printer. Other printer fonts must be
installed using a font installation program provided by the font manufacturer.)

Specify international settings such as the country and language, number and
currency formats, and date and time formats without changing the language of
the product itself.

Adjust the keyboard delay and repeat rate.

Select, change, or create MIDI setups, patch maps, or key maps for playing a
synthesizer connected to your computer.

Customize elements such as speed and button function for your pointing
device.

Install and configure network adapter cards and other network software, and
join a workgroup or a domain.

Set parameters for serial communications ports.

Open Print Manager to work with local and network printers.

For the local computer, view and manage connected users, directory shares,
open resources, directory replication, and recipients of administrative alerts.

Start, stop, pause, or continue the services available on the computer and
configure startup options.

Assign sounds to system and application events, and turn on or off the warning
beep and system sounds.

Specify the default operating system for startup, change user environment
variables, and define paging file size.

Configure the uninterruptible power supply to ensure safe shutdown during a
power failure.

For additional information about any option in Control Panel, see the online Help.
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Changing the Desktop

You can use the Desktop option to customize the appearance of your desktop
(which is where elements such as windows, icons, and dialog boxes appear). You
can specify a pattern or wallpaper for the desktop, adjust icon spacing, wrap icon
titles, or set an invisible grid to easily align windows and icons. Use the Color
option to select the colors used for displaying desktop elements.

Customizing Desktop Colors

The colors assigned to the different parts of the desktop are saved in color
schemes. Several predefined color schemes are provided. A solid color in
Windows NT is directly supported by your display adapter. VGA adapters support
16 solid colors, and 256-color adapters support 20 solid colors. Both types of
displays support hundreds of dithered colors, which are produced by patterns of
colored dots to simulate a color or pattern. Depending on the screen resolution,
dithered colors can look almost exactly like solid colors.

Changing an Existing Color Scheme

You can change individual colors assigned to a color scheme. If you find that you
use only one or two color schemes, you can shorten the list of selections by
deleting schemes. The only color scheme that cannot be deleted is Windows
Default, the scheme you see the first time you start Windows NT.

Important Deleting a color scheme on a particular computer will remove that
scheme for every user on that computer.

» To change the colors of a color scheme

i

1. In the Control Panel window, double-click the Color icon.

2. In the Color Schemes box of the Color dialog box, select the color scheme you
want to change.

3. Choose the Color Palette button.

The Color dialog box expands to include a list of screen elements, a palette of
basic colors, and a palette titled Custom Colors.
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Color Schemes

Capture Default

| File Edit

Custom Colors:

I | N
N

L Clicking "Highlighted" \ Clicking the OK button alternately selects

alternately selects the the Button Face, Button Shadow, and
Highlight and Highlighted Button Text elements.
Text elements.

4. Click the part of the sample screen where you want to change the color. Or in
the Screen Element box, select the element from the list.

You can see which element is selected in the Screen Element list.
5. In the Basic Colors palette, select the color you want.
The color is displayed in the sample screen.

6. Change the color of any other screen elements until you are satisfied with the
color scheme.

Control Panel uses the solid color closest to the selected dithered color for the
following screen elements:

Window Frame Window Text Window Background

Menu Bar Menu Text Active and Inactive Title Bar Text
Button Face Button Text Disabled Text

Highlight Highlighted Text

7. To save the new color selections, choose the Save Scheme button, and then
type a name for the scheme.

If you don’t save the scheme, Windows NT still uses the new color selections
until you change them again, even if you quit and restart Windows. However,
when you make another change or choose an existing scheme, the color
selections are lost.

8. Choose the OK button.
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Defining Custom Colors

The Basic Colors palette contains 48 colors. You can define and use up to 16
additional custom colors in a color refiner box by specifying the hue, saturation,
luminosity, and relative amounts of red, green, and blue.

Hue is the position of the color along the color spectrum. Saturation is the purity
of the hue, moving from gray to the pure color. Luminosity is the brightness of the
color on a scale from black to white.

» To define a custom color

1. In the Color dialog box, choose the Color Palette button, and then choose the
Define Custom Colors button.

— Color refiner box

ColorlSolid

2. Move the color refiner cursor to the area of the color refiner box that shows the

color you want. Then drag the arrow next to the luminosity bar to adjust the
luminosity.

The new color is displayed on the left side of the Color/Solid box. The right
side of the box displays the solid color closest to your choice. To select the
solid color, choose the right side of the box, or press ALT+O.

When you are satisfied with the color, select a box in the Custom Colors
palette for the new color. You can select an empty box or one that contains a
color you want to change.

If you do not select a box for the new color, it is placed in the first available
empty box or in the upper-left position in the Custom Colors palette.
Subsequent custom colors fill the boxes in sequence from upper left to lower
right unless you choose a specific box for the new color.
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4. Choose the Add Color button to add the new color to the Custom Colors
palette.

5. Define any other custom colors you want to add to the palette, and then choose
the Close button to return to the Color dialog box. Or to return to the Color
dialog box without closing the Custom Color Selector dialog box, drag the
Custom Color Selector dialog box to a new position.

You can now choose the custom colors the same way you would choose colors
from the Basic Colors palette.

Configuring Desktop Appearance

You can use the Desktop icon in Control Panel to configure the appearance of
your desktop.

[ Pattern

Hame: |!N one]

[ Applications
[ iFast “AjtsTab" Switching:

[ Screen Saver
Name: | Beziers
Delay: l3 E Minutes

[ Password protected

[ Wallpaper lcons
File: Spacing: Pixels
O Center @ Tile Wrap Title
" Sizing Gid— | [ Cursor Blink Rate
Granularity: E-g Slo Fast
Border Width: 3 [& ‘

Changing or Creating a Pattern

You can change a predefined desktop pattern, create a new pattern, or remove a
pattern.
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» To change an existing pattern
1 1. In the Control Panel window, double-click the Desktop icon.
2. Choose the Edit Pattern button.

Sample

\ Click areas in the cell where you
want to reverse the color.

3. In the Name list, select a pattern.

A sample of the current pattern appears in the Sample box. The cell shows an
enlarged version so you can make changes to the pattern.

4. In the cell, click locations where you want to reverse the colors in the pattern.
5. When the Sample box shows the pattern you want, choose the Change button.
6. Choose the OK button to return to the Desktop dialog box.

» To create a pattern

1. In the Name box of the Edit Pattern dialog box, type a name for the new
pattern.

2. Click locations in the cell where you want to reverse the colors in the pattern.
3. When the cell shows the pattern you want, choose the Add button.
4. Choose the OK button to return to the Desktop dialog box.

The pattern you define is repeated as many times as necessary to completely fill
the background. The colors of the pattern are determined by the Desktop and
Window Text colors you choose.

If you find that you use only one or two patterns, you can select patterns you no
longer use and choose the Remove button in the Edit Pattern dialog box.
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Displaying Custom Wallpaper

You can display a .BMP bitmap graphic on your desktop instead of a solid color
or pattern. Paint programs that produce .BMP files, such as Windows Paintbrush,
can be used to create a bitmap or to modify a scanned image. After you create the
bitmap, save the .BMP file in the \WINNT directory (or specify the full path when
choosing the bitmap as wallpaper).

Note Windows uses more memory when displaying wallpaper than when
displaying a solid color or a pattern on the desktop. If you run out of memory
when running an application, you can change to a color or pattern to free some
memory.

To choose a bitmap to display as wallpaper
1. In the Control Panel window, double-click the Desktop icon.
2. In the File box under Wallpaper, select a bitmap from the list.

If you saved the bitmap in a directory other than the Windows NT directory,
type the full path and bitmap filename.

3. Select Center or Tile.

The Center option positions the bitmap in the center of the desktop. The Tile
option repeats the bitmap as many times as necessary to cover the desktop.

If you select both a pattern and custom wallpaper in the Desktop dialog box, the
wallpaper lies over the pattern. If you select the Center option for the wallpaper
and the bitmap doesn’t cover the entire desktop, you’ll see the pattern around the
edges of the bitmap. If the original bitmap is too large to fit on the screen or takes
up too much memory, Windows NT does not display it.

If you want to remove a wallpaper from the list, delete the bitmap file from the
\WINNT directory.

Preventing Icon Titles from Overlapping

Sometimes an icon’s title is so wide that it overlaps an adjacent icon. You can use
the Desktop icon to control the display of icon titles.

Windows NT calculates the standard spacing for application, document, and
program-item icons based on the size of the widest icon. Usually this spacing is
adequate. However, sometimes the description for an icon exceeds the icon’s
width, causing it to overlap adjacent icons.

Icon spacing is measured in pixels, the smallest unit of measurement on the
screen. Increments of 10 pixels result in noticeable increases in spacing between
icons.
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» To increase icon spacing and wrap an icon title

1. Under Icons in the Desktop dialog box, click the up or down arrow in the
Spacing box to increase or decrease the spacing between icons, or type a
number.

2. Select the Wrap Title check box if you want the title to wrap.

Changing Window Border Width

Many windows can be resized by using the mouse to drag the window border to a
new size. If a window can be resized, you can make it easier to “grab” the
window border by increasing the border width.

To change the border width of windows

e Under the Sizing Grid in the Desktop dialog box, click the up or down arrow
in the Border Width box to increase or decrease the border width. Or type a
number from 1 to 50, with 1 being the narrowest border.

Changing the Sizing Grid of Windows

The position and alignment of application windows and icons on your desktop are
determined by an invisible grid. When Windows NT is set up, the sizing grid is
turned off so that icons and windows remain where you place them on the
desktop. When the sizing grid is turned on, application windows and minimized
icons align with the nearest invisible gridline.

The grid changes in multiples of 8 pixels. A value of 1 creates a grid with 8 pixels
between gridlines, a value of 2 creates a grid with 16 pixels between gridlines,
and so forth. A value of O cancels the grid.

This option only affects application windows and the application icons that appear
at the bottom of your screen. The sizing grid has no effect on document windows
and icons.

» To set the grid spacing

e Under the Sizing Grid in the Desktop dialog box, click the up or down arrow
in the Granularity box to increase or decrease the size of the grid, or type a
number from O to 49.
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Switching Between Applications

Windows NT allows you to run multiple applications at one time. However, when
doing this, it is sometimes difficult to locate a specific application window. You
can use fast application switching to switch between your applications.

» To use fast application switching
1. In the Control Panel window, choose the Desktop icon.

2. In the Desktop dialog box, select the Fast Alt+Tab Switching check box, and
then choose the OK button.

If Fast Task Switch is selected, you can quickly cycle through the names of the
applications running at that time. If Fast Task Switch is not selected, pressing
ALT+TAB still works, but only the title bar of each window is highlighted.

3. Press ALT+TAB to cycle through the running applications. When you see the
name of the application you want, release the keys.

If, while moving through the applications by pressing ALT+TAB, you want to
return to your original application, press ALT+TAB+ESC.

Working with Screen Savers

Screen savers are used to reduce wear on your display and to provide security for
your system. A screen saver is a moving pattern or bitmap that appears after you
have not used your computer for a specified time.

When Windows NT is set up, a default screen saver is selected. However, several
other screen savers are available. Move the mouse or press any key to turn off the
screen saver.

You can use the Windows NT screen savers or the IdleWild screen savers
included in the Microsoft Entertainment Pack for Windows. To use the IdleWild
screen savers, the IWLIB.DLL file and the screen saver files (those with the
extension .IW) must be in the same directory. Place these files in your \WINNT
directory.

When you use a screen saver provided by Windows NT, you can ensure that
unauthorized users do not have access to your work by using password protection
with a screen saver. If someone tries to use your computer once the password-
protected screen saver is displayed, a Lock Workstation dialog box appears. To
unlock the computer, the same password used to log on to the computer must be
entered.
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» To select a screen saver and turn password protection on and off

1. Under Screen Saver in the Desktop dialog box, select a screen saver in the
Names box.

2. In the Delay box, click the up or down arrow to increase or decrease the
number of minutes before the screen saver is activated, or type a number
between 1 and 99.

3. If you want to protect your display with a password, select the Password
Protect check box.

4. To configure your screen saver, choose the Setup button, and then complete
the setup dialog box that appears.

5. To see how your screen saver looks, choose the Test button, and then move the
mouse or press a key on the keyboard to stop the screen saver.

Setting Serial Port Communications Options

You can specify the communications settings for each serial port your system uses
by using the Ports option. Windows NT can support up to 256 serial ports. Serial
ports (named COMI1 through COM256) are used to connect to serial pointing
devices, printers, and other serial devices. Most computers include at least two
serial ports: COM1 and COM2. Some devices, such as serial-port adapters,
modems, and fax cards, use COM3 through COM256. The settings you specify
determine how information is transferred between your computer and the serial
device.

The communications settings you can specify include standard settings such as
those for baud rate, parity, and flow control, and more advanced settings such as
those that specify the base port address and interrupt request (IRQ) line that
Windows NT uses to send information to a serial port. If you plan on using only
COMI1 and COM2, you may only need to change the standard settings. If you use
COM3 through COM256, you may need to change the advanced settings.

Most communications applications that you use to exchange information between
computers, such as Windows Terminal, require that you specify standard port
settings within the application. These settings, such as baud rate, parity, and data
bits, override the settings you specify by using the Ports option in Control Panel.

» To specify standard communications settings

1. In the Control Panel window, choose the Ports icon.

2. In the Ports dialog box, select the name of the port for which you want to
specify communications settings.

3. Choose the Settings button.

4. In the Settings dialog box, display the options for each setting by clicking the
scroll arrow to the right of each box.
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5. Set the options to match the device connected to the port.

For information about the correct settings, see the documentation supplied
with the device.

6. When you finish specifying the settings, choose the OK button to return to the
Ports dialog box, and then choose the Close button.

For additional help on setting Advanced Options, see the online Help in the Ports
dialog box.

Working with Fonts

A font, or typeface, is a collection of letters, numerals, symbols, and punctuation
marks that have common characteristics. Fonts come in different sizes and styles.
Font sizes are the height of a character measured in points—a point is
approximately 1/72 of an inch. Font styles include characteristics such as bold and
italic. Because of the differences in display resolution between the screen and the
printer, what appears on screen and what appears in the printed document may be
different.

If you use TrueType fonts in your documents, Windows NT and all Windows
applications display the fonts on the screen exactly as they appear when printed,;
there is no need to install matching screen fonts. In addition, by using TrueType
fonts, your documents become more portable because they look the same printed
on different printers, as long as you use the same application and print at the same
resolution. If you print at a different resolution or are printing a document from an
older application, line and page breaks might change.

Adding Screen Fonts and TrueType Fonts

When you install a printer driver, screen fonts that match the printer fonts are
usually installed. If you are using cartridge or soft fonts, your font manufacturer
usually supplies an installation program for installing screen fonts; or the
installation program that installs the cartridge or soft fonts may install the screen
fonts automatically.

If no installation program is provided for installing screen fonts, you can use the
Fonts option to install them. You can also use the Fonts option to install any
additional TrueType fonts that you purchase.
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» To add a font
% 1. In the Control Panel window, choose the Fonts icon.

Installed Fonts:

Arial Bold [TrueType]
Arial Bold Italic [TrueType)
Arial Italic [TrueType)

Arial Narrow [TrueType)
Arial Narrow Bold (TrueType)

Sample

AaBbCcXxYyZz 123

displayed on the screen and printed on your printer.

This is a scalable TrueType font which can be

Size of Font on Disk: 67 KB

The Fonts dialog box lists all the installed fonts and the font type (for example,
TrueType) displayed in parentheses.

The Sample box displays the selected font in all available sizes unless the font
is a vector font or a TrueType font. Vector fonts can be scaled to any height,
so the only size displayed is the size used to design the font. TrueType fonts
can also be scaled to any height and are displayed in about 24-point size.

2. In the Fonts dialog box, choose the Add button.

List of Fonts:
Arnal [TrueType)

Arnial Bold (TrueType)

Arial Bold ltalic [TrueType)
Anal Italic (TrueType)
Courier 10.12,15 (8514/a res)
Courier 10.12,15 [VGA res)
Courier New [TrueType]
Courier New Bold [TrueType)

Directories:
c:\winnt\system32 Drives:

[= winnt c:
,

£ drivers
£ os2
Q repl | ﬁ LCopy Fonts to Windows Directory

3. In the Directories and Drives boxes of the Add Fonts dialog box, select the
drive and directory that contains the fonts you want to add.
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4. In the List Of Fonts box, select the fonts you want to add. Click the fonts while

pressing CTRL to select a nonconsecutive list of fonts in the box.
To add every font in the list, choose the Select All button.

. If you have limited disk space, you can clear the Copy Fonts To Windows NT

Directory check box. You can then use the fonts directly from the directory in
which they are located, without copying them to your \WINNT\SYSTEM32
directory.

Choose the OK button to add the selected fonts, and then choose the Close
button.

Removing a Font

The fonts installed in Windows NT occupy memory. If you don’t use all the fonts
you have installed, you can remove them from your system and free memory for
use by your applications.

Important The MS Sans Serif font set is used by most Windows NT dialog boxes.
Do not remove this font; if you do, the text in the dialog boxes will be difficult to
read. Deleting a font on a particular computer removes that font for every user
who logs on that computer.

» To remove a font

1.

In the Installed Fonts list of the Fonts dialog box, select the fonts you want to
remove. Click the fonts while pressing CTRL to select a nonconsecutive list of
fonts in the box.

2. Choose the Remove button.

. If you want to delete the font files from your disk as well as remove the fonts

from memory, select the Delete Font File From Disk check box.

Caution It is recommended that you not delete fonts from the disk if you
chose not to copy the fonts to your \WINNT\SYSTEM32 directory. If you
delete the fonts from your hard disk, you must supply the original Windows
NT installation disks if you decide to add these fonts later.

. In the message that appears, choose the Yes button, or, if you are removing

several fonts at the same time, choose the Yes To All button.

. In the Fonts dialog box, choose the Close button.
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Working with Date, Time, and International Settings

The system date and time are used in some Windows applications and in various
places in Windows NT such as File Manager and Event Viewer. Before setting
the date and time on your system, you must be sure to set the correct time zone.
The way date and time are displayed can be specified through the International
option.

Configuring Date and Time

The system date and time are reflected in Clock and Calendar (two Windows NT
applications in the Accessories group), as well as in the information kept by File
Manager for each file you save on your disk.

Setting the System Date and Time

You need to set the date and time on your system after installing Windows NT.

To set the date and time

1. In the Control Panel window, choose the Date/Time icon.

Date: 2718793 E Time (Local): 11: 43: 13 AM lg

Time Zone: [[157

2| Automatically Adjust for Daylight Savings Time

Press OK when the comrect Date, Time and Time Zone are displayed.

2. In the Time Zone box, select the time zone for your area.

If your area uses daylight saving time, select the check box to automatically
adjust the time.

3. In the Date box, select the part of the date (day, month, or year) you want to
change, and then type the new value, or click the up or down arrow.

4. In the Time box, select the part of the time (hour, minute, second, suffix) you
want to change, and then type the new value, or click the up or down arrow.

5. Choose the OK button.
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Changing the Date and Time Display

You can change the way the date is displayed in applications that have a date
function. For example, you can vary the order of the month, day, and year, or
change the punctuation used to separate parts of the date.

To change the date format
1. In the Control Panel window, choose the International icon.

2. Under Date Format in the International dialog box, choose the Change button.

" Short Date Formal
Order:

Separator:

[] Day Leading Zero (07 vs. 7)
O Month Leading Zero [02 vs. 2]
[] Century (1990 vs. 90)

O DMY O YMD

 Long Date Format
Order: @ MDY O DMY O YMD

[Sunday [®][ |[March  [3][ [os[E][.  |[1992[3]

Sunday, March 05, 1992

3. In the International - Date Format dialog box, set the options you want for
both the Short Date Format and Long Date Format.

The Short Date Format displays the date as three numbers representing the
month, day, and year. You can specify the order and number of digits for each
part of the date. For example, selecting Century displays the year as a four-
digit number.

The Long Date Format displays the date as a combination of words and
numbers (for example, Monday, October 19, 1992) or a variation you specify.

4. Choose the OK button to return to the International dialog box.

You can also specify how the time is displayed in applications. For example, you
can display the time in a 12-hour or 24-hour format, change the punctuation
between the hour, minute, and second, or add suffixes to the time, such as A.M. for
morning or PST for Pacific Standard Time.
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» To change the time format

1. Under Time Format in the International dialog box, choose the Change button.

B
I

our 12:00-23:59

Separator: D
Leading Zero: ® 9:15 O 09:15

\- Suffixes can only be added to the
12-hour format, they are not visible
in the 24-hour format.

2. Set the options you want, and then choose the OK button to return to the
International dialog box.

Working with Other International Settings

With the International option, you can specify basic international settings such as
the country, language, and system of measurement you want to use. When you
select a country, Windows NT automatically adjusts other formats to reflect those
used by the selected country. You can also customize these settings.

» To select international settings

1. In the Control Panel window, double-click the International icon.

LCountry:

Language: fEninsh [American]

Keyboard Layout: IUS English

= & E

Measurement: | English

List Separator: l:l

Date Format [ Currency Format
12722492 Change... $1.22
Tuesday. December 22, 1992 -$1.22

4:33:37 PM 1.234.22

l’lime Format " Number Format
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2. In the International dialog box, specify the settings for Country, Language,
Keyboard Layout, Measurement, and List Separator.

A description of each option follows this procedure.

3. Choose the appropriate Change button to customize settings for Date and Time
Format as specified in the preceding section.

4. Choose the Change button under Currency Format.

In the International - Currency Format dialog box, you can control the way
currency is represented. For example, you can place the currency symbol in
different locations relative to the amount, specify how negative currency
values are represented, or change the currency symbol for your country.

5. Set the options you want, and then choose the OK button to return to the
International dialog box.

6. Choose the Change button under Number Format.

In the International - Number Format dialog box, you can control the way
numbers are displayed. For example, you can choose the punctuation
separating thousands and punctuation separating the fractional part of a
decimal number, or change the decimal display of numbers.

7. Set the options you want, and then choose the OK button to return to the
International dialog box.

Use this option

To

Country

Language

Keyboard Layout

Measurement

List Separator

Specify the country with the standard settings you want to use.
When you select a country, Windows NT automatically adjusts
the settings for the date, time, number, and currency formats, as
well as the Paper Size option in the Print Setup dialog box, to
match the standard formats used by that country.

Specify the language you want to work in. The language you
select affects the way applications sort information and provides
ANSI code page, OEM code page, and OEM font information.
For example, if the language you are working in includes
extended characters, setting this option to that language ensures
that your applications will correctly sort words or phrases that
include these characters.

Specify the keyboard layout of your computer. Keyboard layouts
vary to accommodate the special characters and symbols used in
different languages. Windows NT uses this setting to interpret the
keys you press.

Select the metric or English system of measurement.

Specify a symbol to separate elements in a list. In English, the list
separator is typically a comma and is used to separate words or
numbers that appear in a series.
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Customizing the Keyboard, Cursor, and Mouse

You may have personal preferences about how your cursor, keyboard, mouse, or
other pointing device works. For example, you may want the mouse pointer to
move rapidly, the keyboard to repeat rapidly when you hold down a key, or the
cursor to blink more slowly. You can use Control Panel to customize several

options.

Choose To

Keyboard Adjust the keyboard speed.

Desktop Adjust the cursor blink rate.

Cursors Change the cursor appearance.

Mouse Adjust the speed of the pointer, set the double-click speed, swap

the functions of the left and right mouse buttons, and set any
options specific to the mouse you are using.

Adjusting the Keyboard Delay and Repeat Rate

You can adjust how long your computer waits after you hold down a key before it
repeats that key, and then how fast the key repeats when you hold it down.

» To change the keyboard delay and repeat rate

1. In the Control Panel window, choose the Keyboard icon.

" Keyboard Speed
Delay Before First Repeat
Long

k3:

Repeat Rate
Slow

2. Under Delay Before First Repeat, drag the scroll box toward Long or Short to
increase or decrease the delay. Or click the appropriate scroll arrow.

3. Under Repeat Rate, drag the scroll box toward Fast or Slow to increase or
decrease the repeat rate. Or click the appropriate scroll arrow.

4. To test the speed, move to the Test box and type or hold down any key on the
keyboard. Adjust the box positions until you reach a delay speed and repeat
rate you are comfortable with.

5. Choose the OK button.
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Adjusting the Cursor Blink Rate

You can adjust how fast the cursor blinks.

» To change the cursor blink rate

1. In the Control Panel window, choose the Desktop icon.

Sizing Grid—— ] [ Curszor Blink Rate
Granularity: [0 [ | |Siow Fast

Border Width: g = 1 e

2. Under Cursor Blink Rate, drag the scroll box toward Fast or Slow or click the
appropriate scroll arrow.

3. Choose the OK button.

Changing the Cursor Appearance

You can change the look of your cursor with animated or static cursors provided
by Windows NT.

» To change your cursor

1. In the Control Panel window, choose the Cursors icon.

System Cursors:

Wait

%E Application Starting

®Nn

I I-Beam

2. In the Cursors dialog box, select an action whose cursor you want to change.
3. Choose the Browse button.

4. In the Directories and Drives boxes of the Browse dialog box, select the drive
and directory that contains the cursor files you want to view.

5. In the File Name box, select a file.

An example of what the cursor looks like appears in the Preview Window.
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6. Choose the OK button to return to the Cursors dialog box.
7. Change the cursors for any other actions and then choose the OK button.

8. To reset the selected action to the system default cursor, choose the Set
Default button.

Customizing Your Mouse or Other Pointing Device

You can adjust the way Windows NT works with your mouse or other pointing
devices. For example, if you are using a mouse, you may be able to switch the
functions of the left and right buttons, change the speed of the mouse pointer, or
change the double-click rate.

Before customizing settings for your pointing device, you need to install it and its
driver, using Windows NT Setup. For information, see Chapter 12, “System
Maintenance with Windows NT Setup.”

" Mouse Tracking Speed ™ |
Slow Fast

e L]
B

| Swap Left/Right Buttons

» To customize your pointing device
@ 1. In the Control Panel window, choose the icon for your pointing device.
A dialog box appears for the device you are using.
2. Set the options you want, and then choose the OK button.

For details about the options and their settings, see the documentation for your
pointing device and Help, if available.
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Working with Printers

(=

The Printers option in Control Panel opens Print Manager and allows you to work
with local and network printers. With Print Manager you can:

= Install local printers

= Set printer properties

= Connect to and share printers on a network

=  Remotely administer printers

For more information about Print Manager, see Chapter 6, “Print Manager.”

Working with Device Drivers

When you add a new device to your system, such as a new sound board or video
player, you need to install the driver that controls the device. A device driver is a
program that allows a specific piece of hardware (or device) to communicate with
Windows NT. Although the device may be installed in or connected to your
computer, Windows NT does not recognize the device until after you install and
configure the appropriate driver.

Installing and Configuring Drivers

Security

Most devices come with the appropriate driver. Windows NT also supplies sound
drivers for common sound devices, such as sound boards and synthesizers. If you
do not have a driver for your device, contact your device dealer or manufacturer
about providing one.

Installing a New Driver

To install kernel drivers (drivers that access hardware), you must be logged on as
a member of the Administrators group. The drivers you install will be available to
all users.

» To install a new driver

1. In the Control Panel window, choose the Drivers icon.

The Drivers dialog box displays a list of the drivers already installed.
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2. In the Drivers dialog box, choose the Add button.

List of Drivers

[MCI) CD Audio
[(MCI) Midi Sequencer

(MCI) Sound

Ad Lib

Creative Labs Sound Blaster 1.X

Low level Wave. MIDI and AUX support
Media Vision Thunder Board

MIDI Mapper

In the Add dialog box, select the driver you want to install from the list, or
select Unlisted or Updated Driver if your driver is not yet known to the
system, and then choose the OK button.

You will often get a message saying the driver is already present on your
system. If you don’t have a driver disk or a new driver somewhere else on
your system, you should select the Current button.

If a message asks you to insert the disk that contains the driver file, insert the
disk containing the driver you want to install into drive A. Or, if the driver is
located on your hard disk, type the drive and directory where the driver is
located.

If you do not know where the driver file is located, choose the Browse button
to locate and select the drive and directory that contain the driver file, but do
not type the filename for the driver.

If a setup dialog box appears, select the settings required by the driver, such as
the port address and interrupts for a sound board.

Important The settings you specify must not conflict with the settings used by
other devices installed on your system, such as a mouse or network card. For
example, the interrupts used by each device must be unique. You may get a
message about a configuration error having occurred if the hardware used by
the drivers you are installing or the options you have requested conflict with
the hardware or drivers already installed on your system.

To avoid conflicts, see the manuals for your other hardware devices to
determine the settings they use. Then see the manual that came with the device
you are configuring for information about its settings.

When you finish selecting the settings, choose the OK button.

Windows NT installs any additional related drivers automatically. These
drivers may also require specific settings. In this case, other setup dialog boxes
may appear.
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7. Repeat steps 6 and 7 until all related drivers have been configured.

The new driver and any changed driver settings do not take effect until you
restart Windows NT. A message asks you if you want to restart Windows NT.

8. To have the new driver take effect immediately, choose the Restart Now
button.

Installing a Driver Not Supplied with Windows NT

When you purchase a new device, such as a sound board, the associated driver
should be included with the device. If you do not have a driver for your device,
contact the device manufacturer or dealer to get one. Follow any instructions the
manufacturer provides for installing the driver.

Note Most drivers written for Windows 3.1 cannot be installed. Drivers should be
written specifically for Windows NT. If a driver can’t be installed, a message
indicating the problem will be displayed.

Setting Driver Options

After you have installed a driver, you can change any of its settings. If you want
to use more than one set of settings for the same driver, you need to install that
driver twice. For instructions on how to install a driver, see “Installing and
Configuring Drivers” earlier in this section.

To adjust driver settings
1. In the Control Panel window, choose the Drivers icon.

2. In the Installed Drivers list in the Drivers dialog box, select the driver you
want to configure.

3. Choose the Setup button.

Some drivers do not require specific settings. If you select such a driver, the
Setup button is unavailable.

The Setup dialog box appears. The options in this dialog box vary according to
the driver you are configuring.

4. Set the options as described in the manual for your device.
5. Choose the OK button.

The changes you make do not take effect until you restart Windows NT. A
message asks if you want to restart Windows NT.

6. To have the new settings take effect immediately, choose the Restart Now
button.
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Security

Removing a Driver

You need to be logged on as a member of the Administrators group to remove
some drivers.

If you are no longer using a device, you can remove its driver from the Drivers
list. Removing a driver from the Drivers list does not remove the driver file from
your hard disk. If you need to use the same device later, you can add its driver
again.

Caution The drivers that are automatically installed while running Setup are
required by your system (these are the drivers that are displayed when you first
open the Drivers dialog box). If you remove one of these drivers, your system
may not work properly.

To remove a driver
1. In the Control Panel window, choose the Drivers icon.

2. From the list of installed drivers in the Drivers dialog box, select the driver
you want to remove.

W

Choose the Remove button.

4. When the message asks you to confirm your decision to remove the driver,
choose the Yes button.

A message asks if you want to restart Windows NT.

5. To have the removal take effect immediately, choose the Restart Now button.

Using Audio and MIDI Sounds in Windows NT

The Sound icon provides several options for controlling audio sound in Windows
NT. To use audio sounds, you need to install a sound card and a sound driver, and
then choose the Sound icon to assign different sounds to system and application
events.

The Musical Instrument Digital Interface (MIDI) Mapper provides options for
setting up and playing MIDI sound in Windows NT. To use MIDI sounds, you
need a sound device such as a synthesizer and MIDI device drivers. Windows NT
supports two different standards, the General MIDI guidelines and the Microsoft
authoring guidelines for MIDI files (for playing MIDI information generated by
an application or stored in a MIDI file).

The information in this section is intended only as a general guide. For more
specific help, see the documentation for the sound device you install.



Chapter 5 Control Panel 133

Assigning Sounds to Events

With the Sound option, you can assign sounds to different application and system
events. For example, you can select a sound to play whenever you start Windows
NT. Other sounds play as specified by the application you are using. For example,
some applications play the sound assigned to Default Beep whenever you click
the mouse outside of an open dialog box. The sounds you can assign to these
events are stored in files with the .WAYV filename extension.

To use sound in Windows NT, the sound driver that controls your sound board
must be installed and configured for your system. If you do not have a sound
board or if the sound driver is not configured properly, you hear a warning beep
when an error occurs. Windows NT does not support playing a waveform sound
through the PC speaker; therefore, if you do not have sound hardware, the sound
dialog boxes will appear dimmed.

To assign sounds to events

1. In the Control Panel window, choose the Sound icon.

<none>
chimes.wav
5
AL
ding. wav
tada. wav

Default Beep
E xclamation
Windows Logoff
Critical Stop
Question
windows Logon

] Enable System Sounds cint

2. From the Events box in the Sound dialog box, select the event that you want to
assign a sound to.

If a sound file is already assigned to that event, it is selected in the Files box.
Otherwise, “none” is selected.

3. In the Files box, select the sound file you want to use. If the file you want is
not listed, select the drive and directory where the file is located by scrolling in
the Files dialog box, and then select the file.

If you don’t want to assign a sound to the selected event, select “none.”
4. To hear the sound, choose the Test button or choose the event or filename.

5. Repeat steps 2 through 4 until you have assigned a sound to each event you
want.

6. Select the Enable System Sounds check box.
7. Choose the OK button.
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You can turn the warning beep and all other sounds off by clearing the Enable
System Sounds check box and assigning “none” to Windows Start and Windows
Exit.

Changing MIDI Settings

Caution To use MIDI Mapper, you should have a basic understanding of MIDI
concepts and terminology. It is recommended that you not use MIDI Mapper to
edit or create MIDI setups unless you are experienced with MIDI and understand
the results of the changes you make.

If you are using a sound device such as a synthesizer that has MIDI capabilities,
you can specify MIDI settings for the setups, patch maps, and key maps.

O Patch Maps 9] Key Maps

Name: [Ad Lib 2 j

Description: Base-level setup

For additional help on the MIDI Mapper, see the documentation for the sound
device you are installing, or see the online Help in the MIDI Mapper dialog box.
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Configuring the Network

You can use the Network option in Control Panel to make changes in your
computer’s network configuration. For example, if you add a new adapter card to
your computer after installing Windows NT, you need to specify the network
device drivers and supporting software that Windows NT needs to work with
network adapter cards. You can also use the Network option to join a workgroup
or domain, configure network bindings, and set network provider search order.

Security To make changes in the Network Settings dialog box, you must be logged on as a
member of the Administrators group for your computer.

» To use the Network option

% e Choose the Network icon in Control Panel.

Computer Name: terrier

Workgroup: Scottie

Installed Network Software:

" Metwork Software and Adapter Cards

MetBl0S Interface

MNetBEUI Protocal
“Workstation

Server
3Com Etherlink || &dapter Driver

Installed Adapter Cards:

Description: |3Com Etherlink 1l Adapter j

The following table summarizes the buttons in the Network Settings dialog box.

Choose

To

Change (Computer name)

Change (Domain or
Workgroup)

Add Software

Change the computer name for this computer.

Display a dialog box for joining a workgroup or domain.
This button is never available if the current computer is a
domain controller in a Windows NT Advanced Server
network.

Display one or more dialog boxes for installing a network
software component.
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Choose To

Add Adapter Display one or more dialog boxes for installing a network
adapter card.

Configure Display one or more dialog boxes for configuring the
selected network software component or adapter card.

Update Display one or more dialog boxes for updating a network
software component or adapter card.

Remove Remove a selected network software component or adapter
card.

Bindings Display a dialog box for adding and removing bindings for

network components.

Networks Display a dialog box for setting network search order
if your computer is connected to more than one kind of
network provider.

Changing the Computer name

You can change the computer name for the current computer in the Network
Settings dialog box.

» To change the computer name

1. In the Network Settings dialog box, choose the Change button next to the
computer name.

Computer Name: |a-anniepl

2. In the Computer Name dialog box, type a unique name for this computer, and
then choose the OK button.

Caution If you change the computer name for a computer that participates in a
Windows NT Advanced Server domain, that computer name must have an
account in the domain. If the computer does not have an account, you will not be
able to log on to the domain or access any domain user accounts (including your
own account). Check with your network administrator to ensure that you specify a
correct computer name and that the computer has an account on the domain.
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Installing Network Adapter Cards

To communicate over the network, a computer must have a network adapter card
installed. Windows NT uses a network device driver, which is software that
coordinates communication between the adapter card and the computer’s
hardware and other software, controlling the physical function of the network
adapter cards.

During the initial installation of Windows NT, you have the opportunity to install
at least one network card. To add or change network adapter cards to your
computer after installation, you must choose the Network icon in Control Panel.

» To install one or more network adapter cards
1. In the Network Settings dialog box, choose the Add Adapter button.

2. In the Add Network Adapter dialog box, select the name of the adapter card
that is installed in your computer, and then choose the Continue button.

If you have a disk with software from a vendor, select Other.

3. When Setup asks for a disk, insert the disk in the drive, or type the path of the
driver if the file is located on your hard disk or on a network drive. Then
choose the OK button.

You may be asked to insert additional disks if more than one disk was
provided by the hardware manufacturer. You may also be asked for specific
Windows NT installation disks.

4. When you complete all your changes and close the Network Settings dialog
box, a message asks if you want to restart your computer for the changes to
take effect. To restart your computer immediately, choose the Yes button.

Installing Network Software

Windows NT also uses network software (or protocol) drivers that bind to the
adapter card driver. You can also add supporting software for network
components in the Network Settings dialog box.

» To install network software
1. In the Network Settings dialog box, choose the Add Software button.

2. In the Add Network Software dialog box, select the software component you
want to install, and then choose the Continue button.

If you have a disk with software from a vendor, select Other.

3. When Setup asks for a disk, insert the disk in the drive. Or type the path of the
software component if the file is located on your hard disk or on a network
drive. Then choose the OK button.
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You may be asked for additional disks if more than one disk was provided by
the hardware manufacturer. You might also be asked for specific Windows NT
installation disks.

When you complete all your changes and close the Network Settings dialog
box, a message asks if you want to restart your computer for the changes to
take effect. To restart your computer immediately, choose the Yes button.

Updating or Removing Network Components

You can either update or remove the configuration information for an installed
network software component or adapter card.

» To update a network component

1.

In the Network Settings dialog box, select the component you want to update
in the Installed Network Software box or the Installed Adapter Cards box.

2. Choose the Update button.

. Complete the dialog boxes that appear.

You will be asked to insert disks from the manufacturer that contain the
updated driver information for the selected component.

When you remove a network component, the information is removed from your
system configuration. The related software remains on your hard disk.

» To remove a network component

1.

In the Network Settings dialog box, select the component you want to remove
in the Installed Network Software box or the Installed Adapter Cards box.

Choose the Remove button.

. Complete the dialog boxes that appear.

The dialog box for removing the component is supplied by the manufacturer.
Choose the Help button in the dialog box for more information.

For your changes to take effect, you must restart your computer.

Configuring Network Software and Adapter Cards

Many adapter cards and their supporting software can be configured to achieve
the best performance on your system. You can set the appropriate configuration
for your network components in the Network Settings dialog box.

The dialog boxes for configuring your adapter and software are supplied by the
manufacturer. Most of these dialog boxes contain a Help button to guide you
through making choices for optimal settings. For additional information, refer to
the documentation for your network adapter card or software.
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» To configure network software or an adapter card

1. In the Network Settings dialog box, select the name of the item you want to
configure in either the Installed Network Software box or Installed Adapter
Cards box.

Optionally, in the Description box, type text to describe the component, or
keep the description provided by the manufacturer. If you have multiple
adapter cards, consider including the slot number of the card in its description.

2. Choose the Configure button.

Windows NT displays a dialog box specifically for the selected component, as
provided by the component manufacturer.

For information about any items in the dialog box, choose the Help button.

3. Complete options in the dialog box to specify your choices, and then choose
the OK button.

For example, the following illustration shows a typical configuration dialog box
for a 3Com Etherlink II network adapter card.

These settings specify the interrupt number
and I/0 address jumper settings for the card.

R Leve = [3 3]
1/0 Port Address:

Transceiver Type
[ @® External > OnBoard

| Memory Mapped

t This setting specifies whether the
base address for the card's 1/O port
is mapped in the computer's memory.

In general, Windows NT networking software is self-configuring. However, you
might choose to minimize memory use or maximize throughput for optimal
software performance. You can also install and configure various network
protocol services. To communicate over a network, each computer must be
configured with at least one type of protocol driver (sometimes called a protocol).
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Choosing and Configuring Protocol Software

Protocol software works between the upper-level network software and the
network adapter card. The protocol packages data that is to be sent on the network
in a way that the computer on the receiving end can understand. Microsoft
provides three protocols for use with Windows NT: NetBEUI, TCP/IP, and Data

Link Control.

Protocol software Description

NetBEUI 3.0 (NetBIOS Extended A small, efficient, and fast protocol tuned for small

User Interface) LANSs. It is installed automatically when you install
Windows NT.

TCP/IP (Transmission Control Provides communication across wide area networks

Protocol/Internet Protocol) (WANSs) and routers.

Data Link Control Not designed to be a primary protocol for use

between PCs. It is useful if your computer needs to
access IBM mainframe computers or if you are
setting up a printer that attaches directly to the
network, instead of to a serial or parallel port on a
print server.

NetBEUI is the standard Windows networking protocol and is automatically
installed during Windows NT setup. If there are no wide area network (WAN)
links in the network, and if there is no need to connect to any devices other than
computers running Windows NT or other Windows operating systems, you do not
need to add any protocol software. If you need WAN internet capability, add
TCP/IP. With both protocols supported, you can benefit from NetBEUI
performance when connecting to local computers and you can still connect over
WAN:S to other networks.

To install other protocols included with Windows NT, choose the Add Software
button in the Network Settings dialog box. All adapter card drivers that come with
Windows NT can use any of the included protocols.

When you install Windows NT on a computer (and when you install additional
protocols or network adapter cards), Windows NT automatically assigns LAN
adapter (Lana) numbers to protocol/network adapter card bindings. You need to
change a LAN adapter number only if you have a NetBIOS application that
specifies that it must use a certain LAN adapter number.

» To set LAN adapter numbers for special applications

1. In the Network Settings dialog box, select NetBIOS Interface in the Installed
Network Software box.

2. Choose the Configure button.
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3. In the Network Route box, select the protocol whose LAN adapter number you
need to change and then type in a new number in the Lana Number box.

4. Complete options in the dialog box to specify your choices, and then choose
the OK button.

Joining a Workgroup or Domain

You can assign the workgroup for the current computer, such as the workgroup
created if you were previously using Windows for Workgroups. If the computer
will participate in a Windows NT Advanced Server domain, you can use the
Network Settings dialog box to join the domain.

In Windows NT, a workgroup is a collection of computers that appear, for
convenience, under the same workgroup name when you browse network
resources. Any computer can join any workgroup.

A domain is a collection of computers defined by the administrator of a Windows
NT Advanced Server network. A domain provides the same convenience for
network browsing and also provides access to the centralized user accounts and
group accounts maintained by the domain administrator.

Computer Hame: a-anniepl

" Member of:
O Workgroup: | I
® Domain: [DOMAIN |

[Domain Administrators Only)

Domain Administrator User Name: | —I

Domain Administrator Password: l

» To join a workgroup

1. In the Network Settings dialog box, choose the Change button next to the
current workgroup or domain name.

The Change button is unavailable if you previously changed the computer
name in the current session.

2. In the Domain Settings dialog box, select the Workgroup option, and then type
the name of the workgroup you want to the computer to join.

The workgroup name must not be the same as the computer name.
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3. Choose the OK button.

» To join a domain

Security

1. In the Network Settings dialog box, choose the Change button next to the
current domain or workgroup name.

The Change button is unavailable if you previously changed the computer
name in the current session.

2. In the Domain Settings dialog box, select the Domain option, and then type the
name of the domain you want the computer to join.

3. Choose the OK button.

Caution If you change the domain name, you will not be able to log on except
using local accounts until you specify a new domain where the computer has an
account. If you change the computer name but that computer does not have an
account in the domain, you will not be able to log on to the domain or access any
domain user accounts (including your own account).

If you are logged on as a domain administrator, you can automatically add an
account for the current computer when the computer joins the domain.

» To add a computer to a domain

1. In the Domain Settings dialog box, select the Domain option, and then type the
name of the domain you want the computer to join.

The computer name, as shown at the top of this dialog box, must be a unique
name in the domain.

2. Select the Create Computer Account In Domain check box.

3. In the appropriate boxes, type the username and password for your domain
administrator user account.

4. Choose the OK button.

Configuring Network Bindings

The network consists of a series of software layers, where software in each layer
performs specific functions for the layers above and below it. All network
software layers end at the network adapter card, which moves information
between computers. Each network component can be bound to one or more
network components above it or below it to make the component’s services
available to any other component that can benefit from them.
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By default, Windows NT maximally binds all network components to ensure that
they are fully utilized. If you rarely use a particular adapter card and want to
reduce the software loaded into memory, you can simply unbind (disconnect) that
network adapter card from all network components.

When you choose the Bindings button in the Network Settings dialog box to add
or remove bindings, the Network Bindings dialog box shows the bindings of
network components as a series of bound paths, from the upper layer services and
protocols to the lowest layer of adapter-card device drivers.

This list shows the binding paths
that pass through the selected
component, or shows all binding
paths if All Components is selected.

Show Bindings for: < All Components > 7/ Lgl

<-- Upper Bindings Lower Bindings -->

L These icons indicate whether
the binding is currently enabled.

Caution Do not attempt to reconfigure binding settings unless you are an
experienced network administrator familiar with the requirements of your network
software.

» To view bindings for network components
1. In the Network Settings dialog box, choose the Bindings button.

2. In the Show Bindings For box of the Network Bindings dialog box, select one
or more components.

Or choose Select All Components to see a list of all bound components.
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» To enable or disable binding paths for selected network components

1. In the Network Bindings dialog box, select a binding path.
2. To enable the binding path, choose the Enable button.
To disable the binding path, choose the Disable button.

The icon next to the selected binding shows the current state of that binding
path.

3. Choose the OK button.

If you have more than one kind of protocol installed, you can set the order in
which workstation and NetBIOS software bind to each protocol. You might want
to change the binding order for one of the following reasons:

= If the protocol you use most frequently is first in the Binding list, average
connection time decreases.

=  Some protocols are faster than others for certain network topologies. Putting
the faster protocol first in the Bindings list improves performance.

» To change protocol binding order

1. In the Network Settings dialog box, choose the Bindings button.

2. In the Show Bindings For box of the Network Bindings dialog box, select All
Components.

3. Select the binding path to move up or down and use the protocol order buttons
to change the binding order.

4. Choose the OK button.

Configuring the Remote Procedure Call Service

Windows NT Setup automatically installs the files you need for the Remote
Procedure Call (RPC) service, a mechanism that enables programmers to easily
develop distributed applications. However, to use this functionality, you need to
specify the Name Service Interface (NSI) that the RPC service uses to
communicate with name service databases. Use the RPC Name Service Provider
Configuration dialog box to specify settings for the name service provider. To see
this dialog box, choose the Network icon in Control Panel, select RPC Name
Service Provider in the Network Software list, and then choose Configure.

To configure the name service provider, you must know what provider you want.
If you choose the DCE Cell Directory Service, you must also supply the network
address of the provider. The Windows NT Locator is the default name service that
is installed with Windows NT.
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Setting Network Provider Search Order

If you have more than one kind of network installed at your site, you can specify
the order in which Windows NT searches the various networks for certain
operations.

After you specify the network search order, Windows NT will always search in
that order. After Windows NT finds the specified server, directory, file, or other
item on one network, it does not continue to search the networks listed lower in
the search order.

» To set network provider search order

1. In the Network Settings dialog box, choose the Networks button. (This button
is dimmed if no other network providers are available.)

Access Networks in This Order:

Novell Netware 3.11
Banyan Vines 4.1

2. In the Access Networks In This Order box, select the name of the network
whose order you want to change, and then choose the Up or Down button to
move that network higher or lower in the search order.

3. Continue selecting network names to define the order until all networks are
listed in the order you want for searching, and then choose the OK button.
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Defining Options for the Operating System

You can have more than one operating system installed on your computer if you
want to use different operating systems at different times. Choose the System
option in Control Panel to specify the operating system that the boot loader will
use the next time you start your computer. You can also specify the user
environment variables and view or change the size of your computer’s virtual-
memory paging file by using the System option.

» To specify the default operating system for startup

1. In the Control Panel window, double-click the System icon.

The System dialog box shows the settings for the user whose profile is
currently active on this computer.

Computer Name:  anam-1

[~ Operating System
Startup: |"Window: NT" |§

Show list for seconds

System Environment Yariables:

ComSpec = %SystemB oot \systemcmd.exe
LibPath = Z5ystemB oot \spstem
MEer

Variable: |_ntdrive | e

Yalue: | c: |

2. In the Startup box, select the default operating system from the list of systems
installed on your computer.

This is the operating system that the boot loader will propose to start
automatically the next time you start your computer.

3. In the Show List For box, specify the number of seconds the list of choices
should be displayed before automatically starting the default operating system.

4. Choose the OK button.
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Defining an Alternate Startup Operating System

The method for adding an alternate startup operating system (other than versions
of Windows NT) depends on whether your computer is an x86-based or RISC-
based system. For systems with either kind of processor, Windows NT Setup
detects any operating systems present during the initial installation of

Windows NT, so that you can choose to keep or delete the alternate operating
systems. After you first install Windows NT, use one of the following methods to
add other operating systems:

= For a RISC-based computer, run the appropriate ARC setup program to install
the alternate operating system. Windows NT detects the new alternate
operating system automatically. All system startup information is stored in
non-volatile RAM.

=  For an x86-based computer, install the operating system in the usual way, then
edit the BOOT.INI file, which Windows NT automatically creates in the root
directory of the computer’s main hard disk. All system startup information is
stored in the BOOT.INI file.

When you edit the BOOT.INI file to define an alternate startup operating system
for an x86-based computer, use a non-formatting text editor such as Notepad to
add the name and location of the alternate system in the [operating systems]
section. The descriptive text you specify appears in the Startup box of the System
dialog box.

There are no rules for how you refer to each kind of operating system listed in
BOOT.INI, except that you must include the path that shows where the source
files for the operating system are stored. For example:

[operating systems]
c:\nt="Windows NT 3.1"
c:\dos="MS-DOS"

You cannot necessarily take advantage of the alternate startup option for all
operating systems that might be installed on an x86-based computer. Some
operating systems such as MS-DOS or OS/2 require certain files to be present in
the computer’s root directory, and Windows NT can provide the alternate startup
option for only one such root-based operating system on a computer. However,
you can specify alternate startup options for any number of Windows NT versions
or other non-root-based operating systems.
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Changing the Environment Variables

Windows NT requires certain information to find programs, to allocate memory
space for some programs to run, and to control the behavior of various programs.
This information —called the system and user environment variables— can be
viewed in the System dialog box. These environment variables are similar to
those that can be set in the MS-DOS operating system, such as PATH and TEMP.

The system environment variables are defined by Windows NT, and you cannot
add new variables or change the values.

The user environment variables include any environment variables you want to
define or variables defined by your applications, such as the path where
application files are located.

After you change any user environment variables in the System dialog box and
choose the OK button, Windows NT saves the new values in the registry so they
are available automatically the next time you start your computer.

If any conflict exists between environment variables, Windows NT resolves the
conflict in this way:

= System environment variables are set first.

= Variables defined in AUTOEXEC.BAT are set next.

= User environment variables defined in the System dialog box are set last.

This means, for example, that although you cannot change the values of a system
environment variable directly, you can overwrite it by creating a user environment
variable with a name that is identical to the name of the system environment
variable you want to overwrite.

Note Path settings, unlike other environmental variables, are cumulative. The full
path (what you see when you type path at the command prompt) is created by
appending the path contained in AUTOEXEC.BAT to the paths defined in the
System option of the Control Panel.

» To change user environment variables for your computer

1. In the Control Panel window, choose the System icon.

The System dialog box shows the current system environment variables and
the environment variables for the user whose profile is currently active on this
computer.

2. In the User Environment Variables box, select the variable you want to
change.
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The name of the selected variabie appears in the Variable box, and its current
value appears in the Value box.

You can also click the Variables box, and then type a variable name that does
not appear in the list. Variables that you add in this way are appended to the
list of environment variables for the current user profile.

3. In the Value box, type a new value for the variable.

4. To remove a variable completely, select it in the User Environment Variables
box, and then choose the Delete button.

5. When the Variable and Value boxes contain the new information you want to
specify, choose the Set button.

Choose the Cancel button at any time to remove all changes made in the
System dialog box and restore the previous values.

6. When you have completed all changes you want to make to environment
variables, choose the OK button.

Changes to these variables are stored immediately, but the changes won’t
affect programs that are already running when the changes are made. You
must restart your computer to see the effects of the changes while running, for
example, the command prompt.

Changing the Virtual-Memory Paging File

Security

Windows NT uses a special file on your hard disk called a virtual-memory paging
file (or swap file). With virtual memory under Windows NT, some of the program
code and other information are kept in RAM while other information is
temporarily swapped to virtual memory. When that information is required again,
Windows NT pulls it back into RAM and, if necessary, swaps other information
to virtual memory. This activity is invisible, although you might notice that your
hard disk is working. The resulting benefit is that you can run more programs at
one time than your system’s RAM would usually allow.

If you are logged on as a member of the Administrators group for a computer, you
can change the size of the virtual-memory paging file or create additional paging
files on other local hard drives.

A virtual-memory paging file is created automatically on your computer when
you install Windows NT. Usually, you should leave the paging file at its
recommended size for each drive. However, you might want to change the file
size if, for example, you frequently work with applications that require a large
amount of memory and that could therefore benefit from a larger paging file.
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Note The virtual-memory paging file is a file named PAGEFILE.SYS in your
system partition. You cannot delete this file while running Windows NT. If you
delete this file while running under another operating system, a new paging file is
created automatically the next time you start Windows NT.

The recommended size for the virtual-memory paging file, which Windows NT
identifies as the size that ensures the best performance, is equivalent to the
amount of RAM available on your system plus 12 MB. However, the size of the
file also depends on the amount of free space available on your hard disk when
the paging file is created. The minimum required size is 2 MB.

If you have multiple hard disks, you should consider creating a paging file for
each local hard drive on your computer. Depending on the capabilities of your
system’s hard disk controller, the disks can be reading or writing information
simultaneously, greatly improving performance. Also, because Windows NT
expands the paging file as necessary, multiple paging files make expansion easier,
since each file expands a little rather than a single file expanding a lot.

» To change the size of your system’s virtual-memory paging file

1. In the System dialog box, choose the Virtual Memory button.

Note If you are not logged on as a member of the Administrators group for a
computer, the Virtual Memory button is not available, so you cannot change
the size of your computer’s paging file.

2. In the Drive box of the Virtual Memory dialog box, select the drive for which
you want to change the paging file size.

Drive [Volume Label]

Paging File Size [MB]

 [ANAMYOL2]

" Paging File Size for Selected Drive
Drive: C:[ANAMYOL1]

Space Available: 25 MB
Initial Size [MB]: 20
Magimum Size [MB]:

[~ Total Paging File Size for All Drives
Minimum Allowed: 2MB

Recommended: 27 MB
Currently Allocated: 20 MB
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3. In each Paging File Size box, type a number in megabytes to specify the new
initial size or maximum size for the paging file, and then choose the Set
button.

For example, type 20 to create a 20 MB paging file.
4. Choose the OK button to return to the System dialog box.

You must restart your computer to see the effects of the changes.

Changing Application Response Time

By default, Windows NT gives priority to the application running in the
foreground of your display screen. This application receives more processor time
relative to other applications running in the background. (A foreground
application is the application running in the active window, topmost on your
screen.)

» To change the priority (response time) of a foreground application relative to
other running applications

1. Double-click the System icon in Control Panel.

2. In the System dialog box, choose the Tasking button.
3. In the Tasking dialog box, select one of the following options:
= Best Foreground Application Response Time (Default)
= Foreground Application more Responsive Than Background
= Foreground And Background Applications Equally Responsive

The first two options vary the degree of priority given to the foreground
application; the last button gives all applications an equal share of processing
time.

Setting Up the Uninterruptible Power Supply (UPS)

An uninterruptible power supply (UPS) is a battery-operated power supply
connected to a computer to keep the system running during a power failure. The
UPS service for Windows NT detects and warns users of power failures, and
manages a safe system shutdown when the backup power supply is about to fail.

Before purchasing a UPS device to use with Windows NT, confirm with the UPS
manufacturer that both the device and its serial cable are compatible with
Windows NT.
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You can use the UPS option in Control Panel to set various options for
configuring how UPS works on a computer, such as:

= The serial port where the UPS device is connected.

= Whether the UPS device sends a signal if the regular power supply fails.

= Whether the UPS device sends a warning when battery power is low.

= Whether the UPS service sends a signal telling the UPS device to shut off.
= A command file to execute at shutdown time.

= The expected life and recharge time for the battery.

= The timing for warning messages.

The actual options for configuring the UPS service depend on the specific UPS
hardware installed on your system. Incorrect settings can cause undesirable
operation of your UPS hardware. For details about possible settings, see the
documentation for your UPS device.

» To set up the UPS service for a computer
1. In Control Panel, double-click the UPS icon.

[ {Uininterruptibie Power Supply is instailed on:} [COM1:

~ UPS Configuration
UPS Interface Yoltages:

< Power failure signal @ Megative O Positive
O Low battery signal at least O] O
2 minutes before st
[J Remote UPS Shutd ® e O
- [0 Execute Command File
File Name: | |
UPS Characteristics ™| [ UPS Service

Expected Battery Life: [&] min | | Iime between power failure =
=P v m“ and initial warning message: EW sec

Battery recharge time = - Delay between warning I
per minute of run time: ml: min messages: E? sec

2. In the UPS dialog box, select or clear the Uninterruptible Power Supply Is
Installed On check box, and then specify the serial port where the UPS device
is connected.

You cannot select a serial port unless the Uninterruptible Power Supply Is
Installed On check box is selected.
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10.

. If the UPS device on your system can assert a main power failure indication,

select the Power Failure Signal check box.

This setting corresponds to the CTS pin for the UPS serial port connection.

. If the UPS device on your system can send a warning when battery power is

low, select the Low Battery Signal check box.
This setting corresponds to the DCD pin for the UPS serial port connection.

. If the UPS device can accept a signal from the UPS service telling it to shut

off, select the Remote UPS Shutdown check box.
This setting corresponds to the DTR pin for the UPS serial port connection.

. For each item that is checked in the UPS Configuration group, specify

Negative or Positive for the UPS Interface Voltage.

This setting defines how your UPS device expects to communicate with the
UPS service. For information about making this choice, see the documentation
for your UPS device.

Depending on what items you’ve checked in the UPS Configuration group,
steps 7 through 10 may or may not be necessary.

In the Expected Battery Life box, specify the time in minutes that the system
can run on battery power. Check the UPS device documentation for the
appropriate setting.

The range is 2 to 720 minutes; the default is 2 minutes.

. In the Battery Recharge Time box, specify the time in minutes that battery

must be recharged for every minute of run-time. Check the UPS device
documentation for the appropriate setting.

The range for is 1 to 250 minutes; the default is 100 minutes for each minute
of battery run-time.

In the Time Between Power Failure box, specity the time, in seconds, between
when a power failure occurs and when the first message is sent to notify users.

The range is 0 to 120 seconds; the default is 5 seconds.

In the Delay Between Warning Messages box, specify the interval, in seconds,
between messages sent to notify users of a power failure and to advise them to
stop using the computer.

The range is 5 to 300 seconds; the default is 120 seconds.
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11. Choose the OK button.

Depending on the changes you make in the UPS dialog box, a message asks if
you want to start, stop, or restart the UPS service, depending on whether it is
currently running. Choose Yes or No. If you choose Yes, Windows NT
configures the UPS service to begin automatically each time your system starts

up.
You can also start and stop the UPS service using the Services option in
Control Panel once the UPS is configured.

You can also configure the UPS option to execute a command file
immediately prior to system shutdown. For example, such a file might run a
command to close remote connections. This command file must execute within
30 seconds. Failure to complete execution in 30 seconds jeopardizes the safe
shutdown of your Windows NT computer.

» To set up the UPS service to execute a file prior to system shutdown

1. In the \WINNT\SYSTEM32 directory, create a command file with one of the
following file extensions: .BAT, .CMD, .EXE, or .COM.

2. In the UPS dialog box, type the name of the command file in the File Name
box.

3. Select the Execute Command File box.

Using UPS with Other System Services

The UPS service should be used in conjunction with the Windows NT Alerter,
Messenger, and Event Log services. This will ensure that events related to the
UPS service, such as a power failure or a UPS connection failure, are recorded in
the system log of Event Viewer and that designated users are notified of these
events over the network.

The Alerter and Messenger services must be started for a computer to generate a
UPS or other type of network alert. After setting up the UPS service on your
computer, use the Services tool in Control Panel to make sure the Alerter,
Messenger, and Event Log services are configured to start automatically. Use the
Server option in Control Panel to designate which users and computers will
receive alerts. The Messenger service must be started on computers that are to
receive UPS alerts and UPS warning messages.
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Testing Your UPS Configuration

After configuring UPS options, you or your system administrator should test that
your computer is protected from power failure.

» To test UPS configuration

1. Simulate a power failure by disconnecting the power to the UPS device. The
computer and peripherals connected to the UPS device should remain
operational and a warning message and/or alert should appear on the computer
screen.

2. Wait until the UPS battery reaches a low level. At that point system shutdown
should occur.

3. Restore power to the UPS device.

4. Check the system log in Event Viewer to ensure that all actions were logged
and that there were no errors.

If the UPS service is configured to run a command file, you should test that file
execution does not exceed the 30 second time limit.

» To test command file configuration

e Determine a worst case scenario. For example, if your command file starts up
a custom application to disconnect logon sessions to a remote computer, test
command file execution with a maximum number of logon sessions.

If you have problems running the UPS service, see the system log in Event
Viewer for event details related to UPS.
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Managing Server Properties

Use the Server option in Control Panel to display a summary of connections and
resource use for the computer; to edit the computer description; to view connected
users, shared resources, and open resources; and to manage directory replication
and the recipients of administrative alerts.

» To manage properties
% 1. In the Control Panel window, choose the Server icon.

Usage Summary

Sessions: 7 Open Files: 11 -

File Locks: 0 Open Named Pipes: 0

Description:
|Emest Aydelotte, building 7. room 822, ext. 777 —l

The Properties dialog box displays a usage summary for the computer.

Item Meaning

Sessions The number of users remotely connected to the computer
Open Files The number of shared resources opened on the computer
File Locks The number of file locks by open resources on the computer
Open Named Pipes The number of named pipes opened on the computer

2. To change the computer description, type new text in the Description box.

3. To administer a property associated with one of the five buttons at the bottom
of the Properties dialog box, choose a button and complete the dialog box that
appears. These buttons and their associated dialog boxes are described in
procedures following this one.
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Choose

To

Users

Shares

In Use

Replication
Alerts

View all the users connected over the network to the
computer and the resources opened by a selected user. One
or all of the connected users can be disconnected.

View the computer’s shared resources and the users
connected over the network to a selected resource. One or
all of the connected users can be disconnected. (To create
and manage shares, use File Manager.)

View the open shared resources on the computer. One
resource or all resources can be closed.

Manage directory replication for the computer.

View and manage the list of users and computers that are
notified when administrative alerts occur on the computer.

4. To exit, choose the OK button.

Viewing User Sessions

Use the User Sessions dialog box to view all the users connected over the network
to the computer, and the resources opened by a selected user.

One or all of the connected users can be disconnected. There are several reasons
to do this. For example, you might be about to stop the Server service on the
computer, or you might be about to shut down the computer. To avoid data loss,
always warn users before disconnecting them.

» To view users connected over the network to the computer

1. In the Control Panel window, choose the Server icon.

2. In the Properties dialog box, choose the Users button.

Connected Users: 7

Connected Users Computer Opens Time
ﬁ DOMALEEE DOMALEEE 0 00:31
€ ERNESTA

ERNESTAT 2 00:59

FFHO
RN

Resource Opens Time
=1 BUDGET 2 01:09
&1 EXPORT 0 00:29
&1 MONITOR il 01:10
&1 SCHEDULE 1 01:09

_Disconnect All_
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In the User Sessions dialog box, the Connected Users box lists the users
remotely connected to the computer.

Item Meaning

Connected Users The user name of a connected user

Computer The computer name of the computer where the user is
logged on

Opens The number of resources opened on the computer by the
user

Time The hours and minutes that have elapsed since this session

was established

Idle The hours and minutes that have elapsed since the user last
initiated an action

Guest Whether this user has guest status on the computer

Below the Connected Users box, the Connected Users summary shows the
number of users remotely connected to the computer.

3. To view the resources used by a user, select a user name from the Connected
Users box. The Resource box lists the shared resources that user is connected

to.

Item Meaning

Resource The name of a shared resource the selected user is connected
to. This could be a shared directory, named pipe, or printer.

Opens The number of opens against this resource by this user.

Time The hours and minutes that have elapsed since this resource

was first opened.

4. To disconnect one user from the computer, select the user name from the
Connected Users box and then choose the Disconnect button: to disconnect all
users from the computer, choose the Disconnect All button.

Warn users before disconnecting them.

5. To exit, in the User Sessions dialog box choose the Close button, and then in
the Properties dialog box choose the OK button.

Viewing Shared Resources

Use the Shared Resources dialog box to view the shared resources available on
the computer, and the users connected over the network to a selected resource.
(To create and manage shares, use File Manager.)



Chapter 5 Control Panel 159

One or all of the connected users can be disconnected. There are several reasons
to do this. For example, you may need to allow another user to connect to a shared
directory that already has its maximum number of users connected. To avoid data
loss, always warn users before disconnecting them.

» To view shared resources

1. In the Control Panel window, choose the Server icon.

2. In the Properties dialog box, choose the Shares button.

LConnected Users

cristalw
ERMNESTA
JEFFHO

STEVENA

Sharename Uses Path
I iPcs 1
&1 MONITOR 2 CAMONITOR
£ NETLOGOM ] C:hnt
&1 SCHEDULE 1 CASCHEDULE

Time In Use

o053
0102 Yes
0031 Yes
01:13 es

_Disconnect All

In the Shared Resources dialog box, the Share Name box lists available

resources.

Item Meaning

Share Name The name of a shared resource. This could be a shared
directory, named pipe, or printer.

Uses The number of connections to the shared resource.

Path The path of the shared resource.

3. To view the users connected to a shared resource, select a share name from the
Share Name box. The Connected Users box lists the connected users.

Item

Meaning

Connected Users

Time

In Use

The user name of a user connected to the selected shared
resource

The hours and minutes that have elapsed since the user first
connected to this shared resource

Whether the user currently has a file open from this shared
resource
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Below the Connected Users box, the Connected Users summary shows the
number of users connected to the selected resource.

4. To disconnect one user from all shared resources, select the user name from
the Connected Users box and then choose the Disconnect button: to disconnect
all users from all shared resources, choose the Disconnect All button.

Warn users before disconnecting them. Each disconnected user is disconnected
from all shared resources on the computer—not just the resource selected in
the Share Name box.

5. To exit, in the Shared Resources dialog box choose the Close button, and then
in the Properties dialog box choose the OK button.

Viewing Resources In Use

Use the Open Resources dialog box to view the resources open on the computer.
One or all of the resources can be closed. To avoid data loss, always warn
connected users before closing resources.

» To view resources in use
1. In the Control Panel window, choose the Server icon.

2. In the Properties dialog box, choose the In Use button.

Open Resources: 1
File Locks: 0
Opened by For Locks Path

CRISTALw ; C:AMONITORMEVENTYWR EXE
ERNESTA i C:ASTOCKMSCHEDO3.DOC
ERNESTA i CASTOCKATIMECARD XLS

JEFFHO i CASTOCKMNYO3XLS
STEVENA i C:ABUDGETMBUDGET.XLS

The Open Resources dialog box shows the resources open on the computer.

Item Meaning

Open Resources The total number of open resources on the computer.
These could be files, named pipes, or printers.

File Locks The total number of file locks by open resources.

Opened By The user name of a user who opened a resource.

For The permission granted when the resource was opened.

Locks The number of locks on the resource.

Path The path of the open resource.
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3. To close a single resource, select one resource from the list and then choose
the Close Resource button: to close all resources, choose the Close All
Resources button.

Warn connected users before closing resources.
4. To update the displayed information, choose the Refresh button.

5. To exit, in the Open Resources dialog box choose the Close button, and then in
the Properties dialog box choose the OK button.

Managing Directory Replication

Use the Directory Replication dialog box to manage replication for the computer.
Directory replication is the duplication of a master set of directories from a server
(called an export server) to specified servers or workstations (called import
computers) in the same or other domains. A Windows NT workstation can only
be set up as an import computer.

Before replication can occur, a special user account must be created, configured,
and assigned to the Replicator service. For information on preparing the
Replicator service, and for detailed information explaining directory replication,
see the Microsoft Windows NT Advanced Server System Guide, which is provided
with the Microsoft Windows NT Advanced Server software required for the
replication export server.

The procedures that follow describe how to use the Server option in the Control
Panel to set up the computer as an import computer. When setting up an import
computer you do not need to create the imported subdirectories, because a
subdirectory is automatically created the first time it is imported.

» To set up an import computer
1. In the Control Panel window, choose the Server icon.

2. In the Properties dialog box, choose the Replication button.
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) Do Not Import

~® Import Di

[C:\winnt\System32\Repl |

From List:

SHIPFING

Remove

The Directory Replication dialog box contains the following items relating to

import replication.

Item

Description

Do Not Import

Import Directories

To Path

Manage

From List

Add

Remove

Stops importing replicated subdirectories and files.

Allows replicated subdirectories and their files to be
imported.

The directory in which replicated subdirectories and files
will be stored. The default is
CAWINNT\SYSTEM32\REPL\IMPORT.

Displays the Imported Directories dialog box, where the
subdirectories to be imported are specified, and where
import locks are added or removed.

Subdirectories are replicated to this import computer from
the domains and computers listed here. By default, the From
List contains a [blank] entry and this computer automatically
imports from the local domain.

Displays the Select Computer dialog box. Used to add a
computer or domain to the From List.

Removes a selected computer or domain from the From List.

In the Directory Replication dialog box, select Import Directories.

4. To change the directory where imported subdirectories will be stored, type a
new path in the To Path box.

Because complex permissions support the default path,
CAWINNT\SYSTEM32\REPLNIMPORT, it is recommended this not be

changed.
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5. To import subdirectories from a domain or computer, under Import Directories
choose the Add button, and then complete the Select Domain dialog box that
appears.

The domain name or computer name is added to the From List.

Note By default, the From List contains a [blank] entry and this computer
automatically imports from the local domain. If any entries are added to the
From List, the local domain is no longer imported from. If needed, it must be
explicitly added to the From List.

6. To stop importing subdirectories from an export server or domain, select the
domain or server name in the From List, and then choose the Remove button.

7. To view a list of the subdirectories that have been imported to this computer,
or to manage locks on those imported subdirectories, under Import Directories
choose the Manage button, and then complete the dialog box that appears. For
more information, see the following procedure.

8. To exit, choose the OK buttons in the Directory Replication and Properties
dialog boxes.

» To view a list of, or manage locks for, imported subdirectories

1. In the Directory Replication dialog box, under Import Directories, choose the
Manage button.

Import Path: C:\winnt\System32\Replilmport

SCRIPTS 1] 0K 12/12/92 6:10:17 PM

The Manage Imported Directories dialog box contains the following items.

Item Description

Import Path The directory in which replicated subdirectories and files
are stored on this computer.

Sub-Directory A list of the subdirectories that are imported to this
computer. A subdirectory is automatically imported if it is
exported by one of the export servers or domains in the
From List of the Directory Replication dialog box.
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Item

Description

Locks

Status

Last Update
Locked Since

Import Settings For
Add Lock

Remove Lock

Add

Remove

A lock prevents import to the subdirectory. More than one
lock might be applied to a subdirectory. Import to a
subdirectory only occurs if this column has a value of 0.

OK indicates that the subdirectory is receiving regular
updates from an export server and the imported data is
identical to that exported.

No Master indicates that the subdirectory is not receiving
updates. The export server might not be running, or the
export server might have stopped exporting updates.

No Sync indicates that the subdirectory has received
updates, but the data is not up to date. This could be due to a
communications failure, open files on the import or export
server, the import server not having access permissions at
the export server, or an export server malfunction.

[blank] indicates that replication has never occurred for that
subdirectory. Replication may not be properly configured
for this import computer, for the export server, or both.

The date and time the last update was made to a file in this
import subdirectory, or in its subtree.

The date and time the oldest lock was placed on this
subdirectory.

Shows the selected subdirectory.
Adds a lock to the selected subdirectory, preventing import.

Removes a lock from the selected subdirectory. Import only
occurs when a subdirectory has 0 locks.

Displays the Add Sub-Directory dialog box, used to add
new subdirectories to the list of imported subdirectories.

However, this is usually unnecessary. This does not create
the actual subdirectory; and when a subdirectory is exported
by one of the export servers or domains in the From List of
the Directory Replication dialog box, it is automatically
imported and is added to this list.

Removes the selected subdirectory from the list.

However, this is usually unnecessary. If that subdirectory is
exported by one of the export servers or domains in the
From List of the Directory Replication dialog box, it will
still be imported and will later reappear in this list.

2. To temporarily stop importing to a subdirectory, select the subdirectory from
the list and then choose the Add Lock button.

3. To resume importing to a locked subdirectory, select the subdirectory and then
choose the Remove Lock button.
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Usually, you should only remove locks that you have applied. Import only
resumes when the Locks column shows a value of 0 for the subdirectory.

4. To return to the Directory Replication dialog box, choose the OK button.

Managing Administrative Alerts

The Alerts dialog box displays and manages the list of users and computers that
are notified when administrative alerts occur at this computer.

Alerts relate to server and resource use. They warn about security and access
problems, user session problems, server shutdown because of power loss when the
UPS service is available, and printer problems. For example, an alert can be
generated when disk space becomes low.

For alerts to be sent, the Alerter and Messenger services must be running on the
computer originating the alert. For alerts to be received, the Messenger service
must be running on the destination computer.

» To manage the recipients of administrative alerts
1. In the Control Panel window, choose the Server icon.

2. In the Properties dialog box, choose the Alerts button.

Send Administrative Alerts To:
=

NESTA
GREYHOUND

New Computer or Username: JEFFHO

AIREDALE

3. To add a user or computer to the list of alert recipients, type the user name or
computer name in the New Computer Or Username box, and then choose the
Add button.

4. To remove a user or computer from the list of alert recipients, select the user
name or computer name from the Send Administrative Alerts To box, and then
choose the Remove button.

5. To exit, in the Alerts dialog box choose the OK button, and then in the
Properties dialog box choose the OK button.
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Managing Services

Use the Services option in Control Panel to start, stop, pause, or continue each of
the services available on the computer, to determine whether a service will start
up automatically when the system starts, and to control some other service startup

parameters.

The default services provided with the system are shown in the following table.

Service

Description

Alerter

Computer Browser

Directory Replicator
Event Log
Messenger

Net Logon
Schedule

Server

UPS

Workstation

Notifies selected users and computers of administrative alerts
that occur on this computer. Used by the Server and other
services. Requires the Messenger service.

Maintains an up-to-date list of computers, and provides the list
to applications when requested. Provides the computer lists
displayed in the Select Computer and Select Domain dialog
boxes; and in the main Server Manager window.

Replicates directories, and the files in those directories, between
computers.

Records system, security, and application events in the event
logs.

Sends and receives messages sent by administrators or by the
Alerter service.

Provides authentication of user logon requests.

Must be running for the AT command to be used. The AT
command can be used to schedule commands and programs to
run on a computer at a specified time and date.

Provides RPC (remote procedure call) support, and file, print,
and named pipe sharing.

Manages an uninterruptible power supply connected to this
computer.

Provides network connections and communications.
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Starting and Stopping Services

» To start, stop, pause, or continue a service

1. In the Control Panel window, choose the Services icon.

Status Startup

5 2 e b S
Computer Browser tarted Automatic
Directory Replicatar Manual
EventLog Started Automatic
Messenger Started Automnatic
Met Logon Started Automatic
Schedule Manual
Server Started Automatic
UPS Manual

Startup Parameters:

A blank in the Status column indicates that the service is stopped.
In the Services dialog box, select a service.
3. Choose the Start, Stop, Pause, or Continue button.

To pass startup parameters to a service, type the parameters in the Startup
Parameters box before choosing the Start button. That entry will be passed to
the service when the Start button is chosen. None of the default services
supplied with Windows NT accept startup parameters.

4. In the Services dialog box, choose the Close button.

Because stopping the Server service disconnects all remote connected users, use
the following procedure to stop that service.

» To stop the Server service
1. Use the Services option in Control Panel to pause the Server service.
This prevents new users from establishing a connection with this computer.

2. Notify all connected users, warning them to disconnect within a specified time
period.

3. After expiration of your warning period, use the Services option in Control
Panel to stop the Server service.
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Configuring Service Startup

Security

Use the Service Startup dialog box to configure when and how a service is started,
and to specify the user account the service will use to log on.

When a user account other than the system account is used to log on a service,
that user account must have the Password Never Expires option selected, the User
Must Change Password At Next Logon option cleared, and it must belong to a
group that is granted the Log On As A Service right. For instructions on
configuring a user account and user rights as described here, see Chapter 13,
“User Manager.”

If it is the Directory Replicator service that you are assigning the user account to,
it must be a domain user account, it must be a member of the domain’s
Replicator, Domain Users, and Backup Operators groups, and it must be a
member of the Replicator group on all Windows NT workstations configured for
import replication. Also, the domain Replicator group and the Replicator groups
of all Windows NT workstations configured for import replication must be
granted the Log On As A Service right. For instructions on configuring a user
account and user rights as described here, see the Microsoft Windows NT
Advanced Server System Guide provided with the Microsoft Windows NT
Advanced Server software required for the replication export server.

To configure service startup you must be logged on to a user account that is a
member of the Administrators local group.

» To configure startup for a service

R

1. In the Control Panel window, choose the Services icon.
2. In the Services dialog box, select a service.
3. Choose the Startup button.

[ Startup Type
- Automatic
9] Manual
¢ Disabled

Log On As:
& System Account
® This Account: l?ihipping\Domain Repl I..;

Password: I:“""’“ I

Confirm
Password:
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4. Specify a startup type.
Select To

Automatic Start the service every time the system starts. (The Server
service will not start automatically unless the computer has at
least 12 MB of memory.)

Manual Allow the service to be started by a user or by a dependent
service.
Disabled Prevent the service from being started.

5. Specify the user account the service will use to log on.

Select To
System Account Specify that the service will log on using the system account.
This Account Specify a user account the service will use to log on.

Caution Most services must log on using the system account. Of the default
services provided with Windows NT, only the Directory Replicator and
Schedule services can use different accounts.

6. If you select This Account, choose the Browse button and complete the Add
User dialog box that appears, and then in both the Password and Confirm
Password boxes type the password for the user account you specified in the
Add User dialog box.

7. In the Service Startup dialog box, choose the OK button, and then in the
Service dialog box, choose the Close button.

If a user account has been assigned to a service as described in steps 5 and 6 of
the previous procedure, and if the password for that user account is later changed
(for example, while using the User Properties dialog box in User Manager to
administer the user account), the password for that user account must also be
changed here, in the Service Startup dialog box.
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Managing Devices

Use the Devices option in Control Panel to start, stop, and configure the startup
type for device drivers.

Starting and Stopping Devices
Use the Devices dialog box to start and stop devices.

» To start or stop devices

1. In the Control Panel window, choose the Devices icon.

Mtfs

tted

Started

Device Status Startup
MNerc710 Disabled
NetBEUI Protocol Started

Manual

System
Disabled

Mtfz_Rec Started System
Null Started System
Ofs Disabled

In the Devices dialog box, if Started is displayed in the Status column for a
device, that device driver is loaded. If the Status column is blank, that device
driver is not loaded.

The Startup column displays the startup type of each device. The startup types
are described in the following procedure under “Configuring Device Startup.”

2. In the Devices dialog box, select a device.
3. Choose the Start or Stop button.

Some devices are essential to system operation and cannot be stopped. When
such a device is selected, the Stop button is unavailable.

4. Repeat steps 2 and 3 as necessary.

5. In the Devices dialog box, choose the Close button.
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Configuring Device Startup

Security

>

= P

You can determine when a device will start by specifying the startup type.

To Configure device startup you must be logged on to a user account that is a
member of the Administrators local group.

To set the startup type of a device

1. In the Control Panel window, choose the Devices icon.
2. In the Devices dialog box, select a device.

3. Choose the Startup button.

Startup Type
9] Boot

] System
O Automatic
@ Manual:

> Disable

4. Select a startup type.
Select To

Boot Start the device every time the computer starts. Boot devices
start before any other devices. Use for critical devices essential
to system operation.

System Start the device every time the system starts. System devices
start after Boot devices. Use for critical devices essential to
system operation.

Automatic Start the device every time the system starts. Automatic devices
start after Boot and System devices. Use for devices that are not
critical for basic system operation.

Manual Allow the device to be started by a user or by a dependent
device.
Disabled Prevent the device from being started by a user. However, the

device can be started by the system.

Caution Changing the startup type of a Boot or System device can leave the
system in an unusable state.

5. Choose the OK button.
6. In the Devices dialog box, choose the Close button.
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CHAPTER 6

Print Manager

Overview

Use Print Manager to work with local and network printers.

This chapter explains how to control printing and printers, and includes the
following topics:

= Installing a printer for use with Windows NT and your applications

= Connecting to a network printer

= Changing a printer’s properties, including sharing a printer over the network
= Securing a printer and auditing its use

= Printing documents

=  Administering network print servers remotely

Use Print Manager to install local printers and to connect to printers on the
network so that you can print to them from your applications. Each printer that is
available appears in its own window in Print Manager. Printer windows show you
the current activity of the printer, including a list of the documents waiting to be
printed. If you have several printers available to you on the network, you can use
Print Manager to find one that is ready to print and not busy printing other users’
documents.

You can use Print Manager to control documents that have been sent to a printer.
You can pause and restart printing, arrange the order in which waiting documents
will be printed, and remove documents that are waiting to print.

Print Manager allows you to manage both local and remote printers to suit your
needs. Use Print Manager to share printers on the network, control access to
printers, and set other printer properties such as the hours the printer is available
to print.
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The Print Manager window contains a menu bar, toolbar, and status bar. Printer
windows and icons represent printers you have installed or to which you are
connected over the network. Server windows and icons represent servers to which
you have connected in order to administer printers remotely.

"":5 - Printer
| Window

| | Server
Window

(=7 =% =
3 | =

Ithlifeboatdinghy shared printer Server.
SASETT EF!]

\ Printer icons

Server icon

The toolbar provides quick access to commands through buttons.

The status bar shows the status of the current job or printer, including how many
pages of the job have been printed and how many documents are waiting to be
printed.

The printer window shows information for one of the printers that you have
installed or to which you are connected. For each printer, you can see what
documents are waiting to be printed, who owns them, how large they are, and
other information.

The server window shows information for all printers connected to a
Windows NT-based server.

The toolbar and status bar are displayed by default. You can hide them by
choosing the Toolbar and Status Bar commands from the Options menu.
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Starting and Quitting

By default, when you start Print Manager, its window appears as it was when you
last quit Print Manager. The positions of printer and server windows and icons are
saved as long as the Save Settings on Exit command is in effect when you quit.

» To start Print Manager

=/
)

e

e From the Main Group, choose the Print Manager icon.
—Or—

e In Control Panel, choose the Printers option.

» To quit Print Manager

e From the Printer menu, choose Exit.

Installing a Printer

Security

Use the Print Manager Create Printer option from the Printer menu when:

=  You are physically installing a printer on a computer.
=  You are physically installing a printer that connects directly to the network.
» You want to define a printer that prints to a file.

= You want to define multiple printers with varying properties for the same
physical printer.

You can also create a printer for a network printer controlled by a LAN Manager
2.X server.

To create a printer, you must be logged on as a member of the Administrators or
Power Users group.

The printers you create using Print Manager represent physical devices, usually
physical printers. Because Print Manager printers are representations of physical
devices, they can be used flexibly. You can create more than one printer
representing the same physical printer, or you can create a printer that prints to a
file. For example, if you have a printer in your office, but also share it with others
over the network, you might want to create two printers for the physical printer.
You can create a printer for yourself that is not shared over the network and a
second printer that is shared. Then it’s easy to control the use of the shared
printer. You can set permissions on it, ensuring that only members of your
department can print to it. Or you can set a low priority for it, ensuring that
documents you send to the printer will always print before documents sent by
those who share it.
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Note If you want to print to a printer that is already shared on a network, add it to
the printers in Print Manager by connecting to it. For more information, see
“Connecting to a Network Printer” later in this chapter.

When you choose Create Printer from the Printer menu, Print Manager displays a
Create Printer dialog box where you can define the operation of the printer. To
complete a basic printer installation, specify the printer name, driver, and an
optional description. Then specify a printing destination. The destination can be a
port, a file, a network share name, or a network address. Print Manager will
prompt you to select the appropriate printer driver or to install a new one if
necessary.

» To install a printer

1.

From the Printer menu, choose Create Printer.

Printer Name: |5hipping

|
Driver: [HP Laseret lISi 2]

Description: |departrnent printer available & AM to & PM I

Print to: |LPT1:

[ Share this printer on the

Share Name: |Shipping |

Location: IHoom 342 |

2. In the Printer Name box, type a name for the printer.

This name appears in the title bar of the printer window. It is the name
network users running Windows NT will see when connecting to the printer if
you share the printer over the network. The name can be up to 32 characters
long.

. In the Driver box, select the printer’s driver.

If your printer does not appear in the list, you can try installing the printer
using a compatible driver. For example, if your printer is Hewlett-Packarde
PCLe compatible, you may be able to use one of the HP LaserJete drivers
included with Windows NT. Consult your printer’s documentation to
determine which drivers you can choose.

If your printer manufacturer supplies a Windows NT compatible driver that
you want to install, select Other in the Driver box. In the Install Driver dialog
box, specify the drive and path where the printer driver is located and choose
the OK button. Print Manager adds the new driver to the list.
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4. In the Description box, type an optional description.

Network users will see this description when adding the printer to their
available printers. Use the description to inform them about the printer. For
example, if the printer is available only during certain hours, you could include
that information here.

5. In the Print To box, choose a destination for printing output:

If you are installing a printer that you have physically connected to a
computer, choose the appropriate parallel or serial port, for example, LPT1.

If the port you want does not appear in the list, choose Network Printer. In
the Print Destinations dialog box, choose Local Port and then choose the
OK button. Type the name of the new port in the Port Name dialog box and
choose the OK button. Print Manager adds the port to the list of print
destinations.

If you want to print to a file, choose File. When you print, you are
prompted for a file name.

If you want to create a printer for a printer controlled by a LAN Manager
2.x server, choose Network Printer. In the Print Destinations dialog box,
choose LAN Manager Print Share and then choose the OK button. You can
select the print share in the Browse Network Printer dialog box or type the
name of the print share in the Path box. Then choose the OK button.

If you are installing a Hewlett-Packard printer that connects directly to the
network, choose Network Printer. In the Print Destinations dialog box,
choose Hewlett-Packard Network Port and then choose the OK button. In
the Add A Hewlett-Packard Network Port dialog box, select the network
address in the Card Address box and name the port. Then choose the OK
button.

Before you can create a printer that uses a Hewlett-Packard network port,
the Data Link Control protocol must be installed and running. You can
install the protocol using the Networks option in Control Panel.

6. Choose the OK button.

7. If the appropriate printer driver is not already installed, Windows NT prompts
you to enter the path of the distribution files where the driver is located. Type
the path and choose the OK button. Windows NT prompts you to insert disks
as necessary to install the driver.

This completes a basic printer installation. You can specify many other options
when installing a printer. For more information, see “Changing a Printer’s
Properties” later in this chapter.
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Installing a Printer Driver

Use Print Manager when you need to install a new or additional printer driver for
your printer.

Because RISC and x86-based computers use different printer drivers, you may
want to install printer drivers for both platforms on your print servers if your
network contains a mixture of RISC and x86-based computers. For example,
when a RISC-based Windows NT computer connects to an x86-based Windows
NT print server, the RISC version of the printer’s driver must be available to the
RISC-based computer. You can install the RISC printer driver on either the local
computer or on the x86-based print server. If you install the driver on the server, it
will be available to any other RISC-based Windows NT computer on your
network.

» To install a new printer driver
1. Select the printer’s icon or window.

2. From the Printer menu, choose Properties. Or choose the Properties button on
the toolbar.

3. In the Printer Properties dialog box, select Other in the Driver box.

4. In the Install Driver dialog box, specify the drive and path where the printer
driver is located and choose the OK button.

Print Manager installs the new driver.

5. In the Printer Properties dialog box, choose the OK button.

Connecting to a Network Printer

To print to a printer that is shared over the network, connect to it. Connecting to
the printer adds the printer to the available printers displayed in the Print Manager
window.

» To connect to a network printer

1. From the Printer menu, choose the Connect To Printer command. Or choose
the Connect Printer button on the toolbar.
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Printer: | shipping

Shared Printers: Expand at Startup

gg& Microsoft Windows Netwark
£ ACCOUNTING
L ENGINEERING
SHIPPING
"8 SsETTER

‘&, AIREDALE
“ENVOICE
B TECHSUPPORT

™ Printer Information
Description: department printer available & AM to 6 PM
Status: Ready Documents Waiting: o

2. In the Connect To Printer dialog box, select a printer.

The Select Printer box shows networks, domains or workgroups, and shared
printers organized in a tree structure. Double-click an item to expand the list:
Double-click a network name to display domains or workgroups, a domain or
workgroup name to display shared printers. Print Manager displays the
printer’s driver and location next to the printer’s name.

When you select a printer, Print Manager fills in the Printer box with the name
you selected and displays additional information, including the printer’s
description, status, and the number of waiting documents, in the Printer
Information box.

Or you can type the name of a computer and shared printer in the Printer box.
Precede the computer name with two backslashes (\\) and separate the
computer name from the shared printer’s name with a single backslash (\), for
example, \\printserver\laser.

3. Choose the OK button.

4. If the printer you selected is shared by a Windows NT computer, you are now
ready to print to the printer.

If the printer you selected is shared by computer other than a Windows NT
computer, Windows NT prompts you to install a driver. Choose the OK button
to continue.

5. In the Select Driver dialog box, select the appropriate driver for the printer in
the Driver box.

6. In the Windows NT Setup dialog box, type the directory and path where
Windows NT printer drivers are stored, and then choose the Continue button.
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Windows NT installs the driver and displays a printer window for the
connected printer.

Removing a Printer

You can use Print Manager to remove printers that you have installed and to
which you are connected.

» To remove a printer

. Select the printer window or printer icon.

From the Printer menu, choose Remove Printer, or choose the Remove Printer
button on the toolbar.

Print Manager prompts you for confirmation. Choose the Yes button to
remove the printer.

Changing a Printer’s Properties

You can set printer properties when you create a printer or you can change a
printer’s properties after you have created it. Properties include:

Security

Sharing the printer on the network.

Setting printing options such as the size and format of paper available at the
printer and the font cartridges that are installed.

Setting job defaults such as the default paper size and printing orientation.

Setting printer details such as the hours the printer is available and the printing
priority of documents sent to the printer.

To change printer properties, you must be logged on as a member of the
Administrators or Power Users group, or you must have been granted Full Control
permission for the printer.

» To change the properties of an installed printer

1. Select the printer’s icon or window.

2. From the Printer menu, choose Properties. Or choose the Properties button on

the toolbar.
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Printer Name: | shipping

Driver: [HP Laseret llSi

Description: [department printer available € AM to & PM

Print to: ILPT‘I :

Share this printer on the networl

Share Name: Ishipping [

Location: l Foom 342 |

You can now change the printer’s properties as discussed in the sections that
follow.

Sharing a Printer

Sharing a printer allows others on the network to connect to the printer and to
print their documents on it. Before you can share a printer, the Server service
must be running. You can start the Server service by using the Services option in
Control Panel.

» To share a printer on the network

1. In the Printer Properties dialog box, select the Share This Printer On The
Network check box.

Share this printer on the k

Share Name: | shipping l

Location: | Room 342 l

2. In the Share Name box, Print Manager creates a share name for the printer.
Computers running Windows NT see the printer name when connecting to the
printer; however, computers running MS-DOS require a share name that
conforms to MS-DOS naming conventions in order to connect.

The share name is based on the printer name. You can edit the share name;
however, the share name must follow MS-DOS naming conventions and
cannot be longer than 12 characters.

3. In the Location box, type a description of the printer’s location to let users
know where their documents will be printed. Users see the printer’s location in
the Connect To Printer dialog box when they add the printer to their list of
available printers.
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4. Choose the OK button.

Setting Printing Options
Setup options allow you to configure the printer to take full advantage of its

features. The options that are available depend on the printer. The following table
lists typical setup options:

Option Purpose

Forms Specifies the size and format of paper used in the printer. Printers that
support multiple paper trays or sources for paper allow you to match a
form with a source.

Memory Specifies the amount of memory available in the printer.

Font Specifies the font cartridges installed in the printer. Controls the loading
of soft fonts and font substitution.

Color Adjusts the printing of halftone colors.

» To set or change printing options
1. In the Printer Properties dialog box, choose the Setup button.

A typical Printer Properties dialog box used for setting printing options is
shown below. The options available for your printer may be different.

[ Forms
Source Mame

|Uppel Paper tray ILetler

[ Printer Memory
Amount (kilobytes]

1 Page Protect

Font Cartridges [ 1 maximum )

Z: Microsoft 1A

HP: ProCollection

HP: Global Text

HP: Great Start

HP: TextEquations

HP: Polished Worksheets

2. Set the options and then choose the OK button.
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Setting Job Defaults

Job defaults include printing settings such as paper size, page orientation, and
number of copies. The features that are available depend on the printer. The
settings in Print Manager establish how a document prints by default; however,
you can change these settings through your applications when you print. Changes
made from an application override the settings made in Print Manager.

» To set or change job defaults

1. In the Printer Properties dialog box, choose the Details button.

2.

In the Printer Details dialog box, choose the Job Defaults button.

A typical Document Properties dialog box used for setting job defaults is
shown below. The options available for your printer may be different.

[~ Orientation

® Portrait

. O Landscape

Copies

2 Sided Dperation

® Mone
E O Long side
) Short side

Set the defaults and then choose the OK button.

Setting Printer Details

Use the Printer Details dialog box to set the following printer features:

Set the hours a printer is available

Print a separator page

Create a pool of printers

Set printer priority

Specify a print processor

Specify a default datatype

Print directly to ports
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» To set printer details
1. In the Printer Properties dialog box, choose the Details button.

Available From: [12:004M [ To: [12:00 aM

Separator File: |7

Print to Additional Ports: Priority: E-'-

Print Processor: E
Default Datatype: Q

O Print Directly to Ports

2. Set or change printer details and then choose the OK button.

Setting Printing Hours

Setting printing hours sets the period during which the printer will print
documents sent to it. Documents can be sent to the printer at any time, but they
will only be printed during the hours that you have set. By default, printing hours
are not limited.

Setting printing hours allows you to control the flow of work to a printer. For
example, you can create two printers in Print Manager for the same physical
printer and restrict the printing hours for one printer to nighttime hours. You can
send documents to the nighttime printer at any time, but they will print only at
night. Use the nighttime printer to print documents that are large or that you don’t
need immediately. This keeps the physical printer available during the day to print
the documents you need right away. Print those documents by directing them to
the printer whose hours you have not limited.

» To set or change printer availability

e In the Printer Details dialog box, set the period that the printer is available
using the Available From and To scroll boxes.

Available From: | 12:00 &M E To: | 12:00 AM E
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Using Separator Files

You can use separator files for a variety of purposes. Windows NT includes
separator files that print a page at the beginning of each document to make it easy
to find a document among others at the printer and separator files that can switch
a printer between PostScripte and PCL printing. You can create your own
separator files and specify their use by Print Manager.

The following table shows the names of separator files supplied with
Windows NT, the purpose of each, the type of printer with which each is
compatible, and whether or not the file can be edited.

Filename Purpose Compatible with Can be edited
DEFAULT.SEP Prints a page before = PCL No
each document
PSLANMAN.SEP Prints a page before ~ PostScript Yes
each document
PCL.SEP Switches printer to PCL Yes
PCL printing
PSCRIPT.SEP Switches printer to PostScript Yes
PostScript printing

To specify a separator page

e In the Printer Details dialog box, type the name of the separator file, including
its path, in the Separator File box. To use the Windows NT default separator
page, type DEFAULT.SEP in the Separator File box.

Separator File: |

If you want to search for a file, choose the browse button next to the Separator
File box. You can then search for the file using the Select Separator Page
dialog box.

Setting Printer Priority

Use the priority setting to control which documents will print first when sent to a
printer. When you create two printers for the same physical printer and set
different priorities for them, documents sent to the printer whose priority is higher
will always print before documents sent to the printer whose priority is lower.

For example, if you are the primary user of the printer in your office, but you also
share it with others over the network, you can ensure that your print jobs will
always print before those of others by creating two different printers for the
physical printer and setting a low priority for the shared printer.
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» To set or change the priority

e In the Printer Details dialog box, set the priority in the Priority box.

By default, the priority is set to 1, which is the lowest priority. You can set a
priority from 1 to 99.

Prioity A

Creating a Printer Pool

Print Manager allows you to pool printers. When printers are pooled, several
printers connected to a server behave as a single printer. When a document is sent
to the server, the first available printer in the pool will print it. The printers in the
pool must be identical to ensure printing consistency. To create a pool of printers,
create a printer and include in the printer definition the additional ports to which
the pool printers are connected.

» To create a printer pool

e In the Printer Details dialog box, select port names from the Print To
Additional Ports box that correspond to the ports where you have connected
printers.

If the ports you need do not appear in the list, you can add them.

» To add a port

1. In the Printer Properties dialog box, select Network Printer in the Print To box.

2. In the Print Destinations dialog box, select Local Port and choose the OK
button.

3. In the Port Name dialog box, type the name of the port you want to add in the
Enter A Port Name box, and then choose the OK button.
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Printing Directly to Ports

You can control how Print Manager sends documents to the printer. By default,
documents are spooled before starting to print. When a document is spooled, it is
stored on the hard disk first and then the spooler sends it to the printer. You can
continue working with your application as soon as the document is stored on the
disk. The spooler sends the document to the printer in the background.

If you want to bypass spooling, you can print directly to the printer. However, you
will have to wait until the document is printed before continuing to work with
your application.

» To print directly to ports
e In the Printer Details dialog box, select Print Directly To Ports.

[1 Print Directly to Ports

Specifying a Print Processor or Datatype

The Windows NT print processor supports ASCII, Journal, and Raw data types. In
general, you should not need to change either the default print processor or
datatype. These options are available so that specialized applications can modify
the printing process. Such an application may require you to specify a specialized
print processor and a particular datatype when you create a printer to use with the
application.

» To set or change the print processor

e In the Printer Details dialog box, select the filename of the processor in the
Print Processor box.

Print Processor: E

» To set or change the default datatype
e In the Printer Details dialog box, select a datatype in the Default Datatype box.

Default Datatype:

Setting Timeouts

For printers that are connected to a computer’s parallel port, for example LPT]1,
you can control the amount of time that elapses before Print Manager decides that
the printer is not responding and notifies you of an error. The setting affects the
printer you’ve selected and any other local printers that use the same driver. The
setting for Transmission Retry determines how long Print Manager will wait for a
printer to ready itself to accept more data.
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» To set timeout options

1. Select the printer whose timeouts you want to set.
Timeouts can be set only for printers connected to a parallel port.
2. From the Printer menu, choose Properties.

3. In the Printer Properties dialog box, choose the Settings button.

Transmission Retry:

[’Timeoul [seconds)

4. Set the number of seconds in the Transmission Retry box, and then choose the
OK button.

Securing a Printer

Security

You can secure printers by setting permissions on them. Each permission you set
specifies the access that a group or user has to the printer. For example, when you
set Print permission for the group called marketing on the printer, members of that
group can print documents on the printer, but cannot change any of the printer’s
properties.

Permissions are cumulative except that the No Access permission overrides all
other permissions. For example, if the marketing group has Full Control
permission while the finance group has only Print permission, and Jane is a
member of both groups, Jane will have Full Control permission. However, if you
change the finance group’s permission to No Access, Jane will not be able to use
the printer even though she is a member of group that has access to it.

By default, if you have permission to print, you also can control the printing of
any document you print. As creator of the document at the printer, you are
allowed to control the document through permissions granted the Creator Owner.
In general, you should not change the permissions granted to the Creator Owner
or remove the Creator Owner from the permissions list.

To change permissions on a printer, you must be the owner of the printer or have
been granted Full Control permission.
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The following table shows the permissions for printers and the actions available to

users for each permission.

® Permission allows use
O Permission does not allow use

Qr

00071}2 .

Print documents

Control settings for documents

Pause, resume, restart, and delete documents
Change the printing order of documents
Pause, resume, purge printer

Change printer properties

Delete printer

oooooooo%(q
Ss

Change printer permissions

0000000 8|k

O 00 0O e e O 4,

» To set or change printer permissions

1. Select the printer window or icon for the printer whose permissions you want

to set or change.

2. From the Security menu, choose Permissions.

Printer: shipping

Owner: Administrators

Mame:

CREATOR OWNER

Everyane
Power Users

Manage Documents [None) (A1)
Print
Full Control [All] (Al

Type of Access: |FuII Control

3. Select the name of the group or user and choose a permission from the Type of

Access box.
4. Choose the OK button.
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» To add a group or user to the printer permissions list

1. In the Printer Permissions dialog box, choose the Add button.

List Names From: I@ \\setter®

MNames:

embers can assign file backup and restore IE

CREATOR OWNER The uzer who creates this object

Everyane All Users

Guests Guests of the domain
e INTERACTIVE Users accessing this object locally
e NETWORK Users accessing this object remately
L shipstaff shipping department staff |+

Add Names:
@ setterhshipstaff shipping department staff

Type of Access: |Print

The Add Users And Groups dialog box displays the groups on the computer or
in the domain shown by the List Names From box.

You can select another domain by using the List Names From box. Domains
appear only if your computer is a member of a domain on a Windows NT
Advanced Server network. The domains shown have a trust relationship.

2. You can use options in the Add Users And Groups dialog box to display users,
find the users in a group, or find the domain to which a group or user belongs.

= Choose the Show Users button to display the names of users on the current
computer or domain.

= To see a group’s content, select the group and choose the Members button.
Users are listed in a new dialog box. On a Windows NT Advanced Server
network, global groups that are members of a local group appear in the list.
To see a global group’s users, select the group and choose the Members
button. To include the group in the Add Users And Groups dialog box,
choose the Add button. To include some of the group’s users, select them
and choose the Add button.
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= To add a group or user, you must know the domain which contains the
group’s or user’s account. On a Windows NT Advanced Server network,
choose the Search button to find the domain of a group or user. In the Find
Account dialog box, type the name of the group or user in the Find User Or
Group box and specify the domains to search. Then choose the Search
button. To include the groups or users in the Add Users And Groups dialog
box, select them in the Search Results box and choose the Add button.

3. To add groups or users to the permissions list, select them and choose the Add
button, or double-click the name of the group or user.

Or you can type the names of groups and users in the Add Names box.
Separate names using a semicolon. If the account of the group or user is not
located on the computer or domain shown by the List Names In box, you must
specify the location. Type the computer or domain name followed by group or
user name and separate the names using a backslash, for example
SHIPPING\ERNESTA. You can type the name without waiting for Windows
NT to list groups in the Names box.

4. Select the permission for the groups or users shown in the Add box using the
Type Of Access box.

5. Choose the OK button.

» To remove printer permissions for a group or user
1. In the Printer Permissions dialog box, select the name of the group or user.

2. Choose the Remove button.

Auditing a Printer

Auditing a printer allows you to track its usage. For a particular printer, you can
specify which groups or users and which actions to audit. You can audit both
successful and failed actions. Windows NT stores the information generated from
auditing in a file. You can view the information using Event Viewer. For more
information, see Chapter 15, “Event Viewer.”

Important To audit a printer, you must set the audit policy to audit file, print and
security changes. Set the audit policy using User Manager. For more information
on audit policy, see Chapter 13, “User Manager.”
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To audit the following activities for a printer, select the events shown.

@ Event audits action
O Event does not audit action

Printing documents

Changing job settings for documents

Pausing, restarting, moving, and deleting documents
Sharing a printer

Changing printer properties

Deleting a printer

© 00000 e,
e 6 6 0 0 O
o%/o
OI][I’O/

Changing printer permissions

» To set or change printer auditing
1. Select the printer window or icon for the printer that you want to audit.

2. From the Security menu, choose Auditing.

Printer: shipping

Name:

i oon Project Team
B Sales Staff

" Events to Audit

Success Failure
Print | O
Full Control [

3. Select the name of the group or user and then select the Events To Audit.
4. Choose the OK button.
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» To add a group or user to the printer auditing list
1. In the Printer Auditing dialog box, choose the Add button.

List Names From: I@ W setter®
Mames:
Backup Operators Members can assign file backup and restore -E
b CREATOR OWNER The user who creates this object |
Everyone All Users
B Guests Guests of the domain
@ INTERACTIVE lJsers accessing this object locally
tfi NETWORK Users accessing this object remotely -
:;‘_(f shipstaff shipping department staff E

Add Mames:
setter\shipstaff shipping department staff
Type of Access: [Print

The Add Users And Groups dialog box displays the groups on the computer or
in the domain shown by the List Names From box.

You can select another domain by using the List Names From box. Domains
appear only if your computer is a member of a domain on a Windows NT
Advanced Server network. The domains shown have a trust relationship.

2. You can use options in the Add Users And Groups dialog box to display users,
find the users in a group, or find the domain to which a group or user belongs.

»  Choose the Show Users button to display the names of users on the current
computer or domain.

= To see a group’s content, select the group and choose the Members button.
Users are listed in a new dialog box. On a Windows NT Advanced Server
network, global groups that are members of a local group appear in the list.
To see a global group’s users, select the group and choose the Members
button. To include the group in the Add Users And Groups dialog box,
choose the Add button. To include some of the group’s users, select them
and choose the Add button.
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= To add a group or user, you must know the domain which contains the
group’s or user’s account. On a Windows NT Advanced Server network,
choose the Search button to find the domain of a group or user. In the Find
Account dialog box, type the name of the group or user in the Find User Or
Group box and specify the domains to search. Then choose the Search
button. To include the groups or users in the Add Users And Groups dialog
box, select them in the Search Results box and choose the Add button.

3. To add groups or users to the auditing list, select them and choose the Add
button, or double-click the name of the group or user.

Or you can type the names of groups and users in the Add Names box.
Separate names using a semicolon. If the account of the group or user is not
located on the computer or domain shown by the List Names In box, you must
specify the location. Type the computer or domain name followed by group or
user name and separate the names using a backslash, for example
SHIPPING\ERNESTA. You can type the name without waiting for Windows
NT to list groups in the Names box.

4. Choose the OK button.

» To remove printer auditing for a group or user
1. In the Printer Auditing dialog box, select the name of the group or user.

2. Choose the Remove button.

Taking Ownership of a Printer

The owner of a printer can always change the permissions set on the printer. If
you have Full Control permission for a printer, you can take ownership of it.
Otherwise, you must be logged on as a member of the Administrators group to
take ownership.

» To take ownership of a printer
1. Select the printer window or icon for the printer.

2. From the Security menu, choose Owner.

Printer Name:  shipping
Owner: Administrators

Take Ownership

3. Choose the Take Ownership button.
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Using Forms

A form specifies paper size and the size of margins. Many printers support a range
of forms: letter, legal, A4, #10 envelope, and so on. When you create a printer,
you assign a form to each of the printer’s trays. In addition to supporting standard
forms, Print Manager allows you to create custom forms and assign them to
printers. Use this feature to ensure that a printer is always ready to print your
special forms.

For example, you can define a letter-sized form called Letterhead whose
expanded top margin reserves space for the information on your company’s
letterhead. You can then assign this form to a paper tray on one of your printers
and keep that tray filled with letterhead paper. Users connected to the printer can
select the Letterhead form when printing from their applications and be assured
that their documents will be printed on the company stationery. If a user selects a
form that is not assigned to a tray on the printer, the document will wait to print
until the selected form has been assigned to the printer.

Forms you create are stored on the computer. When you create a form for use with
a particular printer, create the form on the computer used as the printer’s server.

» To create a form

1. From the Printer menu, choose Forms.

Forms on this Computer:

Letter Small
Tabloid
Ledger
Legal
Statement
Executive

[~ Form Description

Name: [ Letter [

Paper Size Print Area Margins

Width: Left: [000n | Top: [0.00n |
Height: [11.00n_| | | Bight:[050n | Bottom: [0.00in

Units
( O Metric @ English

2. In the Form Description box:
= In the Name box, type a name for the form.

= In the Paper Size box, type the measurements for the width and height of
the paper.
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3.
4.

= In the Print Area Margins box, type the measurements for the left, right,
top, and bottom margins.

You can enter sizes in either inches or centimeters by selecting the English
or Metric option buttons in the Units box.

Choose the Add button.
Choose the OK button.

» To assign a form to a printer

1.

5.

Select the printer to which you want to assign the form.

2. Choose the Properties button, or choose Properties from the Printer menu.
3.
4

. Select the source, for example Upper Paper Tray, and the name of the form,

In the Printer Properties dialog box, choose the Setup button.

for example Letter.
Source and form options are dependent on the printer.
Choose the OK button.

» To remove a form

1.
2.

From the Printer menu, choose Forms.

In the Forms On This Computer box, select the form you want to remove. You
cannot delete any of the standard forms supplied with Windows NT.

. In the Forms dialog box, choose the Delete button.

Printing Documents

The way you print documents depends on the application you are using. Use Print
Manager to manipulate the documents at the printer. You can pause printing, and
change the order of or remove documents that are waiting to print.

Security You can always control printing of your own documents. However, to control
printing of other users’ documents, you must be logged on as a member of the
Administrators or Power Users group, or you must have been granted Manage
Documents permission for the printer.

Setting the Default Printer

When you choose the Print command in an application, the application sends the
document to the default printer. Some applications allow you to select any of the
available printers when you print. Set the default printer to be the printer you print
to most often.
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» To set the default printer

e On the Print Manager toolbar, choose the Default box and select a printer from
the list.

Viewing Documents at the Printer

To see the documents that are printing or waiting to be printed, display the
printer’s window. The printer window shows each document’s status, name, and
owner; the time it was sent to the printer; its size in pages and kilobytes; and its
priority. Print Manager displays documents sorted by the order in which they will
print.

Paintbiush - CHART BMP Guest 215PM 1 0
MNotepad - APPMOTES. TXT  Stevew/ 216 PM 2 BS54 b 1]
b, Spooling  Remote Downlevel Document SYSTEM 2:39 PM i} Ob ]

Pausing and Resuming Printing

You can interrupt and restart printing of all documents on a printer or of one
document on a printer.

» To pause all printing
1. Select the printer’s window or icon.

If a document is selected in the printer window, deselect it by pressing the
right mouse button or by pressing the SPACEBAR.

2. From the Printer menu, choose Pause. Or choose the Pause button on the
toolbar.

» To resume all printing
1. Select the printer’s window or icon.

If a document is selected in the printer window, deselect it by pressing the
right mouse button or by pressing the SPACEBAR.

2. From the Printer menu, choose Resume. Or choose the Resume button on the
toolbar.
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» To pause printing of a document
1. Select the document in the printer window.

2. From the Document menu, choose Pause. Or choose the Pause button on the
toolbar.

» To resume printing a document
1. Select the document in the printer window.

2. From the Document menu, choose Resume. Or choose the Resume button on
the toolbar.

Changing Printing Order

You can change the order in which documents will be printed.

» To change the order of a document

e Select the document in the printer window, and then drag it to a new position
in the printing order.

—_Or—

e Select the document in the printer window, and then press CTRL+UP ARROW or
CTRL+DOWN ARROW to move the document up or down in the printing order.

Restarting Documents

You can restart printing from Print Manager. When you restart a document, Print
Manager reprints it from the beginning. For example, if your printer experiences a
problem such as wrinkled paper, use Print Manager to restart printing. You can
restart printing only when the Print Directly To Ports option is off.

» To restart printing for a document

e Select the document in the printer window, and then choose Restart from the
Document menu.

Removing Waiting Documents

You can remove documents that are waiting to print one at a time, or you can
remove all documents that are waiting to print.

» Toremove a waiting document
1. Select the document in the printer window.

2. From the Document menu, choose Remove Document. Or choose the Remove
Document button on the toolbar.
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» To remove all waiting documents
1. Select the printer’s window or icon.

2. From the Printer menu, choose Purge Printer.

Displaying or Changing Document Details

When you display detailed information on a document, Print Manager displays
the file’s name, status, owner, size in pages and kilobytes, and the time it was sent
to the printer. Print Manager also shows who will be notified of the document’s
status when it prints, the range of time in which the document can be printed, the
document’s priority, and the document’s print processor.

» To display details about a document

1. Select the document in the printer window.

2. From the Document menu, choose Details. Or choose the Details button on the
toolbar.

Document Title: Microsoft ward -

Status: Pages: 20

Size: 1159576 Owner: Administrator

Printed On: Lazer Printer MNotify: I::J
Printed At: 1259 4M Priority:
Processor: WinPrint Start Time:
Datatype: NT JNL 1.000 Until Time: [12:00 aM B

Changing Print Notification

By default, the owner of a document is notified when the document has been
printed. You can change who is notified.

» To change print notification

¢ In the Document Details dialog box, type the username of the person you want
to notify in the Notify box.
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Changing Document Priority

By default, documents sent to a printer have the same priority while waiting to
print. But when you raise the priority of a document, it will print before other
documents that are waiting at that printer. If multiple printers with different
priorities have been defined for a physical printer, documents sent to printers with
higher priority will still print before documents sent to lower priority printers. For
more information on printer priority, see “Setting Printer Priority” earlier in this
chapter.

To change a document’s priority

¢ In the Document Details dialog box, set the document’s priority in the priority
box.

You can set a priority from 1; the highest priority, to 99.

Changing Document Printing Hours

You can specify a period of time during which the document will print. If, for
example, you have a long document to print, you can specify that it print during
the evening. The hours you set must be within the hours the printer is available.
For more information on setting hours for a printer, see “Setting Printing Hours”
earlier in this chapter.

» To change printing hours for a document

e In the Document Details dialog box, set the period of time during which the
document will print in the Start Time and Until Time boxes.

Administering Network Print Servers Remotely

Security

Print Manager allows you to administer network print servers remotely. You can
change the properties of existing printers, as well as install new printers or remove
printers.

To administer a printer, you must be logged on as a member of the Administrators
or Power Users group; or you must have been granted Full Control permission for
the printer.
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» To install, remove, or change a printer remotely

1. From the Printer menu, choose Server Viewer.

Computer: [\\SETTER |

Select Computer:

2. In the Select Computer dialog box, double-click the name of a domain to
display the servers in the domain. Choose the print server you want to
administer, and choose the OK button.

3. Print Manager displays a window that shows the printers on the server you
have chosen. You can minimize server windows.

To Choose

Install a new printer Create Printer from the Printer menu. You can
then install the printer just as you would a local
printer.

Remove a printer Remove Printer from the Printer menu.

Change a printer Properties from the Printer menu.
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CHAPTER 7

Mail

Overview

The Mail electronic mail system helps you communicate efficiently with
coworkers. This chapter provides an overview of the basic features of Mail for all
users, and also provides information for the administrator who creates and
manages the Workgroup Postoffice (WGPO).

The following topics are presented in this chapter:

An overview of Mail

Using Mail

Setting up the Mail system
Managing the Workgroup Postoffice

Using Mail with other networks and other messaging systems

Although this chapter will get you started using Mail, your main source of
information is online Help. To get Help, press F1 wherever you are working in
Mail.

Mail is part of the set of applications that you can install on your system with
Windows NT Setup. With Mail, you can:

Send and receive electronic messages (e-mail).

Attach files created with other applications, such as spreadsheet and word-
processing applications, to your messages.

Find messages in your mailbox according to criteria you specify.

Print messages, organize and store messages in folders.
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Before you can use Mail, an administrator must create a workgroup postoffice
(WGPO), which contains all the information about Mail user accounts and serves
as a collective mail drop facility for users. For information about how to create a
WGPO, see “Setting Up the Mail System” later in this chapter.

When you connect to your postoffice and sign in for the first time (as described in
“Starting and Quitting Mail”), Mail creates a file named MSMAIL.MMF in the
directory where you installed Windows NT. Mail uses this file to store your
messages, message folders, and Personal Address Book. The postoffice updates
the file when it receives messages for you. Each Mail user in your workgroup has
a message file, which is like a private mailbox. Each message file and the
messages in it are protected by a password that only the user knows.

Each time you sign in, Mail displays the Inbox, showing your messages and
folders.

Toolbar

“E0 Deleted Mail [ #
€ Inbox New Schedule 9/29/32 9:562
Sent mail Andy MacKay MNew Inventory Database 9/30/92 9:564

Outboy

\ Folder \ Message header

The Inbox displays message headers, which show who sent the message, the
subject, and the date and time the message was received in your mailbox. If the
sender specified an urgent priority for the message, an exclamation point appears
beside the message icon; a low-priority message appears with a down arrow; and
a message that includes an attachment appears with a paper clip in the message
icon. When you read a message, it appears in a Read Note form, as described in
“Reading a Message” later in this chapter.
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You can use either the toolbar or menus to reply to messages, forward them to
other Mail users, or print or delete them. You can move or copy messages to
organize and store them in folders. You can also sort messages by priority, sender,
subject, or date. If you want to keep a record of the messages you send to other
people, you can automatically save copies in the Sent Mail folder. For more
information about these activities, see “Using Mail” later in this chapter.

To create a message, choose the Compose button on the toolbar, which displays
the Send Note form. If you don’t know the recipient’s address or office number,
you can use the address lists in the Address Book or in your Personal Address
Book to address a message. For more information, see “Sending a Message” later
in this chapter.

In the message body, you can cut and paste text between messages and files. If
you want to send formatted files, such as Microsoft Word or Microsoft Excel
documents, you can send them with the message as attached files. You can send
as many attachments as you like with each message. For more information, see
“Advanced Features of Mail” later in this chapter.

Starting and Quitting Mail

This section explains how to start Mail for the first time, connect to a postoffice,
sign in to Mail, change your password, and quit Mail.

When you start Mail for the first time, you must:

= Create or connect to a postoffice.

= Create an account for yourself in the postoffice if the administrator has not set
up an account for you.

If an existing Mail version 3.0 postoffice has been assigned for your workgroup or
if someone in your workgroup has already created a WGPO, you must connect to
that postoffice. If you need to create a new postoffice, see “Creating a Workgroup
Postoffice” later in this chapter.

If you have already connected to a postoffice and created your account, see
“Signing In to Mail” later in this section.

Connecting to a Postoffice

Before connecting to a postoffice, ask the administrator for the path to the post-
office, and verify that your computer has enough available disk space for your
message file (MSMAIL.MMF). The required disk space depends on the number
and type of messages stored in your mailbox. A typical small mailbox requires
about 100K of disk space; a large mailbox might require several megabytes of
disk space.
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» To connect to a postoffice

1. From the Main group in Program Manager, choose the Mail icon.

Microsoft . .
e . Before you can use Mail. you must either

| connect to an existing postoffice or create
a new Workgroup Postoffice.

Postoffice Selection

@ Connect to an existing postoffice

" Create a new Workgroup Postoffice

2. In the Welcome To Mail dialog box, select the Connect To An Existing
Postoffice option button.

3. In the Network Disk Resources dialog box, select the postoffice you want to
connect to by doing one of the following:

= In the Network Path box, type the path of the postoffice in the form
\\computername\sharename; for example, type \\maria\wgpo.

= Or in the Show Shared Directories On box, select the computername for
your postoffice. Then in the Shared Directories On \\computername box,
select the shared directory for your postoffice.

4. Choose the OK button.

5. When Mail asks if you have an account on this postoffice, choose Yes if you
already have an account. You will be asked for your password.

Or choose No if you need to create an account. The Enter Your Account
Details dialog box appears, so you can create your account, as explained in the
following section.

Creating an Account

After you connect to a postoffice, you need to create an account. Before creating
one, check that the administrator has not already created an account for you.

» To create an account

e In the Enter Your Account Details dialog box, fill in the appropriate
information, as described in the following tables.
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Required Information to Create an Account

Item

Description

Name

Mailbox

Password

Type your full name, for example, Maria Smith. The maximum
length is 30 characters, and the default is the user name you entered
when you installed Windows NT.

Type a unique name with which you will sign in to Mail. Choose a
mailbox name that is easy to remember, for example, MARIAS. The
maximum length is 10 characters, and the default is your

Windows NT username.

Type a password. You will use this password and your mailbox
name to sign in to Mail. Choose a password that is easy to
remember. The maximum length is 8 characters, and the default is
PASSWORD.

Optional Information to Create an Account

Item Description

Phone #1 Type your phone number, for example, (206) 555-5555. The
maximum length is 32 characters.

Phone #2 If you have two phone numbers or a phone number and a fax, type
your second phone number. The maximum length is 32 characters.

Office Type your office location, for example, 205 to represent a room
number. The maximum length is 32 characters.

Department Type your department’s name, for example, Sales. The maximum
length is 32 characters.

Notes Type any comments about your account. The maximum length is

128 characters.
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After you create an account, Mail displays the Inbox, where your messages and
folders appear, as shown earlier in this chapter.

Signing In to Mail

When you create an account, you are signed in automatically. The next time you
start Mail, you sign in by typing your mailbox name and password. You can also
set up Mail to enter your mailbox name and/or password automatically when you
start it.

To sign in to Mail
1. In the Main group in Program Manager, choose the Mail icon.

2. In the Name box of the Sign In dialog box, type your mailbox name and then
press TAB.

Note The Postoffice Manager does not distinguish between uppercase and
lowercase letters; “MARIAS,” “MariaS,” and “marias” are considered to be
the same.

3. In the Password box, type your password and then press ENTER.

Mail displays your Inbox so that you can begin reading and sending messages,
as described in “Using Mail” later in this chapter.

To sign in to Mail automatically
1. In the Main group in Program Manager, choose the Mail icon.
2. From the File menu, choose Properties.

3. To have Mail automatically enter your mailbox name, at the end of the path in
the Command Line box, type a space and then your mailbox name. For
example, type c:\winnt\msmail.exe marias

Or to have Mail automatically enter your mailbox name and password, at the
end of the path in the Command Line box, type a space, your mailbox name,
another space, and then your password. For example, type
c:\winnt\msmail.exe marias secret

Important If security is important in your workgroup, record only your mailbox
name and not your password, so others cannot read your messages or send
messages under your name.
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Changing Your Password

For security, change your password regularly. If security is not a concern, you
don’t need to change it.

» To change your password
1. From the Mail menu, choose Change Password.
2. Type your old password, and then press TAB.
For security, you do not see the characters as you type them.
3. Type your new password, and then press TAB.
4. To verify the new password, type it again and then press ENTER.

If your second attempt to type the new password does not match the first, the
computer beeps; start over with a new password and then verify it.

Your new password is registered. You must use it the next time you sign in to
Mail.

Note If you forget your password, you must ask the postoffice Administrator to
define a new password for you.

Quitting Mail
There are two commands on the File menu you can use to quit Mail: Exit and Exit

And Sign Out. If Mail is the only application you are running that requires you to
sign in to your mailbox, both of these commands close Mail and sign you out.

If you are running another application such as Schedule+ that uses Mail to
communicate with your workgroup, the Exit command does not sign you out.
This allows the other application to continue using the postoffice when Mail is
closed. If you restart Mail, you don’t need to sign in.

The Exit And Sign Out command closes Mail and signs you out. This command
also closes any other application using Mail that might be running. If you restart
Mail, you will need to sign in again.

When you quit Mail, by default Mail permanently deletes all the messages in the
Deleted Mail folder. If you don’t want the messages in this folder deleted when
you quit Mail, turn off this option by choosing Options from the Mail menu.

» To quit Mail and sign out
e From the File menu, choose Exit And Sign Out.
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» To quit Mail and remain signed in

e From the File menu, choose Exit.

Using Mail

If other applications that use Mail are not running, the Exit command also
signs you out.

This section covers the basic steps for sending messages and working with
messages you receive, including the following topics:

Sending a message
Reading a message
Replying to a message

Deleting a message

Some advanced features of Mail are described at the end of this section.

Sending a Message

Sending a message involves a few simple steps: addressing it, typing a subject and

message, and then sending it.

Addressing a Message

The first step in sending a message is to open a Send Note form and choose the
users to whom you want to send the message.

» To address a message

1.

Click the Compose button, or from the Mail menu, choose Compose Note.

A Send Note form appears.




Chapter 7 Mail 211

2. Choose the Address button.

Mail displays the Address Book, which contains the names of users on your
postoffice.

For information about using the buttons in the Address Book and about using
shortcut keys, see the table following this procedure.

Andy MacKay
Bob Andrews
Bonita Gonzalez
Bruce Bergstrom

| Catherine Boll

| Connie Laine

{ Design Group
Gertrude Chorel

3. To locate usernames in the address list:

= Type the first few characters of a name. The address list scrolls to the first
name in the list with those characters and selects it. This is the fastest way
to find a name.

= Or click the scroll arrows in the scroll bar.
= Or press the arrow keys to scroll through the list.

4. To select a name that is highlighted in the list, choose the To button or press
ENTER.

The selected username is added to the To box.

5. To add names to the Cc list, repeat the steps for locating and selecting names,
and then choose the Cc button or press ENTER.

6. Choose the OK button.

The display shows the Send Note form with the selected name entered in the
To box. If you select a name from the Address Book, the name is underlined in
the Send Note form. The underline indicates that Mail verified the name in the
postoffice.
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Button Shortcut key Use

CTRLAL The Directory button to select a user directory from the
= list of available directories for postoffices and gateways
on your network.

CTRL+P The Personal Address Book button to display names and
groups in your Personal Address Book.

CTRLAF The Find button to find a name or first part of a name in
the current user directory.

CTRL+N The New Address button to add a new name and address

CTRL+A to your Personal Address Book or to address a message to

another mail system. You can add a gateway address plus
the name and address of a user on another mail postoffice.

You can copy the names of people to whom you often send messages from the
Postoffice List into your own Personal Address Book. If you often send messages
to the same group of people, you can choose Personal Groups from the Mail menu
to create a personal group name for them. When you include that group name on a
message’s recipient list, all the individuals in the group receive the message.

You can also address mail to users on another mail system if a gateway has been
added to your Mail network. A gateway is software that enables direct mail
systems to communicate with each other. When a message is sent from one mail
system to another, the gateway filters out information specific to the originating
mail system, attaches information the second mail system needs to deliver the
message, and sends the message on its way. If a gateway has been added to your
Mail network, its name appears in the Address Book.

Typing and Sending a Message

The next step is to type the subject and message text.

» To type a message subject and a message

1. In the Send Note form, click the Subject box, or press TAB until the insertion
point is in the Subject box, and then type a short description of the message.

If you make a mistake while typing, press the BACKSPACE key to erase the
error, and then continue typing.

2. Click anywhere in the message body, or press TAB, and then type the message
you want to send.

If the text reaches the right margin of the form, the next word automatically
moves to the next line; you don’t need to press ENTER at the end of each line.

The last step is to send the message.
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» To send a message

1. If you want to sei options for the message you are sending, choose the Options
button in the toolbar, and then select the options you want to set. For more
information about the Options dialog box, see online Help.

2. In the Send Note form, choose the Send button.

Reading a Message

The message header in your Inbox displays information about the message,
including who the message is from and the date and time it was received. Because
you haven’t read the new message, Mail displays a closed-envelope symbol and
shows the sender’s name in bold.

te Fold
3 Deleted Mail :
& Inbox |_1l*&3  Dave Byer New schedule 97297 |
O Sent mail || €8 Andy MacKay New inventory database 9/297|

» Toread a message

e Double-click the message in the Inbox. Or press TAB to move the highlight
from the Folders list to the message list; use the arrow keys to highlight the
message, and then press ENTER.

The message appears in a Read Note form.
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File Edit View Mail Window Help

Message
heading

INYNTORY HLS
This Microsoft Excgl spreadsheet itemizes our available stock as of this morning.
Flease refer to it whign taking orders.

-Andy

\ Attached file

The gray area at the top of the form is the message heading, which shows who
sent the message, when it was received, the people or groups it was sent to, and
the message subject.

Attached files appear in messages as icons. An attached file can contain any kind
of data, including text, graphics, a spreadsheet, executable code, and so on. If you
have the application used to create the file, you can open the file while reading the
message by double-clicking the icon.

Note To avoid introducing a computer virus, you should use the same care when
opening or activating an attached file or object in a message that you do when
opening or activating a file or object from the network or a floppy disk.

Replying to a Message
After reading a message, you may want to send a reply. The Reply button or com-
mand automatically addresses the message to the person who sent it and includes

the original message in the message body. Including the original message is
useful because you can add comments above or within the original message.

> To reply to a message
1. Choose the Reply button, or from the Mail menu, choose Reply.

If you want to reply to everyone who received the original message, choose
the Reply All button.
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A Send Note form appears. The name of the original sender appears in the To
box, and the title of the original message appears in the Subject box, preceded
by the prefix RE: (for “reply”). The original message is included in the form,
below the solid line.

2. At the top of the message box, type your reply.

3. If you want to insert comments within the message you received, use the arrow
keys to move the insertion point to where you want to enter a comment. Press
ENTER to start a new line after the original message, and then type the
comment you want to insert.

4. Choose the Send button.

Edit View Mail Window Help

RE: New Inventory Database

Thanks for preparing this so guickly!

|From: Anchy MacKeay

[To: Dawve Byer. Tim O'Reilly

|Subject: New inventory database

|Date: Wednesday, September 30, 1992 10:25AM
l

I
[¢«<File Attachment: INVINTORY XLS>>

Deleting a Message

To manage the number of messages in your Inbox, you should delete messages
you’ve already read and no longer need.

» To delete a message from the Inbox
1. In the Inbox, select the message you want to delete.
2. Click the Delete button, or from the File menu, choose Delete.

The message is moved to the Deleted Mail folder, where you can retrieve it
until it is deleted there. By default, Mail deletes messages in the Deleted Mail
folder when you quit Mail. To change this option, choose Options from the
Mail menu.



216 System Guide

Advanced Features of Mail

This section presents some advanced features of Mail. Use Help to find more
details.

Attaching Files and Embedding Objects

You can choose the Attach button from the toolbar to send one or more
application files, such as Microsoft Word or Microsoft Excel documents, or batch
files, programs, graphics files, or any other files that are available to you.

Mail displays the Attach dialog box, where you can select a file to attach in the
same way that you select a filename in the Open or Save As dialog boxes.

Mail also includes object linking and embedding (OLE) capability, so you can
copy parts of formatted documents from other applications, such as spreadsheets
and word processing, into a message without losing formatting. You embed or
link an object in a Mail message in the same ways as you do in any application
with OLE capabilities. For information, see Chapter 7, “Object Linking and
Embedding.”

Creating Message Templates

If you send a specific message on a regular basis, such as a weekly progress
report, you can set up a Send Note template for the message and basic addresses.

» To create a message template

1. Choose the Compose button on the toolbar, or from the Mail menu, choose
Compose Note.

2. Address the message to the people you will be sending it to regularly, and type
the subject and template information.

3. Close the message window by double-clicking the Send Note window’s close
box or by pressing CTRL+F4.

4. When Mail asks if you want to save the message, choose the Yes button.

Mail displays the template message in your Inbox, but you can move this
message to any folder.

» To use a message template
1. Display the message template by doing one of the following:
= Drag the message header to the Outbox icon.
= Or select the message, and from the Mail menu, choose Forward.
2. Fill in the message. If necessary, change the list of recipients.
3. Choose the Send button.



Chapter 7 Mail 217

Finding Messages

You can choose Message Finder from the File menu to search for messages you
stored in Mail folders. You can also keep multiple Message Finder windows
minimized on the Mail workspace, each with its own search criteria. Then, when
you want to search for a message with the criteria, maximize the icon.

Microsoft Mail - [Message Finder 1]
File Edit View Mail Window Help

Using Folders

Mail stores your private messages in folders that you create and manage using the
New Folder and Folder Properties commands from the File menu. Your private
messages are stored on your hard disk. Shared folders are stored in your
postoffice and can be accessed by other users in your postoffice.

Mame:
[
~Type

@ Private

“Level
" Top Level Folder
@ Subfolder OF:

ystem News
£ Templates
£ Workgroup News
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Working Offline

You may want to create new messages or work with messages you received
without being connected to the postoffice (for example, while you are traveling or
working at home). If you have Mail installed on your computer, you can compose
and work with messages without being connected to the postoffice. This is called
working offline.

To move your message file to a computer or disk from your postoffice
1. From the Mail menu, choose Options.

2. In the Options dialog box, choose the Server button.

3. In the Storage box, select the Local option button.
4

. In the File box, type the path to the drive or directory where you want to save
your message file, and then choose the OK button.

To work offline

1. Start Mail on a computer that is not connected to the postoffice.

2. In the message that asks if you want to work offline, choose the OK button.
3. Type your password in the dialog box, and then choose the OK button.

4. If Mail cannot find your message file, specify the path to it.

After you finish composing a message, choose the Send button. The message is
moved to the Outbox. To move it to the postoffice when you resume working
online, follow the procedure above for copying your message file to a computer or
disk, but choose the Postoffice option instead of the Local option. When you
connect to the Mail system, the messages in your Outbox are sent automatically.

Defining Other Mail Options

You can choose the Options command from the Mail menu to define various
preferences for sending mail, checking for new mail, choosing the server, and
emptying the Deleted Mail folder. For more information, see Help.
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c di

Save copy of outgoing messages in Sent Mail folder
[ Add recipients to Personal Address Book
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Setting Up the Mail System

The following sections explain the concepts and procedures related to setting up
and administering Mail in Windows NT and using Mail with other networks and
other messaging systems. The rest of this chapter is written for the administrator
who is responsible for creating and managing the Workgroup Postoffice.

Planning a Workgroup Postoffice

Before your workgroup can use Mail, each user needs to connect to a postoffice.
If your workgroup does not have an existing postoffice, an administrator in your
workgroup needs to create and manage a WGPO using the Postoffice Manager.

This section describes the Mail messaging system and the Workgroup Postoffice
to help you plan your WGPO.

The Mail Messaging System

The Windows NT messaging system consists of the Mail application and the
WGPO. The Mail application runs on each user’s computer, and the WGPO is
stored in a shared directory on a computer running Windows NT.

If your company already has a messaging system, you can use the Mail
application with the postoffice or messaging (mail) server that is part of that
system. For information, see “Using Mail with Other Messaging Systems” later in
this chapter.

The WGPO contains all the information about Mail user accounts and serves as a
collective mail-drop facility for users in your workgroup. To communicate, users
must be connected to the same postoffice and have an account on that postoffice.
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The following figure shows three users in a workgroup with a WGPO. Maria
Smith, Peter Black, and Isabelle Johnson belong to a workgroup called
Engineering. To allow users in the Engineering workgroup to use Mail, Maria
created a WGPO on her computer and accounts for herself, Peter, and Isabelle.
Because she created the WGPO, she will be its administrator. Maria, Peter, and
Isabelle use their respective computers to run Mail, and their message files are
stored on their computers as well. They can now use Mail to send messages and
files to each other.

Engineering Workgroup

Postoffice

Maria Smith Isabelle Johnson

Peter Black

Two users connected to different WGPOs cannot exchange messages.

The following figure shows a new workgroup that includes the original
Engineering workgroup and two new users from Marketing, Sam and Ana. Sam
created another WGPO on his computer, and he created accounts for himself and
Ana. In this configuration, Maria, Peter, and Isabelle can communicate with each
other. Similarly, Sam and Ana can communicate. However, Sam and Ana cannot
communicate with Maria, Peter, and Isabelle because they are not connected to
the same postoffice.
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Eng-Mktg Workgroup

Because there are two postoffices in this
workgroup, Sam and Ana cannot communicate
with Maria, Peter, and Isabelle.

Postoffice
Postoffice

Maria Smith Ané Freeman

Peter Black

Sam White

Isabelle Johnson

If Sam deletes his postoffice and Maria creates accounts for Sam and Ana on her
postoffice, all five can communicate with each other.

You can create a WGPO on a computer that is part of your workgroup, on a
Windows NT Advanced Server, file or on an exitsting network such as Novell
NetWare.

The following figure shows the Engineering workgroup connected to a postoffice
that is part of an existing messaging system. For this configuration, the
administrator of the existing messaging system is responsible for setting up and
configuring the postoffice. Each member in the Engineering workgroup needs to
connect to that postoffice, as explained in “Starting and Quitting Mail” earlier in
this chapter.
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Engineering Workgroup

Postoffice on
another mail
system

Maria Smith

Peter Black Isabelle Johnson

Planning for Disk Space
Before creating a WGPO, verify that your computer meets the following
requirements.

On the computer where the WGPO will be installed, there must be:

= 360K of available disk space for an empty postoffice.
= 16K of available disk space for each user account.

On each user’s computer, there must be:

= Enough available disk space for each user’s mailbox, depending on the
number and type of messages stored in a mailbox. A typical small mailbox
requires about 100K of disk space; a large mailbox can use several megabytes
of disk space.

Creating the Postoffice and the Administrator Account

After you verify that the computer has enough disk space to create a WGPO, you
can create a WGPO and an Administrator account. The Administrator account is
the first account you create in the WGPO. After you create the Administrator
account, you can modify it, but you cannot remove it.

This section describes how to create the WGPO on a Windows NT workstation or
Advanced Server. If you want to create the WGPO on a network server, see
“Using Mail with Other Networks” later in this chapter.
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Important The computer where you create a WGPO must be turned on at all times
so that users can exchange mail.

You should create only one WGPO per workgroup. Only the users connected to
the same WGPO can communicate with each other.

» To create a WGPO and the Administrator account
1. Start Mail.

If a WGPO has not been assigned to your workgroup, Mail starts the
Workgroup Postoffice Manager and displays the Welcome To Mail dialog
box, as described in “Connecting to a Postoffice” earlier in this chapter.

2. In the Welcome To Mail dialog box, select the Create A New Workgroup
Postoffice option button, and then choose the OK button.

A message reminds you that there should be only one WGPO in a workgroup
and that you will be responsible for managing any new WGPO you create.
3. To create a new postoffice, choose the Yes button.

Or choose No to return to the Welcome To Mail dialog box so that you can
connect to an existing postoffice.

4. In the Create Workgroup Postoffice dialog box, select a location for the
WGPO. You can create the WGPO either on your hard drive or on a network
server:

= To create the WGPO on your hard drive, select a drive from the Drives box
and a directory from the Create WGPO In list, and then choose the OK
button.

= Or to create the WGPO on a network server, choose the Network button,
and select a server and shared directory from the dialog box, and then
choose the OK button.

Create WGPO in:
c:\ sharedir
= c:\ sharedir

€1 wapo
1 documents

[+
Drives:

| c: main

5. In the Administrator Account Details dialog box, fill in the appropriate
information to create the Administrator account.
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The requirements and optional information in this dialog box are the same as
those described in “Creating an Account” earlier in this chapter.

When you fill in this dialog box, type names that are easy to read. You can use
extended characters (such as letters with accents), but it is not recommended.
Only alphanumeric characters are allowed in the Mailbox and Password boxes.
The Postoffice Manager is not case-sensitive; that is, “MARIAS,” “MariaS,”
and “marias” are considered to be the same.

6. Choose the OK button.

When the message reminds you to share the WGPO directory that you just
created, choose the OK button.

Important If you are not able to create a WGPO, it is probably because you don’t
have enough disk space or, if you are creating the WGPO on a server, because
you don’t have write permission on that server. In either case, the solution is to
find another location with enough disk space and where you have sufficient
privileges to create the WGPO.

Sharing the Workgroup Postoffice

After you create a WGPO, you must share the WGPO directory that contains the
data files with all users on the postoffice.

» To share a Workgroup Postoffice on a Windows NT Workstation
1. Open File Manager and select the WGPO directory.
From File Manager’s Disk menu, choose Share As.
In the Share Name box, type a name for the postoffice. The default is WGPO.
Select the Re-share At Startup check box.
Under Access Type, select the Full Access option button.
Optionally, under Passwords, type a full access password for the WGPO.
Choose the OK button.

A

» To share a WGPO on a Windows NT Advanced Server

1. Create a directory on the LAN Manager server where the WGPO will be
located. This can be a domain controller or backup server.

2. Share the directory you just created. Make sure you don’t share the parent
directory.

3. Provide full access permissions to the directory.

4. Create a WGPO as explained in “Creating a Workgroup Postoffice” earlier in
this chapter.
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Note After you create a WGPO, the Postoffice Manager command appears on the
Mail menu when you start Mail. This command appears only on the computer
where you created the WGPO. If you want to run the Postoffice Manager from
another computer in your workgroup, you must r odify your MSMAIL32.INI file
as explained in “Managing Your Workgroup Po: >ffice” later in this chapter.

Creating a Workgroup Postoffice

This section explains how to create a Workgroug Postoffice (WGPO). The person
who creates the WGPO should plan to manage it. Creating the WGPO requires
that you complete the following actions:

= Verify that there is enough disk space on the computer where you will install
it.
= Create the WGPO and an account for the administrator.

= Share the WGPO so that all users in your workgroup can use it.

Managing Your Workgroup Postoffice

After you create a WGPO and an Administrator account, you can manage the
WGPO with the Postoffice Manager.

Important Only the administrator can run the Postoffice Manager. The
administrator can manage the "“VGPO from any computer in the workgroup. For
instructions, see “Workgroup 'ostoffice Installation Results” later in this chapter.

With the Postoffice Manager, you can complete the following actions:

= Add users to the WGPO

= Modify existing user accounts

= Remove users from the WGPO

= Manage the disk space where the WGPO is stored

You may also need to change the name of the WGPO, move or remove a WGPO,
or manage the Mail system files, as described in this section.
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Starting the Postoffice Manager

Before you can start the Postoffice Manager, you must start Mail.

» To start the Postoffice Manager

e From the Mail menu, choose Postoffice Manager.

In the Postoffice Manager dialog box, you can add users, modify user
accounts, and remove users.

Adding a User

To add a user to a WGPO, you must provide the user’s name, mailbox name, and
password. Optionally, you can also provide the user’s phone number(s), office
location, department, and comments about the user’s account.

Note Users who do not have an account on the WGPO can each create their own
account. If you create the account, be sure to give the account information to the
user.

» To add a user
1. From the Postoffice Manager dialog box, choose the Add User button.

2. In the Add User dialog box, fill in the appropriate information, and then
choose the OK button.

For a complete description of the entries in the Add User dialog box, see
“Creating an Account” earlier in this chapter.
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Modifying a User Account

With the Postoffice Manager, you can modify any information about the user’s
account.

» To modify a user account

1. From the Postoffice Manager dialog box, select the username you want to
modify.

2. Choose the Details button.

A dialog box appears, showing the user’s account information, which identical
to the information defined in “Creating an Account” earlier in this chapter.

3. Change the appropriate entries, and then choose the OK button.

Removing a User

With the Postoffice Manager, you can remove a user from a WGPO.

Note You cannot remove the Administrator account.

» To remove a user

1. From the Postoffice Manager dialog box, select the username you want to
remove.

2. Choose the Remove User button.

When the message asks you to confirm that you want to remove the selected
username, choose the Yes button.

Managing Disk Space

One of the most important administrative tasks is managing the disk space where
the WGPO is stored. To manage disk space, you need to check the current status
of shared folders and recover unused disk space by compressing shared folders.

A shared folder is a public folder stored in the WGPO directory, unlike users’
private folders, which are stored on their own computers. All users in a
workgroup can open shared folders and see the messages they contain. Any user
in the WGPO can create a shared folder and choose the appropriate access
permissions (Read, Write, or Delete).

By checking the status of shared folders, you determine the following:

»  The number of shared folders

= The number of messages stored in shared folders
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= The amount of disk space the messages use

» The amount of disk space you can recover by compressing shared folders

» To check the status of shared folders
e From the Postoffice Manager dialog box, choose the Shared Folders button.

The Shared Folders dialog box shows the current status of shared folders in a
WGPO.

Compressing shared folders recovers disk space. When the Mail system runs out
of disk space, this is the first step to take. If you still require more space, you can
delete old messages and unused folders. You might also need to move the WGPO
to a different location (see “Moving a Workgroup Postoffice” later in this
chapter.)

If the shared folders contain a large number of messages, the compression process
may take a long time.

» To compress shared folders

Important Do not attempt to compress shared folders while others are using them.

1. Before compressing a shared folder, ask all users in a workgroup to close the
folder.

2. From the Postoffice Manager dialog box, choose the Shared Folders button.
3. In the Shared Folders dialog box, choose the Compress button.
4. Choose the Close button.
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Changing the Name of a Workgroup Postoffice

You may need to change the name of a WGPO. For example, if you are part of a
large company where someone else created a WGPO with the same name as
yours, either you or the administrator of the other WGPO needs to change the
name of one of the WGPOs.

Before you rename a WGPO, inform users in the workgroup that they cannot
exchange messages until they reconnect to the renamed WGPO.

» To rename a Workgroup Postoffice

1.

Ask all users in the workgroup to exit and sign out of Mail.

2. Open File Manager and select the WGPO directory.
3.
4. In the Share Name box, type the new name for the WGPQO, and then choose

From File Manager’s Disk menu, choose Share As.

the OK button.

Edit the ServerPath= entry in the [Microsoft Mail] section of the
MSMAIL32.INI file to reflect the new name of the WGPO, in the following
format:

ServerPath=drive:\directory or ServerPath=\\computername\sharename

For example, serverpath=d:\wgpo or serverpath=\\domain1\wgpo.

If the shared directory had a password, you need to delete or edit the entry
specifying the password for the shared directory.

. Ask users in the workgroup to edit the ServerPath= entry in the [Microsoft

Mail] section of their MSMAIL32.INI files to reflect the new name of the
WGPO, in the following format:

ServerPath=\\computername\sharename

For example, serverpath=\\domainl\wgpo.

They may also need to delete or edit an entry specifying a password for the
shared directory.

Important Before altering an MSMAIL32.INI file, you should always make a
backup copy in case you run into problems. After altering the MSMAIL32.INI
file, you must restart Mail for the changes to take effect.
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Moving a Workgroup Postoffice

You may need to move a WGPO to a different location—for example, if the
computer where you installed the WGPO runs out of disk space.

Before you move a WGPO, inform users in the workgroup that they cannot
exchange messages until they reconnect to the relocated postoffice.

» To move a WGPO

1.

Ask all users in the workgroup to exit and sign out of Mail.

2. Open File Manager and select the WGPO directory.
3.
4. In the To box, type the new path for the WGPO, and then choose the OK

From the File menu, choose Move.

button.

Share the WGPO as explained in “Creating a Workgroup Postoffice” earlier in
this chapter.

. Complete steps 5 and 6 as described in the previous procedure to update the

ServerPath= entry in the [Microsoft Mail] section of MSMAIL32.INI to
reflect the new WGPO’s location. The changes must be made for both the
computer that contains the WGPO directory and for each user.

Removing a Workgroup Postoffice

You may need to remove a WGPO that you just created, for example, if
something goes wrong while you are creating it so that you have to re-create it.

Before you remove a WGPO, inform users in the workgroup that they cannot
exchange messages until they reconnect to a new postoffice.

» To delete a WGPO

1.
2.

Delete the WGPO directory tree.

Delete the following entries from the [Custom Commands] section of
MSMAIL32.INT on the computer that contains the WGPO:

WGPOMgr1=3.0;Mail;;13
WGPOMgr2=3.0;Mail;&Postoffice Manager...;14;
WGPOMGR.DLL;0;;Manage Workgroup Postoffice;MSMAIL.HLP;2870
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Managing the Mail System Files

When you create a WGPO or when users connect to a postoffice, the Mail system
files are modified. The Mail system files are the following:

= The message file, MSMAIL.MMF

This file stores messages, message folders, and the Personal Address Book for
the user. The WGPO updates this file when it receives messages. The message
file for each user is stored on his or her computer. Your message file is located
in the directory where Windows NT was installed (the default is CA\WINNT).

= The Mail file, MSMAIL32.INI

This file contains information that controls the way Mail works. Each user’s
MSMAIL32.INI file is located in the directory where the user installed
Windows NT (the default is CAWINNT).

The Mail system files are automatically managed by Mail, so you shouldn’t need
to alter them unless you want to change specific functionality or you want to
restore these files to a particular state.

The following sections describe how these files are modified when you create a
WGPO and when a user connects to a WGPO. They also describe how to back up
and restore the Mail system files.

Workgroup Postoffice Installation Results

When you create a WGPO, the Postoffice Manager makes the following changes
to the system files for the Administrator account:

= The WGPO directory is created in the specified location.

= The following entries are added to the [Custom Commands] section of
MSMAIL32.INI:
WGPOMgr1=3.0;Mail;;13
WGPOMgr2=3.0;Mail;&Postoffice Manager...;14;
WGPOMGR.DLL;0;;Manage Workgroup Postoffice;MSMAIL.HLP;2870

These entries instruct Mail to display the Postoffice Manager command in the
Mail menu when you start Mail on the computer where you created the
WGPO. This command appears only on the computer from which you created
the WGPO. If you want to run the Postoffice Manager on another computer,
you must add these entries to the MSMAIL32.INI file on that computer.

= A message file is created for the Administrator account, with the default name
of MSMAIL.MMF.
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= It adds the following entries to the [Microsoft Mail] section of
MSMAIL32.INI:

ServerPath=drive:\directory
Login=mailbox_name

Workgroup Postoffice Connection Results

When users connect to a WGPO, the Postoffice Manager makes the following
changes to their system files:

= A message file is created for the user, with the default name of
MSMAIL.MMF.

= The following entries are added to the [Microsoft Mail] section of
MSMAIL32.INTI:

ServerPath=\\computername\sharename
Login=mailbox_name

Backing Up and Restoring the Mail System Files

After the Mail system files have been created, Mail automatically manages them
for each user. In general, you don’t need to alter the Mail system files; however,
you might want to restore them to a given state or alter them to change the way
Mail works.

You should back up the Mail system files regularly. Then, if there is a problem,
you can recover your mail and the Mail environment from the last backup copy.
The following procedures exp :in how to back up and restore your
MSMAIL.MMEF file and restc = all folders in your mailbox.

If you want to back up or restcie only some of the folders in your mailbox, use the
Export Folder and Import Folder commands. For information about using Export
and Import, see Help.

» To back up your MSMAIL.MMF file

1. From the Mail menu, choose Backup.

2. In the File Name box, specify the name and location of your backup file; for
example, CAUSER\MARIA.MMF.

3. Choose the OK button.

» To restore an MSMAIL.MMF file

1. Open File Manager and select the backup copy of your message file.
2. From the File menu, choose Rename.

3. In the To box, type ¢c:\WINNT\msmail.mmf (assuming that, by default, you
installed Mail in the same directory that contains your Windows NT files).
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4. Choose the OK button.

The backup file becomes your message file, and your mailbox displays the
messages and folders you had when you last backed up the file. New messages
that you received after you backed up the message file will not appear in your
Inbox.

» To back up an MSMAIL32.INI file

1. Open File Manager and select the MSMAIL32.INI file, which is located in the
directory where you installed Mail (the default is CAWINNT).

2. From File Manager’s File menu, choose Copy.
3. In the To box, type a name for the backup file; for example, msmail.old.
4. Choose the OK button.

To restore an MSMAIL32.INI file, you can rename a backup copy, if you have
one, or you can edit your existing MSMAIL32.INI file. How you edit the file
depends on whether you created a WGPO or are connected to one.

» To restore an MSMAIL32.INI file after creating a WGPO

e If you made a backup copy of an MSMAIL32.INI file, rename it to
MSMAIL32.INI, and move it to the directory where you installed Mail (the
default is CAWINNT).

—Or—
1. If you don’t have a backup copy, remove the following entries from the
[Custom Commands] section of MSMAIL32.INI:

WGPOMgr1=3.0;Mail;;13
WGPOMgr2=3.0;Mail;&Postoffice Manager...;14;
WGPOMGR.DLL;0; ;Manage Workgroup Postoffice;MSMAIL.HLP;2870

2. Remove the following entries from the [Microsoft Mail] section of
MSMAIL32.INI:

ServerPath=drive:\directory
Login=mailbox_name
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» To restore an MSMAIL32.INI file after connecting to a WGPO

e If you made a backup copy of the MSMAIL32.INI file, rename it to
MSMAIL32.INI, and move it to the directory where you installed Mail (the
default is CAWINNT).

—Or—

e If you don’t have a backup copy, remove the following entries from the

[Microsoft Mail] section of MSMAIL32.INI:

ServerPath=\\computername\sharename
Login=mailbox_name

Important If a message file becomes corrupted, a message appears with this
information and also presents an option to repair the file. The user or the
Administrator for the postoffice can repair the file immediately or quit mail and
repair it later. However, the user cannot use Mail until the corrupted file is
repaired.

Restoring a User’s Password

If a user forgets a password, the Administrator for the postoffice can define a new
password.

» To define a new password for a user
1. Sign in to Mail and start the Postoffice Manager.

2. In the Postoffice Manager dialog box, select the name of the user, and then
choose the Details button.

3. In the Password box, type a new password, and then choose the OK button.

4. In the Postoffice Manager dialog box, choose the Close button.

The user can now sign in to Mail with the new password.

Caution If the Administrator for the postoffice forgets the password, that
password cannot be recovered. The Administrator must create a new WGPO.
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Using Mail with Other Networks and Other Messaging Systems

You can also create a Workgroup Postoffice on a file server that is part of an
existing network, such as a Novell NetWare server.

If you want to use Mail with another network, you need to set up support for that
network in Windows NT, using the Control Panel. For information about the
necessary drivers and any further instructions, contact your network vendor.

Using Mail with a NetWare Network

To use Mail with a Novell NetWare network, you need to create a WGPO on a
NetWare server and grant full trustee rights to the WGPO directory.

» To create a WGPO on a NetWare server

1.
2.
3.

Create a directory on the NetWare server where the WGPO will be located.
Grant full trustee rights to this directory.

Use the Control Panel to set up NetWare support in Windows NT, as described
in “Configuring the Network” in Chapter 4, “Control Panel.”

4. Restart Windows NT.

Log on to your NetWare server.

Use File Manager to assign a drive letter to the NetWare directory where you
want to create the WGPO.

Create the WGPO as explained in “Creating a Workgroup Postoffice” earlier
in this chapter.
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CHAPTER 8

Schedule+

Overview

Schedule+ is a personal scheduling tool that you can use to track important
appointments and tasks, block out time for meetings, and record notes.

This chapter describes the basic features and how to use Schedule+ in the
following topics:

= An overview of Schedule+

= Using the Appointment Book

= Using the Task list

= Using the Planner to schedule a meeting

= Using the Messages window to schedule a meeting

= Advanced features of Schedule+

Although this chapter contains the basic information you need to use Schedule+,
your main source of information is the online Help. To get help, press FI wherever
you are working in Schedule+.

Schedule+, which you can choose to install on your system when you install
Windows NT, can be used to schedule individual events and tasks, and to set
automatic reminders for events.

Schedule+ can also be used as a workgroup scheduling tool. When you need to
meet with coworkers, you can view the times they are available. Then you can
schedule the meeting in one step—without leaving your desk or contacting each
person individually.

You can also designate another Schedule+ user as your assistant, who can
schedule appointments and set up meetings for you.
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A scheduling tool is most effective when it’s always accessible for reference and
for recording impromptu appointments. With Schedule+, you can print copies of
your schedule, and you can use Schedule+ from a portable or home computer that
has the software installed.

In Schedule+, you can work online or offline, and then merge your changes into
the copy of your schedule on the postoffice later. For more information, see
“Advanced Features of Schedule+” later in this chapter.

Starting and Quitting Schedule+

You use your mailbox name and password to sign in to Schedule+. (If you are
already signed in to Mail, you won’t be prompted to sign in.)

» To start Schedule+ and sign in

1. From the Main group in the Program Manager, choose the Schedule+ icon.

2. In the Name box of the Sign In dialog box, type your mailbox name and press
TAB.

3. In the Password box, type your password for Mail, and then press ENTER.

When you're finished working with Schedule+, you can either quit Schedule+ or
quit and sign out.

» To quit Schedule+ and keep running Mail and Reminders
e From the File menu, choose Exit.

Choose this method to quit if you want to continue using Mail or receiving
reminders while you aren’t working with Schedule+.

» To quit Schedule+, Mail, and Reminders
e From the File menu, choose Exit And Sign Out.

Choose this method to quit if you're finished working with Schedule+, Mail,
and the Reminders program (MSREMIND.EXE), which tracks reminders you
set and notifies you in advance of these events. The next time you start
Schedule+, the Reminders program starts automatically. (If any reminders
were set to occur during the time that Reminders wasn’t running, they won’t
be displayed when you start Schedule+.)
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Organizing Your Screen

Organizing the workday requires two types of tasks: scheduling events and
communicating with coworkers about scheduled events. Schedule+ provides a
window for each type of task:

= The Schedule window. This window has your name on the title bar and tabs on
the left side for your Appointment Book (Appts), Planner, and Task list
(Tasks). When you want to work with your appointments or tasks, schedule
meetings with others, or schedule a conference room or other resource, you
work in the Schedule window.

= The Messages window (if your computer is connected to your postoffice).
When you receive meeting requests or replies to your meeting requests, the
messages appear in this window.

» To display the Schedule window

® From the Window menu in Schedule+, choose your name.

The Schedule window is where you
schedule events, tasks, or resources.

File Edit Appointments Tasks Options Window Help

In this example, the Messages
window is represented as an icon.



240

System Guide

» To display the Messages window

e From the Window menu, choose Messages. Or double-click the Messages icon
to restore the window.

For more information about the Messages window, see “Using the Messages
Window to Schedule Meetings” later in this chapter.

Using the Appointment Book

The Appointment Book displays your daily schedule. A time slot can contain a
combination of appointments and tentative appointments. Appointments appear as
“busy” times on your schedule when other users view it. Tentative appointments
appear in gray time slots in the Appointment Book and don’t appear as busy times
on your schedule.

Time slots Appointments Calendar

Order new equipment

Lunch with team

| Pick up package

00| Revize annual report

Tentative Notes box
appointments

If you have an appointment that occurs regularly, you can schedule it once in your
Appointment Book and designate it as recurring. Schedule+ automatically sched-
ules the remaining occurrences in your Appointment Book.

You can also set Schedule+ to remind you before specific appointments or before
all appointments, and you can designate specific appointments to be private so
that other users can see that you are not available during that time, but they cannot
see the description of your appointment. Schedule+ puts icons in time slots
containing recurring appointments, meetings, private appointments, or
appointments with reminders.
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You can change the date you’re viewing by choosing a new one in the calendar
next to your appointments, and you can quickly return to today’s date by choosing
the Today tab on the left. You can also leave yourself notes for any day by typing
them in the Notes box for that day.

Adding an Appointment

You can add up to six appointments and tentative appointments for a particular
time slot. You can also set options to control which users (if any) can view your
appointments from their Appointment Book.

» To add an appointment to your Appointment Book
1. If your Appointment Book is not already displayed, click the Appts tab.

To maximize the Schedule window, double-click the title bar or press ALT,
HYPHEN, X. To restore your Schedule window to its original size, double-click
the title bar again or press ALT, HYPHEN, R.

2. If you need to change the date, from the Edit menu, choose Go To Date. In the
Go To Date dialog box, type the new number for the month, day, and year
over the existing numbers. Then choose the OK button or press ENTER.

Or click the month box in the top right corner of the Appointment Book to
display a menu, and then click the month you want. Then click the year box to
display a menu, and then click the year you want. Finally, in the calendar,
click a number to change the date.

Notice that the status bar at the bottom of the Schedule+ workspace displays
the selected time slot.

3. To select the appointment time, drag across the numbers in the appointment
list.

Or press SHIFT+TAB to move the selection to the appointment list, if it is not
already there. Press the DOWN ARROW until the time slot you want is
highlighted, and then press SHIFT+DOWN ARROW to include the all time slots
you want in the selection.

4. In the selected time slot, type text to describe the appointment.

» To set a reminder for the appointment

1. Double-click the time slot for the appointment. Or select it and then, from the
Edit menu, choose Edit Appt.
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~wWh
Start: [9: 00AME] [Frii 12/11792[] [Choose |

End: [ 9:30AMPE [Fri 12/11792[F [ Tentative

Description:

Status Meeting

oré@ MB-E Beforehand

[ Private

2. In the Appointment dialog box, select the Set Reminder For check box.

Schedule+ automatically enters 15 minutes for you, but you can specify a
different amount of time.

You can also change the text in the Description box of the Appointment dialog
box. The change will appear in your Appointment Book.

To return to the Appointment Book, choose the OK button.

A small bell icon appears in the time slot of the appointment in the
Appointment Book, indicating that you set a reminder.

This bell icon shows that
/ a reminder was set.

;ﬁfzStats Meeting . » I

You can choose General Options from the Options menu to specify whether
Schedule+ automatically sets reminders for all new appointments and tasks. When
you remove the reminder option, you must specifically set reminders for any
appointments and tasks you want to be reminded of.

Adding a Tentative Appointment

When you add an appointment to the Appointment Book, that time is blocked out
in your Planner. When other people view your Planner to set up a meeting, they
know that you’re not available at that time. Sometimes, though, you might want to
schedule an event in your Appointment Book but still leave yourself available for
appointments during that time slot. For these times, you can add a tentative
appointment to your Appointment Book.



Chapter 8 Schedule+ 243

Tentative appointments appear in gray time slots in your Appointment Book, and
they do not appear in your Planner. When other people look at your schedule, you
appear to be available for meetings during that time slot.

» To add a tentative appointment
1. In your Appointment Book, select the time slot you want.
2. Type text to describe the tentative appointment.
3. Double-click the time slot. Or from the Edit menu, choose Edit Appt.
4

. In the Appointment dialog box, select the Tentative check box, and then
choose the OK button.

Your Appointment Book now displays the tentative appointment in a gray time
slot. When you or other viewers look at your Planner, you don’t see the tentative
time slot marked as busy, so it appears that you are available for meetings during
this time. Except for being “invisible” in your Planner, tentative appointments are
just like regular appointments—you can set the same options for either type.

If you decide later to make this tentative appointment a regular appointment, you
can clear the Tentative check box for the appointment. When you clear the
Tentative check box, the appointment appears as a regular appointment.

Adding a Recurring Appointment

If you have a meeting that occurs regularly, you can have Schedule+ enter it
automatically on the appropriate days. You can designate a new or existing
appointment to be recurring. For example, if you attend a staff meeting that
occurs every other Monday, you can book that time on your schedule for a year.

» To add a recurring appointment

1. If the Appointment Book is not already displayed, click the Appts tab or press
ALT+A.

2. From the Appointments menu, choose New Recurring Appt.

3. In the Recurring Appointment dialog box, choose the Change button.
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~This Appointment Dccurs
Every Fri starting 12/11/92

Start: | 9: 0DAM @ End:| 9:30AM E [] Tentative

Description:

—

i
w
-
3
=N

(4 Set Reminder forIEl inute(
[ Private

4. In the Change Recurrence dialog box, select the appropriate option button to
specify whether this appointment should occur daily, weekly, biweekly,
monthly, or yearly.

Every Week On:
[dSun [JMon []Tue
OOwed []Thu [JFri []Sat

y!
7y Bi-Weekly
> Monthly
) Yearly

Mo dates match this pattern.

—Duration

Starts [Fri 127117928 O Ends [Sat 127117931

@ No End Date

5. If the meeting occurs every week, select one or more check boxes to specify
the day on which the meeting occurs.

6. In the Duration box, specify a date for when the recurring appointment begins.

7. If there’s an end date for the recurring appointment, in the Duration box, select
the Ends option button and enter a date in the text box.

Otherwise, select the No End Date option button.
8. Choose the OK button.

You can also designate an existing appointment to be a recurring appointment by
selecting it and then performing the steps described above.
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Using the Task List

When you are working on a task over a period of time, you can track it in the
Schedule+ Task list. To reserve time for working on a particular task during the
day, you can copy it to a specific time slot in your Appointment Book.

Sat, Jun 26, 1993 Send memo to team
Sales Report

Callouts: 1:Project name 2: Priority controls 3: Task

Adding a Task to the Task List

Your Task list helps you keep track of tasks over a period of time. When you
create a task, you give it a priority letter or number. If you need to complete the
task by a certain date, you can note that, too. Tasks can be sorted by priority, due
date, or alphabetically by description. You can group related tasks into projects,
and then sort them by project.

> To add a task to the Task list
1. Display the Task list by clicking the Tasks tab or pressing ALT+T.
2. In the New Task box of the Task list, type text to define the task.
3. Choose the Add button to add the new task to your Task list, or press ENTER.
4

. If you want to define a due date for the task, from the Task list, double-click
the task, or select it and choose the Edit button.
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10.

Description: ﬁvrile memo to marketing |

Project: |Sales Report I

Due Date: | None @By (Wed 67275

Start Work: EI E Before Due [] Set Reminder
Priority: E@ [ Private

If you do not want to set a due date, make sure None is selected in the Due
Date box (the default). No due date will be assigned to the task, regardless of
the date displayed in the By box.

In the Due Date box of the Task dialog box, select the By option button and
then change the date to the one you want.

To change each element of the date, select the element, and then either type
the correct day or number over the existing one or click the arrows beside the
box until the day or number you want appears. Schedule+ automatically fills in
the correct day of the week.

In the Start Work box, type a number and then select whether the work should
start days, weeks, or months before it is due.

For example, type 1 and select Day(s) to specify that the task will become
active one day before it is due.

. In the Priority box, type a number to indicate the priority for the task.

The default priority indicators are the numbers 1-9. If you want to change the
priority indicator to letters, type the letter. You can mix letters and numbers in
your Task list; number priorities are higher than letter priorities.

. If you want to set a reminder for the Start Work date, select the Set Reminder

check box.

If you want to ensure that other users do not see this task in your Appointment
Book, select the Private check box.

Choose the OK button.

The task is entered in your Task list with the due date and priority you set.

» To modify a task

Double-click it in the Task list.
Or select the task and choose the Edit button.
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» To remove a task from your Task list
1. From the Task list, select the task.
2. Choose the Delete button, or press either ALT+L or the DEL key.

Scheduling Time in the Appointment Book for a Task

Your Task list helps you keep track of the work you need to do by the end of each
day, but you can also schedule a specific time during the day to complete a task.
For example, if one of your tasks is to file a trip report, you can schedule a
specific time slot in your Appointment Book to be sure you have time to do it.

» To schedule time in your Appointment Book for a task
1. In the Task list, select the task you want to schedule.
2. Choose the Add To Schedule button.

3. In the Choose Time dialog box, select the day, month, year, and time slot you
want to schedule the task for, and then choose the OK button.

The task remains in your Task list, but now it is also booked as an appointment in
your Appointment Book for the day and time slot you chose. If the Private option
is selected in the Task dialog box, other users cannot see the description for this
task in your appointment book, although the time is reserved.
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Using the Planner to Schedule Meetings

With the Schedule+ Planner, you can scan appointments several days at a time or
compare other people’s schedules to your own to determine when others are
available for a meeting. You can also schedule resources.

Scheduling Attendees

When you compare potential attendees’ schedules to your own, their
appointments show a different-colored bar from your appointments. Empty slots
are times when everyone is available for a meeting. When two or more people
have overlapping appointments, the color bar shows a pattern of diagonal stripe,
depending on the colors set with the Display command on the Options menu.
Unless you change the colors, your busy time slots contain a blue color bar. Other
users’ busy time slots contain a gray color bar.

Both people are busy.
Other attendee is busy.

v Marie DuPont .
| o Peter Chapin : ;

Schedule owner is busy.

After you see the schedules for everyone, you can decide the time and date for the
meeting and send requests from the Planner. The Auto-Pick feature automatically
highlights the next time slot when all attendees are available.

Note To schedule meetings with other Schedule+ users, you must be working
online—your computer must be connected to your postoffice.

» To set up a meeting
1. Display your Planner by clicking the Planner tab or pressing ALT+P.
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2. To select a date for a meeting, from the Edit menu, choose the Go To Date
command, and then type the correct numbers.

The vertical color bars in the time slots indicate your current appointments.
Note that your name automatically appears in the Attendees box.
3. Choose the Change button.

iy Mackay
Bob Andrews
Bonita Gonzalez
Bruce Bergstrom
Catherine Boll
Connie Laine
Gertrude Chorel

The list of names in the Select Attendees dialog box are the Schedule+ users
on your postoffice. If any conference rooms or other resources have been set
up on Schedule+, the rooms and resource names also appear in the address list.

4. From the address list, select the name of a person you want to invite to the
meeting, and then choose the Add button or press ENTER.

The person’s name appears with yours in the Attendees box.
Repeat this step for each additional person you want to invite.
5. Choose the OK button.

In your Planner, the names you selected appear in the Attendees box, and
those users’ schedules are overlaid on yours. The color bars indicate busy time
slots. The empty time slots indicate when all attendees are available.

You can view the schedule for an particular individual by selecting the names
of the other attendees in the Attendees box and choose the Remove button to
remove their schedule information from the grid.

6. In the Planner, select a time slot when all the attendees are available by
dragging across the desired time, or press the appropriate arrow keys until the
time slot is selected.

7. Choose the Request Meeting button, or press ENTER.

The attendee(s), date, and time you selected in your Planner are entered auto-
matically in the Send Request dialog box.
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8. In the Subject box of the Send Request dialog box, type a brief description of
the meeting.

9. If you want to receive a response, select the Ask For Responses check box.
These responses will be collected in your Messages window.
10. Choose the Send button.

When Schedule+ has successfully sent the request to the attendees, it books
the meeting automatically for the appropriate date and time slot in your
Appointment Book.

Scheduling Resources

You can use Schedule+ to reserve resources, such as conference rooms,
equipment, or services.

Any technician, conference room, piece of equipment, or anything else can be
assigned an Appointment Book by the Schedule+ administrator. The administrator
who designates an account as a resource account can set it up so that an assistant
controls the resource’s schedule, or can give users access privileges to reserve the
resource directly.

» To schedule a room or resource while you are scheduling a meeting

e Include the room or resource in the Attendees list.

» To schedule a room or resource without inviting people to a meeting
1. Display your Planner.

2. If the conference room or resource isn’t in the Attendees box, choose the
Change button and select the name of the room or resource from the address
list. Then choose the OK button.

If the name of the resource you want to invite isn’t in the address list currently
shown, check another address list. You can view other address lists the same
way you do in mail.

3. Select a time slot for using the resource, based on the times when it is
available.

4. Choose the Request Meeting button.
5. In the Subject box, type a brief description of the meeting (optional).

6. Optionally, in the message area, type any message you want to include in your
meeting request.

7. Choose the Send button.
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If the room or resource has been set up so that you can enter your own requests in
its Appointment Book, the appointment is booked automatically. If an assistant
controls the schedule for the resource, he or she sends you a reply to your request.

Using the Messages Window to Schedule Meetings

If you are connected to a postoffice, the Messages window is available. The
Messages window contains two types of Schedule+ messages: meeting requests
and meeting responses. Meeting requests invite you to meetings other users have
set up, and meeting responses are other users’ replies to your meeting requests.

To use the Messages window, you must make it the active window by double-
clicking its icon, clicking the restored window, or choosing Messages from the
Window menu.

Messages
ead ] [_Delete ]
] arie uont v o 8/25/92 3:52PM
i wi v Marie DuPont ‘es: test of product 8/20/92 4:48PM
Marie will attend —\ Marie DuPont meeting request 8/19/92 4:57PM
8 Marie DuPont meeting request 8/18/92 2:34PM
o ¥ Marie DuPont Yes: marketing meeting 8/14/92 11:17AM
Marie might attend 2 Marie DuPont Tentative: meeting to discuss weeken...8/13/92 5:17PM
Marie DuPont testing 8/13/92 4:41PM
Max Durham 8/12/92 9:42PM
Eric Thomas read Max’s report 8/11/92 11:32AM
Eric Thomas test results 8/11/92 11:24AM
Max won’t attend ———# x Max Durham No: lunch with Jan 8/11/92 11:23AM
Max Durham 8/11/92 11:23AM
Max Durham 8/10/92 1:25PM
Max Durham 8/10/92 1:19PM

Schedule+ messages appear in your Mail Inbox, as well as in your Schedule+
Messages window. You can use the buttons in the window to read, respond to,
and delete messages from either place. For more information about your Mail
Inbox, see Chapter 7, “Mail.”

When you accept a request, Schedule+ automatically notifies the sender that you
will attend and then schedules the meeting in your Appointment Book. When you
decline a request, Schedule+ notifies the sender that you won’t attend and makes
no changes to your Appointment Book. When you tentatively accept a request,
Schedule+ notifies the sender that you might attend and schedules the meeting as
a tentative appointment in your Appointment Book.
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When you invite people to a meeting, they reply by sending meeting responses to
let you know whether they’ll attend. The meeting responses arrive in your
Schedule+ Messages window as entries in the message list. A check mark in a
meeting response entry means the person is planning to attend; an “X” means the
person is not planning to attend; and a question mark means the person might
attend. Entries in bold letters are requests or responses you haven’t read.

When you read a Schedule+ meeting request in the Mail Inbox or Schedule+
Messages window, you can accept, decline, or tentatively accept the invitation,
using the buttons at the top of the request.

Although you can see whether someone is planning to attend by looking at the
symbol in the message list, you can also display the message to see whether the
person provided more information in the reply.

Advanced Features of Schedule+

Some of the advanced features of Schedule+ are described here briefly. For more
information, see online Help.

= You can choose General Options from the Options menu to define how
Reminders are sent, the start and end times for your daily schedule, and other
items.

Reminders
[ Set Reminders for Notes

Set Reminders Automatically

for @ before appointments

[<] Sound Audible Alarm

Day Starts at: 8:00AM g
DayEndsat: | 5:00PM[S]
Week Starts on:

[] Show Week Numbers in the Calendar
mE )
O

Cancel
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You can allow other users to see or update your schedule.

You can choose Set Access Privileges from the Options menu to specify which
users can see your Appointment Book and Task list. When other users check
your schedule to coordinate an event, they usually can only view the times you
are available or busy.

If you want another person to update your schedule for you, you can designate
that person as your assistant in the Set Access Privileges dialog box. Your
assistant can modify your schedule and send and receive meeting requests on
your behalf.

You can archive data and exchange data with other schedule programs.

To create and manage your Schedule+ archives, choose Create Archive or
Open Archive from the File menu. To exchange appointment information with
other scheduling programs, choose Export Appointments or Import
Appointments from the File menu.

File Format: |
Schedule Range: O

@ All
[ Include Daily Notes

You can work offline and then merge changes back into your schedule on the
postoffice.

When your computer is connected to your postoffice, you are working online,
and your appointments are recorded in a file on the postoffice and on your
computer. The filename for this file is has your username plus the .CAL
filename extension. If you have the Schedule+ software on another computer,
such as a portable or home computer, you can use the Move Local File
command from the File menu to copy this file to the other computer.

While you are working offline (without connection to your postoffice), you can
add and modify appointments. When you return to your office computer and
reconnect to Schedule+ on the postoffice, Schedule+ automatically merges the
changes made offline into the copy of your schedule on the postoffice.
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CHAPTER 9

Command Prompt

Overview

The command prompt is the character-based interface to Windows NT and its
subsystems. Any supported command or application can be run at the command
prompt regardless of the operating system it was designed for: Windows NT,
Windows 3.1, MS-DOS, MS 0OS/2 1.x, or POSIX. The command prompt also
supports batch programs, redirection between subsystems, cutting and pasting
information between subsystems, and file management for the NTFS, FAT, and
HPFS file systems.

This chapter explains how to use the Windows NT command prompt. The chapter
includes the following topics:

= An overview of the Windows NT command prompt

= Lists of available commands

= An explanation of command syntax

= An explanation of command prompt functions

= A comparison of Windows NT and MS-DOS version 5.0 commands and
Windows NT and LAN Manager 2.1 commands.

The Windows NT command prompt is a single interface providing seamless
operation and integration of applications from four different operating systems.
The Windows NT command prompt is a major enhancement to the command line
interface on current personal computer operating systems allowing you to:

= Start any Windows NT, Windows 3.1, MS-DOS, character-based MS OS/2
version 1.x, or POSIX-compliant programs.

= Issue Windows NT commands. The command prompt retains and enhances
almost all the commands used in MS-DOS version 5.0 and contains several
new commands.
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= Administer or use network resources. Many LAN Manager 2.1 commands are
available.

= Cut and paste information between applications with the Clipboard.

= Use piping or redirection of data between subsystems

Starting and Quitting the Command Prompt

Start the command prompt by double-clicking the Command Prompt icon. The
Command Prompt window displays copyright information plus the command
prompt in monospaced characters followed by a blinking cursor. The default
command prompt is the current drive and directory enclosed in brackets.

To quit the Command Prompt

e Type exit at the command prompt, or choose Close from the Control menu, or
double-click the Control menu box.

To quit the Command Prompt when it, or an application started at the
Command Prompt, fails to respond

1. From the Control menu, choose Settings.
2. In the Special box, choose the Terminate button.

Use Terminate as a last resort. You should quit applications by using the
application’s Quit or Exit command.

Changing the Command Prompt Display

You can configure the appearance of the command prompt window using the
Control menu. The icon in the upper-left corner of any window is that window’s
Control menu. The Control menu allows you to:

= Cut and paste information between any two windows.

= Toggle between window mode and full-screen mode.

= Change fonts used in window mode.

= Set the screen buffer size and the position of the window.

= Change the colors of text and background for the main screen and pop-up
boxes.
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Click the Control-menu box
to display the Control menu.

Hestore
Move
Size
Minimize
Maximize

Close

CtrI+Esc ‘

_ngs- — Copy information

Fonts... !
Screen Size And Position... be_tween wm'dows
Screen Color... using the edit comn

Use these menu commands to
change Command Prompt
window behavior and display.

» To open the Control menu
e Click the control-menu box once, or press ALT+SPACEBAR.

The Control menu opens and you can select from the list of commands. (If you
are in full-screen mode, the application will minimize and the control menu
will appear from the icon.) For information on Control menu commands not
listed below, see Chapter 2, “Windows NT Basics.”

Control menu settings are stored with the icon used to start the command prompt.
You can have more than one command prompt icon, but the settings for each
command prompt icon are independent. This allows you to have different defaults
for different needs.

An application’s internal display settings will usually override font and color
settings made in the Control menu.

Changing Window Modes

The command prompt can be used in either window or full-screen mode. You can
also use QuickEdit mode which allows you to use your mouse to cut and paste,
bypassing the Edit menu.
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» To toggle between window and full-screen mode
e Press ALT+ENTER.

By default, the command prompt opens as a window on your desktop.

» To change the default window display options
1. From the Control menu, choose Settings.
2. In the Display Options box, choose either Window or Full Screen.

3. To use this Display Option every time you start the command prompt from this
icon, select the Save Configuration check box. If this box is not selected, the
Display Option will be in effect only while this window is open.

4. Choose the OK button.

» To turn QuickEdit mode on or off
1. From the Control menu, choose Settings.
2. Select the QuickEdit Mode check box.
3. Choose the OK button.

You can always use the Edit menu commands, whether QuickEdit mode is on or
off. For more information about QuickEdit, see “Transferring Information to or
from a Command Prompt Window later in this chapter.

Changing Fonts for Window Mode

You can choose from many font sizes for the window mode of the command
prompt display. Fonts for the command prompt are measured in screen pixels.
Default fonts are saved based on the title of the window. The size of the window
will change relative to the font selected, but you can always resize the command
prompt window up to the maximum screen buffer size, as discussed in the
following section.

» To change fonts for the command prompt

1. From the Control menu, choose Fonts.
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Window Preview

O Save configuration

Each character is:
8 screen pixels wide
12 screen pizels high

2. In the Font box, choose a font size.

The Selected Font box displays an example of the selected font and its width
and height. The Window Preview box displays how the current window size
will change based on the font you choose, although you can later resize the
window up to the maximum screen buffer size.

3. To use the font every time you start the command prompt from this icon, select
the Save Configuration check box. If this box is not selected, the new font is
displayed only while this window is open.

4. Choose the OK button.

Changing the Screen Size and Position

The screen buffer size is the size reserved in memory for the command prompt
display. The buffer size is measured by the number of characters wide by the
number of lines high. The position is the current window position on the screen.

Scroll bars are displayed if the current size of the window is smaller than the
screen buffer size settings. You cannot resize a window to be larger than the area
set by the screen buffer settings. The settings have no effect when you are using a
full screen display.

» To change the screen buffer size

1. From the Control menu, choose Screen Size And Position.
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Screen Buffer Size

width: B
ElE

Height:
[ save screen buffer size

[ save window size and position

2. In the Screen Buffer Size box, set the width and height of the window using
the up or down arrows next to the settings, or type the new value.

The width setting determines the number of characters in width. The height
setting determines how many lines are stored in memory.

3. To use these screen buffer size settings every time you start the command
prompt from this icon, select the Save Screen Buffer Size check box. If this
box is not selected, your screen buffer settings are displayed only while this
window is open.

4. Select the Save Window Size And Position check box if you want to use the
current window size and position every time you start the command prompt.

5. Choose the OK button.

Changing Screen Colors

You can specify the color of the text and background of the command prompt
window. You can also specify the color of the text and background of pop-up
windows that originate from the command prompt. Pop-up windows are smaller
character-based windows that present information to choose from.

» To change screen colors

1. From the Control menu, choose Screen Colors.

 Screen Text

O PopUp Text _Cancel
O PopUp Background [[] save configuration

Selected Screen Colors Selected Popup Colors
CAWINNT> dir

Directory of C:AWII
SYSTFM <DIR
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2. In the Screen Colors dialog box, choose the colors for screen text, screen
background, pop-up text, and pop-up background by clicking the element you
want to change, and then clicking the color you want.

The Selected Screen Colors or Selected Popup Colors box displays your
choice.

3. To use the same colors every time you start the command prompt from this
icon, select the Save Configuration check box. If this box is not selected, your
settings are displayed only while this window is open.

4. Choose the OK button.

Getting Help for the Command Prompt

Online Help is available for all commands at the command prompt and in a
Windows NT help file.

Help at the Command Prompt

Online Help is available for all Windows NT commands. The following table
shows how to access the different types of help available at the command prompt
and the information provided.

Syntax Information provided
help Names of native system commands.
command [? Description, syntax, parameters, and switches for native

system commands. This syntax also provides help for
MS-DOS subsystem commands that are not listed when

you type help.

help command Description, syntax, parameters, and switches for native
system commands.

net help Names of available network commands.

net command [? Syntax only for network commands.

net command /help Syntax and description for network commands.

net help command Syntax and description for network commands.

net help command /options Parameters and switches for network commands.

Online Command Reference

The Windows NT online Command Reference is available to provide command
syntax and parameters, details about a command, and examples of the command
in use. To use the online Command Reference, double-click the Help icon in the
Main program group.
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Command Prompt Commands

Any supported Windows NT command can be run at the same command prompt.
Windows NT commands are classified as follows:

= Native commands

= Subsystem commands

= Configuration commands

= TCP/IP utilities

= Special purpose utilities

= Command symbols

Native Commands

A native command means the command takes advantage of the 32-bit operating
system. Most commands familiar to MS-DOS 5.0 users are now native Windows
NT system commands.

Some commands, such as dir and chdir, are internal, meaning the command is
stored in the file CMD.EXE and resides in memory at all times. Other commands,
such as chkdsk and xcopy, are external, meaning the command is stored in its
own file and loads from disk when you use the command. Batch commands are
for use in batch programs, as described later in this chapter.

Command Purpose

at Schedules commands and programs to run on a computer at a
specified time and date.

attrib Displays or changes file attributes.

break Sets or clears extended CTRL+C checking.

call Calls one batch program from another. (Batch command only.)

chep Displays or sets the active code page number.

chdir (cd) Displays the name of or changes the current directory.

chkdsk Checks a disk and displays a status report.

cls Clears the screen.

cmd Starts a new session of the Windows NT command interpreter.

comp Compares the contents of two files or sets of files.

convert Converts FAT and HPFS disk partitions to NTFS partitions.

copy Copies one or more files to another location.

date Displays or sets the date.

del Deletes one or more files.
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Command Purpose

dir Displays a list of files and subdirectories in a directory.

diskcomp Compares the contents of two floppy disks.

diskcopy Copies the contents of one floppy disk to another.

doskey Edits command lines, recalls commands, and creates macros.

echo Displays messages or turns command echoing on or off.

endlocal Ends localization of environment changes in a batch file. (Batch
command only.)

erase Deletes one or more files. (See del.)

exit Quits the Windows NT command interpreter (CMD.EXE).

fc Compares two files or sets of files, and displays the differences
between them.

find Searches for a text string in a file or files.

findstr Searches for strings in files using literal text or regular
expressions.

for Runs a specified command for each file in a set of files.

format Formats a disk for use with MS-DOS or Windows NT.

goto Directs Windows NT to a labeled line in a batch program. (Batch
command only.)

graftabl Enables Windows NT to display an extended character set in
graphics mode.

help Provides Help information for Windows NT commands.

if Performs conditional processing in batch programs. (Batch
command only.)

keyb Configures a keyboard for a specific language.

label Creates, changes, or deletes the volume label of a disk.

mkdir (md) Creates a directory.

mode Configures a system device.

more Displays output one screen at a time.

move Moves one or more files from one directory to the specified

net accounts
net computer

net config

net config server

directory on the same drive.

Displays or sets password and logon requirements of servers in a
domain.

Adds computers to Windows NT Advanced Server domains
(Advanced Servers only).

Displays the controllable services that are running.

Displays or changes settings for the Server service while the
service is running.
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Command Purpose
net config Displays or changes settings for the Workstation service while it
workstation is running.

net continue
net file

net group

net help

net helpmsg
net localgroup
net name

net pause

net print

net send

net session
net share

net start

net start alerter

Reactivates suspended services.

Displays the names of all open shared files on a server and the
number of file locks, if any, on each file. This command also
closes individual shared files and removes file locks.

Adds, displays, or modifies global groups.

Provides a list of network commands and topics you can get help
with, or provides help with a specific command or topic.

Provides help with a network error message.

Adds, displays, or modifies local groups.

Adds, deletes, or displays messaging names on a workstation.
Pauses services or shared printers.

Displays or controls print jobs.

Sends messages to other computers on the network.

Lists or disconnects sessions between a server and workstations.
Creates, deletes, or displays shared resources.

Starts a service or displays a list of started services.

Starts the Alerter service.

net start computer
browser

Starts the Computer Browser service.

net start directory
replicator

Starts the Directory Replicator service.

net start eventlog Starts the Eventlog service.

net start locator Starts the RPC locator service.
net start messenger Starts the Messenger service.
net start net logon Starts the Net Logon service.
net start rpcss Starts the RPC subsystem.
net start schedule Starts the Schedule service.
net start server Starts the Server service.
net start ups Starts the Uninterruptible Power Supply service.
net start workstation  Starts the Workstation service.

net statistics Displays the statistics log.
net stop Stops a network service.

net time Synchronizes the workstation’s clock with that of a server or

domain, or displays the time for a server or domain.
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Command Purpose

net use Connects a workstation to or disconnects a workstation from a
shared resource, or displays information about workstation
connections.

net user Adds or modifies user accounts or displays user account
information.

net view Displays a list of servers or displays resources being shared by a
server.

path Displays or sets a search path for executable files.

pause Suspends processing of a batch file and displays a message.
(Batch command only.)

popd Changes to the directory stored by the pushd command.

print Prints a text file while you are using other Windows NT
commands.

prompt Changes the Windows NT command prompt.

pushd Stores the current directory for use by the popd command, and
then changes to the specified directory.

recover Recovers readable information from a bad disk.

rem Records comments (remarks) in batch files. Also available as a

rename (ren)
replace
restore
rmdir (rd)
set

setlocal

shift

sort
start
subst
time
title
tree
type
ver

verify

CONFIG.SYS command for the MS-DOS and OS/2 subsystem.
Renames a file or files.

Replaces files.

Restores files that were backed up with MS-DOS backup.
Removes a directory.

Displays, sets, or removes Windows NT environment variables.

Begins localization of environment changes in a batch file.
(Batch command only.)

Shifts the position of replaceable parameters in batch files.
(Batch command only.)

Sorts input.

Starts a separate window to run a program or command.
Associates a path with a drive letter.

Displays or sets the system time.

Sets the title for the command prompt window.

Graphically displays the directory structure of a drive or path.
Displays the contents of a text file.

Displays the Windows NT version number.

Tells Windows NT whether to verify that your files are written
correctly to a disk.
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Subsystem Commands

Command Purpose
vol Displays a disk volume label and serial number.
XCOpy Copies files (except hidden and system files) and directory trees.

Windows NT includes 16-bit commands (non-native) for the MS-DOS and

other subsystems. These are older commands, such as edlin or graphics, and
MS-DOS -specific commands, such as debug or exe2bin. These 16-bit commands
are included to maintain MS-DOS 5.0 and MS OS/2 version 1.x compatibility.

Other MS-DOS subsystem commands, such as share, perform functions that are
now inherent to Windows NT or the MS-DOS subsystem. The commands are
accepted to preserve compatibility with existing files, but the commands have no
effect because the functionality is automatic in Windows NT.

Command Purpose

append Allows programs to open data files in specified directories as if
they were in the current directory.

backup Backs up one or more files from one disk onto another.

debug Runs Debug, a program testing and editing tool for MS-DOS
applications.

edit Starts MS-DOS Editor, which creates and changes ASCII files.

edlin Starts Edlin, a line-oriented text editor.

exe2bin Converts .EXE (executable) files to binary format.

graphics Loads a program that can print graphics.

loadfix Loads a program above the first 64K of memory, and then runs
the program.

loadhigh (1h) Loads a program into the upper memory area.

mem Displays the amount of used and free memory for the MS-DOS
subsystem.

nlsfunc Loads country-specific information.

gbasic Starts the QBasicm programming environment.

setver Sets the version number for MS-DOS that Windows NT reports
to a program.

share Starts the share program, which installs file-sharing and locking

capabilities on your hard disk.
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Configuration Commands

You configure the MS-DOS subsystem with configuration commands, such as
device or lastdrive. Place these commands in the CONFIG.NT file in the
\WINNT\SYSTEM32 directory. These commands affect only the MS-DOS
subsystem. Many of them, such as buffers and break, are ignored because the
MS-DOS subsystem works without them. They are accepted for compatibility
only.

You configure the OS/2 subsystem with CONFIG.SYS commands, such as
devicename or libpath. Use an OS/2 editor to edit CNCONFIG.SYS. These
commands affect only the OS/2 subsystem.

For more information on Windows NT subsystems, see Chapter 11, “Other
Application Environments.”

Command Purpose

buffers Allocates memory for a specified number of disk buffers when
the system starts.

codepage Specifies which code pages your system is prepared to use. (0S/2
only.)

country Enables a subsystem to use international time, dates, currency,
case conversions, and decimal separators.

device Loads into memory the device driver you specify.

devicehigh Loads into high memory the device driver you specify.

devinfo Specifies the information a device needs in order to use a
particular code page. (OS/2 only.)

dos Specifies that the MS-DOS subsystem is to maintain a link to its
upper memory area or is to load part of itself in the high memory
area (HMA).

driveparm Defines parameters for block devices. (OS/2 only.)

echoconfig Displays messages when the MS-DOS subsystem CONFIG.NT
file is read.

fcbs Specifies the number of file control blocks (FCBs) the command
prompt can have open at the same time.

files Sets the number of files that the command prompt can access at
one time.

install Loads a memory-resident program into memory.

lastdrive Specifies the maximum number of drives you can access.

libpath Specifies the location of OS/2 dynamic-link libraries. (OS/2
only.)

protshell Specifies the name and location of the MS OS/2 command

interpreter.
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Command Purpose

shell Specifies the name and location of the command interpreter for
the MS-DOS subsystem.

stacks Supports the dynamic use of data stacks to handle hardware
interrupts.

switches Forces an enhanced keyboard to behave like a conventional one.

TCP/IP Utilities

The TCP/IP utilities offer network connections to non-Microsoft hosts such as
Unix workstations. You must have the TCP/IP network protocol installed to use

the TCP/IP utilities.

For more information about the TCP/IP utilities and network protocol, see the

Windows NT Resource Kit.

Command Purpose

arp Displays and modifies the IP-to-Ethernet address translation
tables.

finger Displays information about users on a remote system.

ftp Transfers files to and from a node running ftp service; similar
to tftp.

hostname Prints the name of the current host.

nbtstat Displays the contents of various NetBIOS data structures.

net start nbt

net start snmp

net start tcpip
net start telnet

netstat

ping

rep

rexec

route

Starts the NetBIOS over TCP/IP service.

Starts the Simple Network Management Protocol (SNMP)
service.

Starts and configures the TCP/IP service.
Starts the TELNET service.

Displays the contents of various network-related data
structures.

Bounces echo packets from a specified host to troubleshoot
network problems.

Copies files between computers.

Provides remote execution facilities similar to rsh. Rexec is
password protected.

Manually manipulates network routing tables.



Chapter 9 Command Prompt 269

Command

Purpose

rsh

telnet
tftp

Special Purpose Utilities

Connects to a specified host and executes a specified
command.

Enables terminal emulation.

Transfers files to and from a node running ftp service; similar
to ftp.

Special purpose utilities are native 32-bit utilities, but they have a very limited
purpose and may not appear in future versions of Window NT.

Command

Purpose

aclconv
diskperf

portuas

Command Symbols

Restores OS/2 2.x ACLs to NTFS volumes.
Starts, stops and displays system disk performance counter use.

Converts a LAN Manager user account subsystem to a Windows
NT user account database.

Nine command symbols allow you to manipulate the input or output of a
command and permit conditional execution of a command. Used with commands
and filter commands, the command symbols are powerful tools.

Symbol

Purpose

>

>>

0

A

Redirects output.

Appends redirected output to existing data.
Redirects input.

Pipes output.

Runs the command following the symbol only if the command
preceding the symbol fails.

Separates multiple commands on the command line.

Runs the command following the symbol only if the command
preceding the symbol is successful.

Groups commands.

Allows input of command symbols as text. Escape character.

Sort, more, and find are the native filter commands that allow you to sort input
and output, cause output to the screen to be displayed one screen at a time, and
search for specified text in a file.
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For complete syntax and explanations of the command symbols and filter
commands, see the online Command Reference.

Command Syntax

Syntax is the order in which you must type a command and the elements that
follow the command. Windows NT commands have up to four elements:
command name, parameters, switches, and values.

These two examples contain all four elements. Each element is explained below.

@ o
$ &
> & > &
¥ & S é§ & S
§ & 5 S $ PO
S Q S S T 2 ©
4 | i
dir c:\letters /a:h net share public=c: \users\pubhc /users 10

The first example lists all hidden files in the CALETTERS directory. The second
example allows up to 10 users to connect to the CNUSERS\PUBLIC directory.

Command Names

Parameters

The command name, which you type first, states the action you want Windows
NT to carry out. Some commands (such as the cls command, which clears your
screen) consist only of a command name. Most Windows NT commands require
more than a name. All network commands are preceded by the word net, for
example, net share or net use.

Windows NT sometimes requires additional information, which you specify in
one or more parameters after the command name. A parameter defines or creates
the object you want Windows NT to act on. For example, the del command
requires a parameter that is the name of the file you want to delete.

Some commands require more than one parameter. For example, to rename a file
by using the rename (ren) command, you must include the original name of the
file in addition to the new name. The following command renames LETTER. TXT
to MEMO.TXT: ren letter.txt memo.txt
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Switches

Position in the syntax line determines how a command works and whether a
parameter is a source (first) or a destination (second). In the example above the
source, LETTER.TXT, specifies the location of data to be transferred or used as
input to a command. The destination, MEMO.TXT, specifies a location to which
the data specified by source is to be transferred.

Using Special Characters in Parameters

In a Windows NT command, a computer name, share name, username, or group
name can contain special characters (for example, PROFIT&LOSS).

To type a parameter with a special character

® Type the escape character (1) before the special character. For example, type
net use g: \\profit" &loss\reports

Note The command prompt will not accept the extended ANSI characters
(characters greater than 127).

Switches modify how a command performs a task. A switch is a forward slash (/)
usually followed by words, letters, or numbers. Some Windows NT commands do
not have switches, whereas others have several.

If a command has more than one switch, you type them one after the other,
separated with a space. Switches may be in any position or order after the
command name. Some commands accept more than one switch after a forward
slash. Some commands also accept a hyphen (-) instead of the forward slash.

The following command lists all hidden files in the current directory: dir *.* /ah

The terms “parameter” and “switch” are often interchanged, since both elements
follow the command name. The only meaningful difference between a switch and
parameter is the presence of a forward slash or hyphen to indicate a switch and the
parameter position in the syntax line to indicate whether the parameter is a source
or destination.

Using the /Yes and /No Switches

With some network commands, Windows NT issues a prompt that requires a user
response before a task can be completed. You can append the /yes (/y) or /no (/n)
switch to a command to force a Yes or No answer for all responses. For example,
stopping the Workstation service causes Windows NT to stop dependent services;
Windows NT will prompt you before stopping each dependent service unless the

/yes switch is included, as in the following: net stop workstation /y
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Values

Values determine how a switch works. A value is a colon (:) or an equal sign (=)
followed by a word, letter, or number and must immediately follow the switch it
modifies without a space. The following example of the format command
contains two values, the file system to use (NTFS) and a volume label (Backup2):
format d: /fs:ntfs /v:backup2

Check the syntax for the specific command in online Help to determine if the
command you want to use requires an equal sign or a colon.

Using the Command Prompt

This section explains how to:

Start applications and use batch programs.

Cut and paste information to or from a command prompt window.

Simplify entering repetitive commands.

= Pause or cancel execution of a command.

Starting Programs at the Command Prompt

You can start any program at the command prompt by typing the filename of the
program.

To start a program at the command prompt
e Type the program’s executable file name, and then press ENTER.
For example, typing clock will start Clock (from the Accessories group).

The command prompt window used to start the program is unavailable until
you stop the program.

To start a program at the command prompt and retain use of the command
prompt widow

e Type start followed by the program’s executable file name, and then press
ENTER.
For example, typing start calc will start Calculator (from the Accessories
group).
The command prompt window still accepts commands.

You can also pass additional parameters to a program at the command prompt.
For example, the command notepad letter.txt starts Notepad and automatically
loads the file LETTER.TXT.
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Other programs may accept parameters specific to the program. Each program
determines the parameters it will accept at the command prompt. To determine
whether a program will accept parameters at the command prompt, see the
documentation for that program.

While a program or command is running, the window or icon title displays the
program or command currently running. When the command finishes running, the
command is removed from the window or icon title.

Batch Programs

Batch programs (also called batch files) allow you to simplify routine or repetitive
tasks. A batch program is an unformatted text file that contains one or more
commands and has a .BAT or .CMD filename extension. When the filename is
typed at the command prompt, the commands in the file are executed sequentially.

Any command can be included in a batch file. In addition, several commands
allow conditional processing of the commands in the batch file. For example, the
if command carries out a command based on the results of a condition. Other
commands allow you to control input and output and call other batch programs.
For more information about batch programs, see the online Command Reference.

Transferring Information to or from a Command Prompt Window

You can transfer information to or from the command prompt using either
QuickEdit mode or the Edit menu commands.

Note To quickly switch a command prompt or subsystem application between a
full screen and a window, press ALT+ENTER.

Copying and Pasting Information using QuickEdit Mode

QuickEdit mode allows you to copy and paste text in command prompt windows
using only your mouse, bypassing the control menu’s Edit commands. QuickEdit
mode copies data only when the command prompt is running as a window;
however, you can paste in QuickEdit mode when the command prompt is either a
window or a full screen. The data is treated as text. Use the Settings command
from the control menu to turn QuickEdit mode on or off.

» To cut and paste text at the command prompt using QuickEdit mode

1. If necessary, use the Settings command from the control menu to turn
QuickEdit mode on.
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2. Position the arrow cursor at the beginning of the text you want to copy. Press
the left mouse button. Keeping the left mouse button depressed, drag the
cursor to the last character of the section you want to copy and release the left
mouse button. The portion of the screen you want to copy is highlighted.

If necessary, redo this step until the exact area you want is highlighted.

3. Press the right mouse button to copy the highlighted area to the Clipboard. The
highlight will disappear.

4. Press the right mouse button to copy the contents of the Clipboard to the
command prompt cursor. If the area copied was more than one line, a carriage
return (ENTER) is added at the end of each line.

You must still use the Edit Paste command to paste the contents of the
Clipboard into Windows applications.

Copying and Pasting Information Using the Edit Menu

The Edit menu commands allow you to copy and paste information in any
window, not just command prompt windows. The data is transferred as text or as
a bitmap to the Clipboard depending on how it was copied.

To copy selected information from a command prompt window or character-
based application running in a window as text

1. If necessary, press ALT+SPACEBAR to open the Control menu.
From the Control menu, choose Edit.
From the Edit menu, choose Mark.

Select the information you want to copy using a mouse.

AT SR

Press the right mouse button to transfer the selected information to the
Clipboard or choose Edit Copy from the Control Menu.

To copy the contents of an entire screen onto the Clipboard as a bitmap
1. Make sure the information you want to copy is on the screen.
2. Press PRINT SCREEN.

The contents of the screen are copied onto the Clipboard.

To copy a window and its contents onto the Clipboard as a bitmap
1. Make sure the window you want to copy is the active window.
2. Press ALT+PRINT SCREEN.

A bitmap of the active window is created and placed onto the Clipboard. The
application you want to transfer the information to must be able to read bitmap
(.BMP) files.
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» To paste information into an application as text
1. Make sure the information you want is on the Clipboard.
2. Switch to the destination window.

3. Place the insertion point where you want the information from the Clipboard
to appear.

4. 1If the application is running in full-screen mode, press ALT+SPACEBAR to open
the Control menu.

5. From the window’s Control menu, choose Edit.

6. From the Edit menu, choose Paste.

Editing Commands with Doskey and Editing Keys

Windows NT provides Doskey to give you quick access to your most recent
commands and enable you to assign frequently used command(s) to a single

keystroke. Doskey is always available; you do not need to load the program into
memory.

The UP ARROW and DOWN ARROW keys cycle through commands previously
entered. Press F7 to display all of the previous commands in a pop-up box; then
use the UP ARROW and DOWN ARROW keys to select a command and press ENTER
(or press ESCAPE to cancel). Doskey also allows you to assign multiple commands
to a single key or typed alias.

In addition to Doskey, several editing keys allow you to use and edit the last
command you typed. Press F1 to display the last command one character at a time,
or press F3 to display the entire command. Use the BACKSPACE or LEFT ARROW
key to move the cursor in a command. The Insert key toggles between insert and
overtype mode.

For more information on Doskey and the command editing keys, see the online
Command Reference.

Pausing or Canceling a Command

You can pause or stop the output of a command.

» To pause the output of a command
= Press CTRL+S or PAUSE.

Press any key except PAUSE to restart the output of the command. You can
stop and restart the output of a command as many times as you want.
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» To stop Windows NT from completing a command

e Press CTRL+BREAK or CTRL+C.

Your command is canceled, and the command prompt appears.

Important Any action Windows NT carried out before you pressed CTRL+BREAK
or CTRL+C cannot be undone.

Differences from MS-DOS 5.0 Commands

Windows NT retains and enhances almost all the functionality of MS-DOS 5.0.
This table explains new Windows NT system commands.

Command

Function

aclconv
convert
diskperf

echoconfig

endlocal
findstr
move
popd
pushd

setlocal
start
title

Restores OS/2 2.x ACLs to NTFS volumes.
Converts file systems from FAT or HPFS to NTFS.
Starts, stops, and displays system disk performance counter use.

Displays messages when reading the MS-DOS subsystem
CONFIG.NT file.

Ends localization of environment variables.

Searches for text in files using regular expressions.

Moves files on the same disk drive.

Changes to the directory last set with the pushd command.

Saves the current directory for use by the popd command, and
then changes to the specified directory.

Begins localization of environmental variables.
Runs a specified program or command in a secondary window.

Sets the title of the command prompt window.

This table lists changes and improvements to MS-DOS 5.0 commands.

Command

Changed features

cmd

del

dir
diskcomp
diskcopy
doskey

format

CMD.EXE replaces COMMAND.COM.
New switches provide many more functions.
New switches provide many more functions.
Switches /1 and /8 are not supported.

Switch /1 is not supported.

Several enhancements improve doskey.

20.8 MB floptical drive supported. Switches /b, /s, and /u are not
supported.
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Command Changed features

keyb KEYBOARD.SYS is no longer used.

label The symbols ~ and & can be used in a volume label.

mode Extensive changes.

more New switches provide many more functions.

path The %PATH% environment variable appends the current path
to a new setting at the command prompt.

print Switches /b, /u, /m, /s, /q, /t, /¢, and /p are not supported.

prompt New character combinations allow you to add ampersands ($a),
parentheses ($c and $f), and spaces ($s) to your prompt.

recover Recovers files only.

sort Does not require TEMP environment variable. File size is
unlimited.

Command New or Changed Feature

xcopy New switches provide many more functions.

&& Command following this symbol runs only if the command

preceding the symbol succeeds.

I Command following this symbol runs only if the command
preceding the symbol fails.

& Separates multiple commands on the command line.
() Groups commands.
A Escape character. Allows input of command symbols as text.

The following MS-DOS 5.0 commands are not available at the command prompt.

Command New procedure or reason for obsolescence

assign Not supported in Windows NT.

ctty Not currently supported.

dosshell Unnecessary with Windows NT.

expand Used only for files on the MS-DOS 5.0 distribution disks.

fastopen Windows NT inherent caching is superior to this utility.

fdisk Disk Administrator prepares hard disks for use with Windows
NT.

join Increased partition size and an improved file system eliminate the

need to join drives.

mirror Not supported in Windows NT.
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Command

New procedure or reason for obsolescence

sys

undelete

unformat

Windows NT will not fit on a standard 1.2 MB or 1.44 MB
floppy disk.

Not supported in Windows NT.
Not supported in Windows NT.

Differences from LAN Manager 2.1 Commands

Windows NT retains many LAN Manager version 2.1 commands. This table lists
new network related commands.

Command

Function

at

net start computer
browser

net start eventlog

net localgroup
net start locator
net start nbt

net start rpcss
net start schedule
net start tcpip
net start telnet

portuas

Schedules commands and programs to run on a computer at a
specified time and date.

Starts the Computer Browser service.

Logs any significant system, security, and application
occurrences that require users to be notified.

Manages local groups.

Starts the RPC Locator service.

Starts the NetBIOS over TCP service.

Starts the RPC subsystem.

Starts the Schedule service, enabling the at command.
Starts the TCP/IP service.

Starts the Telnet service.

Converts a LAN Manager user account subsystem to a Windows
NT user account database.

This table identifies changes to LAN Manager commands.

Command

New or changed feature

net accounts

net config

net config server

net config
workstation

Server roles cannot be set. Windows NT security controls
lockout.

Peer functionality is an inherent part of Windows NT and no
longer requires separate commands.

Most network services are self-configuring. The switches
/autodisconnect, /srvcomment, and /hidden can be configured.
The switch /srvhidden is now /hidden.

Most network services are self-configuring. The switches
/charcount, /chartime, and /charwait can be configured.
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Command

New or changed feature

net continue
net group
net pause
net print

net send

net share

net start

net start alerter
net start messenger
net start net logon

net start directory
replicator

net start server
net start snmp

net start workstation

net statistics

net stop

net use
net user

net view

Use Print Manager to control printing. See net pause in this table
for the list of services that can be paused.

Manages global groups and is only for computers that are
members of a domain.

You can pause these network services: Alerter, Browser,
Messenger, Netlogon, Replicator, Server, Telnet, and
Workstation. Use Print Manager to manage printers.

Use Print Manager to manage printers.
Sending files is not supported.

Remote administration is automatic. Use Print Manager to share
printers. Communication-device queues are not supported in this
release.

You can start these network services: Alerter, Browser, Eventlog,
Messenger, Netlogon, Replicator, Server, Snmp, Tcpip, Nbt,
Telnet, and Workstation. Services can be configured to start
automatically.

Self-configuring.
Self-configuring.
Self-configuring. Service name is now two words.

Use Server Manager to configure the Directory Replicator
service. Previously called net start replicator.

Use Server Manager to configure the Server service.
New options permit logging.

The Workstation service is configured at setup and in various
applications.

Peer functionality is an inherent part of Windows NT and no
longer requires separate commands. The statistics log cannot be
cleared.

You can stop these network services: Alerter, Browser,
Messenger, Netlogon, Replicator, Server, Snmp, Telnet, and
Workstation.

The /persistent switch has only yes and no values.
Communication-device queues are not supported in this release.

Switches /logonserver, /maxstorage, /operator, and /privilege
are not supported.

New /domain switch permits viewing of domains and computers
in a specified domain.

This table lists LAN Manager commands that are no longer available at the
command prompt. The table tells how to accomplish the command, or explains
why the command no longer exists.
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Command New procedure or reason for obsolescence

net Use the Windows NT administrative tools to administer the
network.

net admin Use the Windows NT administrative tools to administer the
network.

net access Use File Manager to set permissions on files.

net audit Use Event Viewer to track network resource use.

net comm Communication-device queues are not currently supported.

net config peer
net console

net copy

net device

net error

net forward
net log

net logoff

net logon

net move

net password
net run

net separator

net start netpopup

net start netrun
net start nvalert

net start peer

net start remoteboot

net status

net start timesource

net version

net who

Not needed with Windows NT.

Use Windows NT security features to prevent unwanted access.
Use File Manager or the system copy command to copy files.
Use Print Manager to display information about shared printers.
Use Event Viewer to track network resource use.

You cannot forward network messages with Windows NT.
Message logging is not supported.

Logging off is an inherent part of Windows NT.

Logging on is an inherent part of Windows NT.

Use File Manager or the system copy and delete commands to
move files.

Press CTRL+ALT+DEL to change your password.

Programs cannot be executed remotely in Windows NT.
Use Print Manager to control separator pages.

Windows NT processes network messages automatically.
Not supported in Windows NT.

The Nvalert service is not currently supported.

Peer functionality is an inherent part of Windows NT.
The Remoteboot service is not currently supported.

The information can be found using net config server and net
share.

The functionality is included in the Server service.
Use Winver to determine the current Windows NT version.

Use Server Manager to view connections to a server.
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CHAPTER 10

Object Linking and Embedding

Overview

In Windows NT, you can share information between applications using the
special object linking and embedding (OLE) capabilities of Windows-based
applications.

This chapter provides an overview of methods for sharing information between
applications or documents, including the following topics:

= An overview of object linking and embedding

= Linking or embedding an object with menu commands
= Linking or embedding objects with OLE applications
= Maintaining linked or embedded objects

With object linking and embedding, you can combine information from several
applications into one compound document. You can also edit the information,
without knowing which application was used to create it.

The applications included with Windows NT that have OLE capabilities are
Cardfile, ClipBook Viewer, Mail, Paintbrush, Sound Recorder, and Write. For
more information about how to use the OLE features of these Windows NT
accessories, see the online Help for each. For information about the OLE
capabilities of your Windows-based applications, see the documentation for those
applications.
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Use object linking and embedding
to display information from other
applications in a compound
document.

Site: Archi Archll Archlll
Alhambra 103 107 11

Dijon 107 111 105
Total: 210 218 116
4

Character Paragraph Help

Building Plan for New Arches

This report presents the costs, materials, and schedule

for the new arches to be built at Alhambra and Dijon. s way

Basic Building Materials: Stones Required

Site: Arch | Arch il Arch

Alhambra 103 107 11
Dijon 107 111 105
Total: 210 218 116

The following are basic OLE terms:

An object is any information that you can display and change in a document
created in a Windows-based application that has OLE capabilities. For
example, a single cell in a spreadsheet, a range of cells, or an entire
spreadsheet might be inserted as a linked or embedded object in a word
processing document. When you choose an object to edit it